
U
se

r 
g

ui
d

e

PORTABLE EFFICIENCY





A

B

C

D

E

F

User guide

   2018-11. 71971 B  Rev.1

General instrument functions
Instrument data and functions, general settings, files and upgrades

General measurement functions
Measuring modes, recording, measuring rounds, display windows, 
spectrum functions and order tracking

Measurement techniques always included
RPM, temperature, ISO 2372 vibration and stethoscope

Shock pulse measurement
SPM HD, SPM dBm/dBc, SPM HR/LR, SPM LR/HR HD and SPM Spectrum

Vibration mesurement
ISO 10816 vibration, HD ENV, EVAM vibration analysis, FFT with symptoms

Rotor balancing  
Single plane balancing
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Leonova Emerald is a multi-function, hand-held data 
collector/signal analyzer for monitoring and diagnos-
ing machine condition. The instrument is operated via 
keypad and programmable function keys. Basic data 
for the measurement set-up can be input manually or 
downloaded from Condmaster®Ruby. 

Leonova Emerald is always programmed for the meas-
uring techniques described in chapter C. Other diag-
nostic and analytic functions, for shock pulse measure-
ment, vibration measurement and rotor balancing, are 
user selected. 

This instruction describes the general instrument set-
tings and basic operations.

Supplied accessories

14661 Wrist strap
PRO52 Leonova Service Program

Optional accessories

16573 Optional battery pack
16644 Battery adapter unit, 100–240 V AC
CHA01 Battery charger incl. AC adapter, Euro-plug
CHA02 Battery charger incl. AC adapter, UK-plug
CHA03 Battery charger incl. AC adapter, US-plug
CHA04 Battery charger incl. AC adapter, AU-plug
93484 Car charger cable, 12 V
CAB94 Communication cable, USB - mini USB, 1m
16646 Shoulder strap with safety buckle
16675 Belt clip
16686 Protection foil for display
CAS25 Carrying case, plastic with foam insert
CAS28 Carrying case, soft, with modular insert
81468 Code lock, TSA approved, for CAS25
81469 Silica gel (moisture absorbent) spare for CAS25

The equipment listed above is part of the Leonova 
instrument. In addition, transducers and measuring 
cables are needed for the measurements. These are 
bought separately, depending on which of the avail-
able measurement functions are implemented.

Leonova Emerald®

14661

CAS25

16675
CHA01/CHA02 /
CHA03/CHA04

CAS28
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Instrument overview

Position of RF 
transponder for CondID 
memory tags

Full colour screen

Wrist strap
(fastens left, right)

VIB: Vibration transducer 
input, 8 pin Lemo connector 

ARROW keys and ENTER

Power ON/OFF

SHIFT: capitals, options

M/S: start measurement /
save measurement

Strap holders
Communication port, 
mini USB

BACK

F1– F4: Function keys

MENU

Rechargeable battery pack

Headphones / headset,
3.5 mm stereo mini plug

SPM: Shock pulse 
transducer input , mini coax

RPM: Input for RPM/temp 
probe, NPN/PNP sensors incl. 
12 VDC power supply and 
stroboscope control, 
5 pin Lemo connector

Hold and pull end of rubber 
sleeve to detach Lemo 
connectors.
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Leonova is powered by a rechargeable lithium-ion 
battery pack which is easily replaceable during meas-
urement work. A warning for low battery comes up 
before the instrument turns off. No data is lost, all data 
is stored in the flash memory. Leonova has a built-in 
backup battery that lasts >15 years.

The battery pack in a new instrument has to be charged 
before use. To release the battery pack, lift and turn 
the locking screw (A), then pull out the battery pack 
from the instrument.

NOTE: It is recommended to charge the battery pack at 
least once a month. The reason for this is that the cells 
can not withstand being fully discharged completely. 

Battery Charger

The battery charger unit with AC adapter, CHA01/ 
02 /03/04, provides 9.3V/1.33A. The AC adapter is 
specified for 100 to 240 VAC, 50 to 60 Hz. Do not use 
any other type of charger or AC adapter.

Connect the AC adapter (100 - 240 V AC) to the charg-
er unit (B) and place the battery pack in the charger 
unit. 

The charger unit can also be connected to 12V power 
in a car via the car charger cable 93484.

A green LED on front of the charger indicates that 
power is connected. CHARGE (red LED) lights up dur-
ing charging. READY (green LED) lights up when the 
battery is fully recharged.

A full recharge can take up to 4 hours. The maximum 
battery capacity is 5200 mAh. ‘Power low’ warning is 
given at 25%.  

Measuring results are default stored in the flash 
memory and will not be erased if battery is low.

Battery Adapter 16644

Leonova can be connected to 100 - 240 VAC via an 
optional battery adapter, SPM 16644, when using i.g. 
long time recording. Replace the battery pack in Le-
onova with the battery adapter and connect it to the 
AC adapter.

Charge the battery pack

Only the provided battery 
charger may be used with 
the Leonova.

!

POWER

CHARGE

READY

AC adapter

Charger Unit

A

Battery Adapter
SPM 16644

AC adapter

B
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Start / Check battery status

Leonova is started with the ON/OFF key. The display 
will shut down when not used within 10 minutes (de-
fault setting) and the Leonova goes to “sleep mode”. 
By pressing the ON/OFF key the Leonova immedi-
ately will go to “sleep mode”. To leave sleep mode 
and resume work in the last position, press the ON/
OFF key.

POWER OFF is automatic when not used within 30 
minutes (default setting). 

Times for “power off” and “sleep mode” can be 
changed under MENU ‘Settings’ (see later in this 
chapter).

A battery status icon is placed in the upper right 
corner. 

About Leonova
The file ‘About Leonova’ contains important infor-
mation on the software status.

The license number and serial number belongs to 
the instrument. All upgrades concerning program 
versions and functions are connected with it. The 
package number is a running number of update 
operations.

When ordering new functions, these are delivered 
as a text file ‘Leonova.txt’. Each such order has a 
running package number and is individual for the 
instrument. The files can only be loaded in package 
order, see ‘Leonova Service program’.

To open the ‘About Leonova’ file, press MENU, se-
lect ‘About Leonova’ (1) with UP/DOWN arrow keys 
and press ENTER.

Press BACK or ENTER to close the ‘About’ window. 1
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Navigation

The navigation keys are:
 
•	 F1	to	F4	are	function	keys	used	to	select	

functions displayed on the screen above the 
keys. The functions change in various modes. 

•	 MENU	is	used	to	access	more	functions	
and settings. The menu changes in various 
modes.

•	 M/S	is	used	to	start	measurement	and	to	
save the result after measurement.

•	 The	ARROW	keys	move	within	the	display	
window or in a popup window. 

•	 ENTER	opens/activates	a	highlighted	item.	It	
also closes functions and confirms changes.

•	 BACK	switches	back	to	previous	window.

•	 SHIFT	is	used	to	provide	alternate	functions	
in the function bar.

This is the general rule. Details are explained 
under the function description.

The Leonova main screen is divided into 
three areas:

•	 the	menu	bar	(1)
•	 the	display	window	(2)
•	 the	function	bar	(3).

The function bar shows actions controlled by 
the function keys F1 to F4.

The functionality of the keys F1 to F4 can be 
changed to your personal settings (see next 
side). 

2

3

Measure /
Save

ShiftBack

Menu

Function keys

ON / OFF

1

Arrow keys

and enter
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Defining shortcut keys and menu options

The functionality of the keys F1 to F4 can be 
modified to personal shortcuts. These settings 
apply to all measurement modes.

•	 Open	a	measurement	function	and	press	MENU.

•	 Press	the	MENU	key	and	hold	down	for	3	
seconds to enter the ‘Modify mode’ (1).

•	 Mark	a	line	in	the	list	with	UP/DOWN	and	open	
the shortcut key list (2) with F1.

•	 Select	a	suitable	shortcut	key	in	the	list	and	
press OK.

You can change order and make the options in 
the MENU window visible/unvisible and insert 
separators between them.

To make a menu option visible/unvisible, mark the 
option with UP/DOWN and press F2.

To move a menu option in the list, mark the line 
with UP/DOWN and press F3. Move the option 
with F1/F2. 

Pressing MENU in the ‘Modify menu’ (1) will open 
a window (3) where you can place a separator 
between the menu options. 

Select ‘Undo changes’ to return to the default 
instrument settings.

Pressing BACK switches back to previous window 
and will save your settings. 

1

2

3
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a. FILE: Communication, measurement files saved by the user.

b. RPM: RPM measurement.

c. SPM: All shock pulse measurement techniques.

d. VIBRATION: All vibration measurement techniques.

e. USER DEFINED: Temperature measurement, User defined (manual input)

f. BALANCING: Single plain rotor balancing.

 a b c d e f

Main functions 
The menu bar at the top of the screen opens six display windows, each containing a number of files. 
Functions marked grey are not implemented in your Leonova version and can not be opened.

Navigate in the menu bar with F1 (previous) and F2 (next). 
Select function in the display window with the ARROW keys and open with ENTER.

In case of instrument malfunction, you should remove the battery pack to perform a hardware reset. 
This will erase all data in the RAM memory. 

Do not open the instrument casing. Service on Leonova may only be carried out by specially trained 
personnel authorized by SPM.

Reset

Instrument calibration
An instrument calibration, e. g. for the purpose of com-
pliance with ISO quality standard requirements, is recom-
mended once per year. The calibration is made at the 
Authorized Service Establishments.

The calibration reminder icon (1) in the upper right cor-
ner of the display shows when the Leonova is used for 
the recommended period and is to be sent to a by SPM 
authorized service establishment in your local area. 

1
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Instrument settings

The seven files in the ‘Settings’ window contain the 
general instrument settings. With a new Leonova, 
the first task is to check the available functions and 
to adjust the instrument. 

Press SHIFT+F3 to open the instrument settings 
window, or press the MENU key and select ‘Settings’ 
with the UP/DOWN arrow keys. Open with ENTER.

In the ‘Settings’ window, select file with the UP/
DOWN arrow keys, open with ENTER or F1.

When the appropriate settings are made, press the 
MENU key. Select ‘Previous’ or ‘Next’ with  F1/F2 to 
make additional settings. Press the BACK key to save 
the instrument settings and quit settings mode.

These are the files:

•	 General	settings,	a	menu	for	several	functions.

 Select units: the default is mm, °C, Hz.

 dB mode: scale in dB for the y-scale in spectrum. 

 Icons: show large/small icons.

 Layout: measuring point tree layout, preview live 
spectrum, show theoretical symptoms.

 Automatic save: Prompt to save after measure-
ment. 

 Balancing: select ounce, counter rotational de-
grees and  output unit (ACC, VEL, DISP).

 Screen: Adjust brightness.

 Power saving: Adjust time for ‘sleep mode’ and 
automatic ‘power off’. 

•	 Date/time:	Adjust	when	needed.

•	 Tansducers:	Register	your	transducer(s).	Attention!	All	values	must	be	taken	from	the	trans-
ducer’s calibration card. 

•	 Language:	Choose	among	available	languages.

•	 Fonts:	Select	text	presentation.

•	 Create	default	files:	Creates	the	initial	files	needed	to	use	the	measuring	functions.

•	 Function	and	use:	Shows	available	functions.
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General settings

The files under ‘Settings’ cannot be moved, re-
named or deleted. Select with UP/DOWN arrow 
keys, open with ENTER.

‘General settings’ has its own menu bar (1).

Select tab (1) with F1/F2. Move in the list with the 
UP/DOWN arrow keys, mark/unmark with ENTER.

Marking the box (2) changes from mm to 
inch, acceleration in g, from °C to °F and 
from Hz (Hertz = cycles per second) to 
CPM (cycles per minute, similar to rpm).
Marking a dB mode (3) will change the y-
scale to decibell.

1

2

4

5

3

‘Use temporary file’ will save the round temporary 
while saving. 

‘Preview live spectrum’ will show spectrum in real 
time.

‘Low resolution warning’ when the resolution is 
too low for an accurate result. 

‘Possible to determine rpm from spectrum’ makes 
it possible to get the rpm by setting out a marker 
in the spectrum.

‘Default FFT calculation for SPM HD’ is normally 
selected. If turned off it affects all SPM HD and 
LR/HR HD assignments.

When ‘Large icons’ (4) is not marked, 
files are listed as shown above (5).
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1

This selection (1) affects the measure-
ment window. 

‘Measuring point name . .’ repeats the name on a 
separate line. 

Settings for the ‘Measure All’ function: Show 
‘Measure All’ on separate line, show ‘Measure All’ 
information dialog and open summary view after 
‘Measure All’ measurement.

‘Display colours . .’ displays the evaluation icon 
for each listed measuring technique. 

‘Automatic save . .’ opens a ‘Save yes - no’ win-
dow immediately after a measurement. 

‘Lagging Phase’ means that the phase angle 
increase opposite to the direction of rotation (see 
General settings in the Rotor Balancing chapter 
for details).

‘Ounce’ changes weights from grams to ounces.

‘Output unit’, selected from a list (2), is the unit of 
the vibration measurement (acceleration, velocity 
or displacement).

These selections concern ‘Balancing’. 

2
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Display setting. 

You can change the backlight brightness (1). In-
crease or decrease with LEFT/RIGHT arrow keys. 

You can name your instrument (2). The name ap-
pears when communicating with the computer. 
If you have not named the instrument the instru-
ment serial number will be displayed.

1

Set date/time
Before measuring with Leonova, update the 
internal clock. The measurements time data is of 
great importance when transferred to Condmas-
ter.

To make the update, open ‘Date/Time’ (4) under 
‘MENU/Settings’. Select the date field and press 
ENTER. Select month with F2/F3 and navigate 
with the arrow keys to select date (5). Press F1 
to save.

To set the time (6), select the time field and 
press ENTER. Use LEFT/RIGHT arrow keys to 
change field and UP/DOWN to change value.  
Press F1 (OK) to save.

5

6

4

Power saving. 

You can adjust the time for ‘sleep mode’ (3). The 
display will shut down when not used within this 
setting. ‘Power off’ (4) will shut down the instru-
ment completely when not used within this time. 

Select with UP/DOWN and confirm with ENTER.

To disable the automatic power off, leave it blank 
(none). Remember to reset a value in order to turn 
off the instrument.

3

4

2



A:14   General instrument functions

A

Register transducers

1

5

3

2

4

Transducer type SPM 40000/42000/44000 is added automati-
cally in the register and can not be edited or deleted. The instru-
ment can also work with SPM DuoTech transducers and any other 
transducer of IEPE (integrated electronic piezoelectric) type with 
voltage output. Transducers of not IEPE type which do not require 
power supply, like velocimeters, can also be used. The ‘IEPE type’ 
has then to be set to ‘No’.

To register a new transducer, open ‘Settings’ with SHIFT+F3. Se-
lect ‘Transducers’ (1) to open the register (2).

Select ‘New’ (3) with the F1 key, then input the following data. 
Press F1 to save the settings and close with the BACK key.

The min. and max. bias voltage (5) is needed for the TLQ 
test (Transducer Line Quality test, returning ‘TLT error. Bias 
value out of range’ when the measured voltage is above the 
max. bias voltage or below the min. bias voltage.

The actual sensitivity of the individual transducer is writ-
ten on its calibration card. This data should always be input 
in the transducer register. When several transducers are in 
use, they should be marked to assure that the readings are 
calibrated.

Name: A descriptive name. It will be shown 
on the list of transducers.

Input type: Type of transducer; vibration 
transducer, DuoTech or user defined. 
Setup of user defined (4), see page 
A:16.

Type: The measured vibration parameter, 
either ACC (acceleration), VEL 
(velocity) or DISP (displacement).

Sensitivity: The transducer’s nominal sensitivity 
in the displayed unit (which depends 
on the input under ‘Type’). Select 
‘User defined’ (4) for other types of 
transducers, eg. current clamp.

Max. frequency: The transducer’s upper frequency 
range.

IEPE type: YES or NO. ‘Yes’ opens the next 
three lines.

Min. bias range: The lower working voltage.

Max. bias range: The upper working voltage.

Settling time: Stabilizing time for the transducer 
after ‘power on’.
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6

3

5

4

Default transducers for shock pulse and 
vibration measuring techniques are set up via 
the transducer register. Default transducer 
is the active transducer when ‘Portable’ 
transducer is selected under ‘Measuring point 
data’.

Press SHIFT+F3 to open ‘Settings’. Select 
‘Transducers’ and press F1 (OK) to open the 
transducer register (1).

Press F4 (2) to open the window ‘Default trans-
ducers’ (3). To select a default transducer for 
a measuring technique, mark a technique and 
press F1 (OK). Active transducer will be shown 
(4).

To change transducer, press ENTER to open 
the list of registered transducers (5). Mark a 
name on the list and press F1 (OK) to confirm. 
The new transducer is shown in the window 
(4). Press F1 (OK) to confirm and close with the 
BACK key.

To select default transducers for the balancing 
function, mark ‘Balancing’ in the window ‘De-
fault transducers’ (3). Press ENTER and register 
the transducer (6) to be used. 

To see or edit transducer data, mark its name 
in the transducer register (1) and press F2 
‘Edit’ (7). You can edit the transducer’s data 
and change the transducer name. Mark a line 
in the register with the arrow keys, open the 
keyboard with ENTER and edit the data. Press 
F1 to save the settings and close with the 
BACK key.

When standing in a measuring round, you can 
press SHIFT+F4 to jump to the default trans-
ducer setting which can be useful if you need 
to change default transducer for a measuring 
point.

27

1

Default transducers



A:16   General instrument functions

A

User defined transducers

Other types than vibration transducers can be 
used, e.g. amp clamp, pressure and flow sensors, 
that connects to the VIB input. These are set up in 
the transducer register as ‘User defined’ transduc-
ers.

To register a user defined transducer, open ‘Set-
tings’ with SHIFT+F3. Select ‘Transducers’ to open 
the register (1).

Select ‘New’ with the F1 key, then input the fol-
lowing data: 

Name: A descriptive name.   
It will be shown on the list 
of transducers.

Type: Select ‘User defined’.

User defined, name: The measured parameter.

User defined, unit: The measured unit.

Sensitivity: The transducer’s nominal 
sensitivity in mV / measured 
unit.

IEPE type: Select ‘No’. 

Press F1 to save the settings and close with the 
BACK key.

To select the ‘User defined’ transducer’ as default 
transducer, press F4 and select ‘Vibration’ (2). 
Press ENTER and select ‘Pressure transducer’, as 
in the example (3). 

For EVAM assignments, both ‘Time signal unit’ 
and ‘Spectrum unit’ have to be set to “User de-
fined” (4).

Note! When ‘Time signal unit’ is set to ‘User 
defined’, the “User defined, name” and “User 
defined, unit” must be exactly the same as the 
corresponding parameters for the transducer in 
order to be able to perform a measurement. In the 
example beside, the name “Pressure” and the unit 
“Bar” (5) are the same as for the transducer (6).

To edit the transducer data, press F3 to open the 
transducer register.

When using a ‘User defined’ transducer the ‘RMS’, 
‘Peak’ and ‘Peak to peak’ values   are shown in the 
result window ( 7). The graphs are displayed in the 
selected units.

1

6

5

4

2 3

7
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Select tab (1) with SHIFT + LEFT/RIGHT ar-
row keys. The tabs corresponds to a set of 
numbers or alphabetical letters.

Navigate to the desired character line (2) 
with UP/DOWN arrow keys.

Press F1-F3 a number of times to obtain 
the desired character, one by one. Press-
ing a function key will type out the first 
character that it corresponds with (e.g., F1 
accesses ‘abc’, so pressing the F1 key once 
will type out an ‘a’). To type a ‘b’ or ‘c’, you 
have to press the F1 key twice quickly or 
three times quickly, respectively.

To obtain capital letters, hold down the 
SHIFT key.

Navigate in the input field (3) with LEFT/
RIGHT arrow keys. You can delete charac-
ter with F4. To finish, press ENTER. 

Edit text and numbers

Change TAB (1) = SHIFT + LEFT/RIGHT

Change character line (2) = UP/DOWN

Capitals = hold down SHIFT

Delete = press F4

Confirm = press ENTER
2

1

3

SHIFT
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Select language

The file ‘Language’ under ‘MENU/Settings’ 
allows you to choose Leonova screen lan-
guage (1). To change to another language, 
change with UP/DOWN arrow keys and 
select with F1.Press OK (F1) or ENTER to re-
start the instrument with the new language.

English is always included. If an additional 
language is desired  , please contact your lo-
cal SPM representative.

1

Change font, size and style

The ‘Fonts’ menu under ‘MENU/Settings’ allows 
you to make individual changes of font, style and 
size for any of the listed alternatives (2). 

When showing file names, Leonova uses the larg-
est text that fits into the available space, going 
from ‘Normal’ (16 points) via ‘Medium’ (14 points) 
to ‘Small’ (12 points). Thus, if you have difficulties 
reading ‘Small’ text, you can change the text size 
of ‘Small’ from 12 to 14 points.

Leonova will truncate file names that are too 
large to fit on one line. Using several words or 
hyphens in the name will put it on two or more 
lines. 

Marking an item on the list and pressing F1 (Edit) 
opens the window (3) where you can set char-
acter size and/or select another font (4) for the 
item. Mark the font name, press ENTER to open 
the font list (5). Please note that this will not af-
fect the other items.

Press MENU and select ‘Close’ to save settings. 
‘Reset fonts to factory default’ (6) will reset all 
items to default values. 

4

2

3

5

6
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Create measurement files
The file ‘Create default settings’ (1) under ‘Set-
tings’ is very important. It creates measurement 
files for all measuring techniques and places 
them under the measuring technique windows. 
You cannot use Leonova as a stand-alone meas-
uring instrument without these files.

The installation is simple: Press MENU and open 
‘Settings’. Select ‘Create default settings’ and 
press F1 (OK).

The example shows the measurement files cre-
ated in the vibration technique window: a file for 
vibration ‘1000 Hz/1600 lines’ and a file each for 
vibration measurement according to ISO 10816 
and ISO 2372.

1

Function and use

Leonova has a number of ‘platform’ functions which 
are always available. Other functions are user 
selectable and can be bought in retrospect when 
needed.

‘Function and use’ under ‘MENU/ Settings’ shows 
a list of all functions (2), each followed by an icon 
showing its status:

Available functions.

Not available in this instrument.

Loaded measuring rounds are shown at the bottom 
of the list. 

The loading of new functions is described under 
’Leonova service program’.

2
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Order functions

After buying Leonova Emerald, optional func-
tions can be ordered from your SPM supplier.
 
You will receive the text file Leonova.txt. It 
is coded to the instrument’s license and also 
contains a running package number. The files 
have to be loaded in package number order.

Connect Leonova to the PC and use ’Load 
function to instrument’ to transfer the file 
contents.

Optional functions

EME195  SPM HD Expert, frequency and time  
  domain analysis

EME197  Shock pulse method HDm/HDc

EME130  Shock pulse method dBm/dBc

EME131 Shock pulse method LR/HR

EME132 SPM Spectrum

EME133 Vibration ISO 10816 with spectrum

EME134 Vibration Premium, including:

   HD ENV

   FFT spectrum with symptoms

   6400 lines, 10 kHz

   HD Order tracking

   Time signal

   Post trigger

EME193 Vibration Supreme, including:

   HD ENV     
   EVAM evaluated vibration analysis

   12800 lines, 20 kHz

   HD Order tracking

   Time signal

   Post trigger

EME140 HD Analysis

   Vibration Supreme

   SPM HD Expert

EME109 Balancing, single plane

Platform functions (always included)

•	SPM	HDm/HDc	and/or	SPM	LR/HR

•	1	channel	vibration

•	RMS	vibration	,	ISO	2372

•	Speed	measurement

•	Temperature	measurement

•	Stethoscope	function

•	Measuring	point	identification	using	

CondID® memory tags

•	Recording

•	Manual	recording,	free	quantity

•	Check	points,	free	text

•	Recording	of	vocal	comments
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Replacement of Protection foil 16686

1. Wash your hands thoroughly before applying the film. Clean the Leonova carefully from dust and 
grease.

2. Spray the tips of your fingers before handling the protection foil, in order to avoid leaving finger-
prints. Separate the foil from its backing.

3. Hold up the protection foil with the sticky side pointing upwards.

4. Spray liberally on the sticky side and lightly on the top side of the foil. Run a moist finger over the 
sticky side, and spread the liquid evenly over the entire surface.

5. Apply the protection foil to the instrument with the sticky side 
down and drag the protection foil into the right position.

6. Use the plastic squeegee to remove possible bubbles and 
moisture, work outwards from the middle. It is advisable to hold 
the foil in place with a finger while doing this so that it doesn’t 
move.

7. Dry off any excess moisture with a cloth. Small bubbles and unevenness will disappear of their 
own accord within a few days.

8. Let the protection foil dry 12 hour before use.

Procedure for replacing or moving wrist strap
The wrist strap is easily loosened by unbutton the handle, then loosen the Velcro in the end of 
the strap. Loosen the strap from the metal buckle at the other end. Install the wrist strap in the 
opposite manner and adjust the strap length by moving the metal buckle.

Positioning
of protection 
foil

Maintenance and repair

Replacement of the protection foil, wrist wrap and and exchange of battery pack are the only repair 
actions allowed.  All other repair actionsare not allowed. Send the instrument to a by SPM authorized 
service establishment in your local area.

To clean the external surfaces of the product, wipe the casing with a damp cloth and mild detergent.
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Leonova connects to the PC via the USB cable 
CAB94. Leonova communicates with

• Leonova Service Program.
• Condmaster®Ruby

Place both programs into the same folder on your 
PC.

To start communication, press SHIFT+F1 to open 
the communication mode, or select ‘Communica-
tion’ (3) under the ‘File’ menu and press ENTER.

Connect the USB cable between instrument and 
computer. Control the communication from the 
computer. Press F4 (Close) to exit the communica-
tion mode.

On the PC, open ‘Data transfer’ or ‘Planning’ in 
Condmaster.

Communication with the PC

1

Leonova service program

The Service Program is used to 

• print and save balancing reports.

• load additional functions from the file 
‘Leonova.txt’.

• check for updates of Leonova Service 
Program. This function requires that 
your computer is connected to the 
Internet. Shows version info, available 
and current versions.

• upgrade the Leonova 
software from the file 
‘LeonovaDiamondAndEmerald.swp’.

• transfer language files from file ‘*.llf’. 

• upload and download Leonova files 
to/from the PC (file extension .LRF).

• make and reload safety copies of the 
Leonova files (file extension .lsc).
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Upgrade Leonova software

To upgrade the Leonova software,

• Open ‘Communication’ on the instru-
ment.

• Connect Leonova to the PC.

• Start the Leonova Service program on 
the PC.

• Select ‘Upgrade software on 
instrument’.

• Input the path to the file 
‘LeonovaDiamondAndEmerald.swp’ 
and click CONTINUE.

IMPORTANT! Always upgrade the Service Program and Condmaster to the latest version when 
upgrading the Leonova MMI software. It is critical that the software are in sync with each other. The 
Service program version numbers will always follow Condmaster version numbers and the two will 
always be released together. 

The latest versions of the Service Program and Leonova MMI software can be downloaded from the 
SPM homepage:

• www.spminstrument.com

Under ‘Downloads’, open ‘SPM Software’, and ‘Leonova Diamond/Emerald’. Download the file 
‘LeonovaDiamondAndEmerald.swp’ to your PC.

To load a new or updated language file, select ‘Transfer language file to instrument’. 

Language files translated for an older software version may cause some text elements in the pro-
gram to fall back to english language. Please contact your local SPM representative for an updated 
language file (*.llf). 
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Safety copies of Leonova files

The Leonova Service program 
is also used to make safety 
copies of all measurement files 
saved in Leonova, and to reload 
these files to Leonova when 
needed. Leonova safety copies 
must have the extension ‘lsc’; 
the rest of the file name is your 
choice.

To make a safety copy,

•	 Connect	Leonova	to	the	PC.

•	 Open	‘Communication’	on	the	
instrument.

•	 Start	the	Leonova	Service	pro-
gram on the PC.

•	 Select	‘Safety	copy’,	click	
CONTINUE.

•	 Select	a	folder	on	your	PC,	e.g.	
your Condmaster folder, and 
click SAVE.

When reloading from a safety copy, there are two 
alternatives, all files or a single file. The single file 
option can be used to transfer a measurement 
file from one Leonova to another, and from there 
to Condmaster.

Select ‘View file information’ to see instrument 
data, licenses, etc. Select ‘View log file’ to see 
the instrument’s log file.
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To reload a safety copy,

•	 Connect	Leonova	to	the	PC.

•	 Open	‘Communication’	on	the	instru-
ment.

•	 Start	the	Leonova	Service	program	on	
the PC.

•	 Select	‘Reload	safety	copy’.

•	 Select	the	file	to	be	loaded,	click	OPEN.

•	 Select	‘Reload	all	files’	or	‘Reload	single	
file’. ‘All files’ will erase the present files 
on Leonova. Continue with YES when you 
get the warning. For ‘Single file’ you get 
a file list where you make your selection 
and click OK.

Reload safety copies of Leonova files

Upload and download files to PC

Files are uploaded/downloaded to PC 
usually when Condmaster not is available. 

To upload a file from Leonova;

•	 Connect	Leonova	to	the	PC	and	set	the	
instrument in ‘Communication’ mode.

•	 Start	the	Service	Program	on	the	PC.

•	 Select	‘Uploaded	Files’	and	press	
‘Upload From Instrument’. 

•	 Mark	a	file	in	the	‘Select	Round	File’	
window and press OK to transfer the 
file ( .LRF) to the PC.

•	 You	can	organize	the	uploaded	files	by	
moving them into folders. 

•	 Press	‘Windows	Explorer’	or	‘Copy	File	
To Clipboard’ to make a copy of the 
file.

•	 To	download	a	file	to	Leonova,	select	
file and press ‘Download To Instru-
ment’. 
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File management in Leonova

The ‘File’ menu contains all user created 
measurement files, with one exception. The 
file ‘Communication’ (1) is a system file which 
cannot be renamed or deleted.

The default files for single measurement 
functions remain on their function menu 
unless you save them as a user created file 
under another name. This puts them as new 
files (2) onto the ‘File’ menu.

Files downloaded from Condmaster also get 
onto the ‘File’ menu. They are marked with a 
‘measuring round’ icon (3).

To open a file, select the file with the arrow 
keys and press ENTER. 

For file management, mark the file and press 
SHIFT+F2. This opens a menu from where you 
can delete or rename the marked file and see 
the file information (4). Select ‘File informa-
tion’. Press ENTER to open the info window.

All user created files are stored on Leonova’s 
built-in SD card. ‘File information’ allows you 
to check the file size (5) and free memory on 
the SD card. 

32

4

1

5
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List of icons

1. Go to main function FILE.
2. A file, e.g. a measuring round.

1. Go to main function SPEED.
2. A speed measurement.

1. Go to main function SPM.
2. SPM dBm/dBc and LR/HR measurement.

Go to main function VIBRATION.

Go to main function USER DEFINED.

Go to main function BALANCING.

Go to instrument SETTINGS.

Language selection for Leonova screen 
texts.

Transducer register.

Open default files for measuring 
techniques.

Available functions.

Set disply brightness.

Set time  for sleep mode and power off.

Communication with PC.
 
CondID measuring point identification.
 
Create new.

Edit.

Keyboard for input of text and numbers.

Manual input of measuring results.

Vibration measurement, ISO 10816.

Vibration measurement, ISO 2372.

Quick mode.

Component.

Measuring point.

HD ENV measurement.

SPM HD measurement.

SPM LR/HR HD measurement.

SPM Spectrum measurement.

Transducer Line Test.

Vibration measurement, EVAM/FFT.

Show measuring point data.

Browse through measurements.

Show measuring results.

Show measuring result diagram.

Show spectrum.

Show time record.

Good condition (green).

Condition warning (yellow).

Bad condition (red).

Good condition, but above alarm limit.

Condition not evaluated.

Alarm limit exceeded.

Measurement completed.

Earphone connected. Change volume.

Balancing, single plane, 2 runs and 4 runs.

Calibration reminder.

Information.
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Technical specifications

Instrument, general

Housing: ABS/ PC / TPE

Protection class: IP65

Dimensions: 306  x 108  x  71 mm 
 (12.4” x 4.3” x 2.8”)

Weight: 860 g (30.3 oz.)

Keypad: sealed, snap action

Display: TFT colour, 240 x320 pixels, 
3.5 inch, adjustable backlight

Main processor: 400 MHz ARM®

Memory: 256 MB RAM, 512 MB Flash

SD memory card: 1GB

Operating system: Microsoft Windows® CE

DSP processor: 375 MHz floating point

Dynamic range: up to 120 dB,    
24 bit A/D converter

Communication: USB 2.0

Input channels: 1 x VIB, 1 x  SPM,    
1 x rpm , 1 x temperature

Input/output, headset: 3.5 mm stereo plug

Input/output, 
communication: Mini USB

Power supply: rechargeable Lithium-Ion 
battery pack 5200 mAh or 
power adapter 

Battery power: for min. 18 hours normal use  
(at 20°C)

Charge time: < 4 hours

Operating temperature: -20 to 55 °C  (-4 to 122 °F)   
non condensing

Charging temperature: 0 to 45 °C  (32 to 113 °F)

General features: language selection, customized 
view, voice recording, battery 
status idication, transducer line 
test, metric or imperial units

Meas. point 
identification: NFC transponder for 

communication with CondIDTM 

tags, read distance max. 50 mm 
(2 inch)

SPM input

Shock pulse channels: 1

Measuring techniqes: SPM HD, dBm/dBc, LR/HR and 
LR/HR HD 

Transducer line test: TLQ test

Transducer types: SPM 40000, 42000, 44000, 
probe transducer and quick con-
nector transducer

VIB input
Vibration channels: 1

Frequency range: 0 (DC) to 20 kHz

Resolution: max. 12 800 lines

Transducer line test: bias voltage check

Transducer types: SPM SLD or IEPE* (ICP) type 
with voltage output < 24 Vpp, or 
DuoTech accelerometer. Trans-
ducer supply of 2.5 mA can be 
set On/Off

User defined transd.: e.g. current clamp, pressure and 
flow sensors with voltage output

Measuring techniqes: ISO 2372, ISO 10816, FFT with 
symptoms, EVAM vibration 
analysis, HD Enveloping, 
balancing

RPM input

Channels: 1, RPM or temperature

Measuring range: 1 to 150 000 pulses/min.

Resolution: 1 pulse

Accuracy: ± (1 pulse + 0.1% of reading)

Transducer type: SPM TTP10, TTL-pulses,   
Key phasor®, proximity switch 
NPN/PNP

Output: TTL signal for controlling 
stroboscope and 12 VDC supply

Temperature measurement

Temp. range (TTP10) : -20 to 300 °C  ( -4 to 572 °F)

Accuracy (TTP10) : ± 2.5 °C 

Transducer type: SPM TTP10

Stethoscope

Settings: Filter, volume and gain

Transducer types: Shock pulse and vibration 
transducers
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Shock pulse method LR/HR

Measuring range: -19 to 99 dBsv

Resolution: 1 dB

Accuracy: ± 1 dB

Measuring time: 1,5 sek

Input data: rpm, plus bearing type 
and mean diameter (or ISO 
bearing number)

Output: LR and HR (raw shock values), 
CODE A to D, evaluated 
green-yellow -red. LUB no. 
for oil film condition, COND 
no. for surface condition.

SPM Spectrum

Additional function to:  dBm/dBc, LR/HR

Frequency range: 0 to 20 000 Hz, order tracking

Spectrum lines: 400, 800, 1600, 3200, 6400,  
12800

Meas. windows: Rectangle, Hanning, 
Hamming, Flat Top

Spectrum types 
displayed: linear, power

Averages: FFT linear, FFT peak-hold

Frequency units: Hz, CPM, orders

Saving options 
for spectrum: full spectrum, peaks only

Amplitude unit: SD (Shock Distribution), SL 
(Shock Level) 

Scaling: linear or logarithmic X and Y 
axis

Zoom: true FFT zoom, visual zoom

Symptom recognition: bearing frequencies and 
optional patterns highlighted 
in the spectrum. Automatic 
config.of bearing symptoms 
linked to ISO bearing no.

Shock pulse method SPM HDm/HDc

Measuring range: -30 to 110 dBsv (with 
transducer type 44000)

Resolution: 0.2 dB

Accuracy: ± 1 dB

Input data: rpm, plus bearing type and 
shaft diameter (or ISO bearing 
number)

Output quantity: maximum value HDm, carpet 
value HDc, evaluated green/
yellow/red

Shock pulse method SPM HD Expert

Additional function to: HDm/HDc, LR/HR

Output quantity: Time signal HD, SPM HD 
Spectrum, HD Order tracking

Spectrum lines: 400, 800, 1600, 3200, 6400, 
12800

Measuring time: 1 to 10000 rev (default same as 
FFT)

Symptom enhance-
ment factor:  Off, 1-10 (Default = off)

Symptom recognition: bearing frequencies and 
optional patterns highlighted 
in the spectrum. Automatic 
config.of bearing symptoms 
linked to ISO bearing no.

Shock pulse method dBm/dBc

Measuring range: -9 to 99 dBsv

Resolution: 1 dB

Accuracy: ± 1 dB

Measuring time: 1,5 sek

Input data: rpm, shaft diameter (or ISO 
bearing number)

Output: maximum value dBm, carpet 
value dBc, evaluated green 
- yellow - red, peak value, 
audible shock pulse signal 
(earphones).
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Vibration severity ISO 2372

Measurement 
quantities: velocity, RMS value in mm/s 

over 10 to 1000 Hz

Evaluation table 
selection: menu guided, ISO 2372 

Transducer line test: bias voltage test

Vibration severity ISO 10816 with spectrum

Measurement 
quantity: velocity, acceleration, and 

displacement according 
to individual parts in the 
standard

Spectrum,  linear, 1600 lines, Hanning  
window. 

Quick mode: yes (can be set ON/OFF)

Transducer line test: bias voltage test

HD ENV

Spectrum lines, frequency and envelope filter limits are 
regulated by what is included in the vibration package.

Frequency limit, upper: stated in orders

Envelope high pass filters: 100, 200, 500, 1000, 2000, 
5000, 10 000 Hz

Envelope band pass filters: Filter 1 = 5 -100 Hz  
Filter 2 = 50 -1000 Hz 
Filter 3 = 500 -10 000 Hz  
Filter	4	=	5000	-	40	000	Hz*

Averages: Time synch

Spectrum lines: 400, 800, 1600, 3200, 6400, 
12800

Frequency units: Hz, CPM, orders 

Saving options: full spectrum, time signal and 
FFT, condition parameters

Vibration analysis, EVAM/FFT with symptoms

Frequency limit, 
lower: 0 (DC) to 200 Hz

Frequency limit, 
upper: 8 to 20 000 Hz (EVAM) 
 8 to 10 000 Hz (FFT)
 order tracking
Envelope high 
pass filters: 100, 200, 500, 1000, 2000, 

5000, 10 000 Hz
Envelope band 
pass filters: 5-100, 50-1000, 500-10 000, 

5000-40 000 Hz
Measurement 
windows: Rectangle, Hanning, 

Hamming, Flat Top

Averages: time synchronous, FFT linear, 
FFT peak-hold

Spectrum lines, EVAM: 400, 800, 1600, 3200, 6400, 
12800

Spectrum lines, FFT: 400, 800, 1600, 3200, 6400

Saving options: time signal (FFT calculated), 
full spectrum, time signal and 
FFT, condition parameters

Spectrum types 
displayed: linear, power, PSD

Zoom, EVAM: true FFT zoom, visual zoom

Zoom, FFT: visual zoom

Quick mode: yes (can be set ON/OFF)

Frequency units: Hz, CPM, orders

Trigger selection: RPM trigger, post trigger

Transducer line test: bias voltage test

*	Integral	Electronic	PiezoElectric

Specifications are subject to change without notice.
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Leonova measurement functions

Leonova Emerald® always has the following measurement functions with unlimited use:

• HDm/HDc and/or SPM LR/HR
• RMS vibration measurement according to ISO 2372
• Speed measurement, rpm and peripheral
• Temperature measurement
• User defined (manual input)
• Stethoscope
• Vocal comments
• CondID, NFC measuring point identification 
• Automatic recording of measuring results

The remaining measurement functions are user selected:

• Shock pulse measurement SPM HD, time and frequency domain 
analysis

• Shock pulse measurement LR/HR with SPM Spectrum and 
time signal

• Shock pulse measurement dBm/dBc and SPM Spectrum
• Vibration measurement according to ISO 10816, with spectrum
• Vibration Premium or Vibration Supreme for evaluated vibration 

analysis
• HD Analysis
• Balancing, single plane

For each measurement, the user can input a comment as text or voice recording.

Measuring modes
Leonova is primarily designed as a data logger. Measuring rounds, complete with all input data for 
evaluated measurements, are downloaded from a PC running the SPM software Condmaster®Ruby. 
After measurement, the results are uploaded to the PC.

When data logging, the operator works along a predetermined route and measures ‘in measuring 
round order’. As an alternative, CondID memory tags can be attached to the machines. A measuring 
point, belonging to a downloaded measuring round, is identified by reading its tag. Leonova dis-
plays that point and its data, ready for measurement. 

For unprepared measurement, Leonova contains a ‘default file’ for each measuring technique. When 
required, the input data are entered manually by editing the default values. Edited default files can be 
saved as new default files, or as user files which retain both the input data and the measuring results.



B:4   General measurement functions

B

The instrument can be set up to perform a transducer line quality test (TLQ) before measurement. 
Testing the quality of signal transmission between transducer and instrument is essential because, in 
a poor transducer line, part of the signal will be lost. This in turn means that measuring results will be 
lower than they should be.

The overall term for the concept of transducer line quality testing is TLQ. Depending on the transducer 
used, the following applies regarding units of measure and accepted values:

If the TLQ value is outside the accepted level(s), the measuring result cannot be saved.

Further information regarding TLQ is found in the respective measuring technique chapters in this 
manual.

Transducer type 40000, 42000 44000 Vibration transducers, IEPE

TLQ type TLT TLR Bias voltage

Unit of measure No unit kΩ Volt

Accepted values 15 – 25 26 – 40 kΩ According to transducer settings

Transducer Line Quality, TLQ
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Measuring point data settings 

1

2

Measurement with default files is used for a ‘once 
only’ check, where you do not need to save the 
measuring result. Default files are available for all 
measuring techniques and are activated with the 
menu option ‘Create default settings’ under MENU 
> Settings.

• Select a measurement function from one of the 
tabs. In this example, ‘User defined’ is selected 
(1). On the selected tab, pick one of the default 
files (2). 

• Mark the file and press the ENTER key to open 
the measurement function. Press the MENU key 
> ‘Measuring point data’ > ENTER to display the 
available settings.

• In this example (temperature measurement), the 
only setting available is ‘Variable speed’ (3). This 
can be activated if you want to measure RPM in 
conjunction with the temperature measurement. 
Use the UP/DOWN arrow keys to mark this setting 
and press enter to activate it.

• Close ‘Measuring point data’. Connect the probe, 
measure and check the result. If you choose to 
save the measuring result, you can view it under 
‘Graphics’ while the file is still open.

3

Measurement with default files
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Measurement with edited default files

Editing the measuring point data only temporarily 
modifies the default file. Depending on the measuring 
technique selected, different settings are available 
for editing. In the example on the previous page, 
only one parameter can be edited for temperature 
measurement, namely ‘Variable speed’.  

To the right is an example showing the default 
settings for SPM HD measurement (1), all of which 
can be edited. In the second screen shot (2), shaft 
diameter and RPM have been input, and the meas-
uring time set to equal 10 revolutions.

After editing measuring point data, you can do one 
of three things: 

• ‘Close’ (3) simply closes the default file, without 
saving the edited measuring point data or the 
measuring results. 

• To keep the edited measuring point data perma-
nently, use ‘Save as file’ (4) before closing the file. 

• The choice ‘Save as new default settings’ (5) cre-
ates a new default file which you have to name 
(6). For further information, see overleaf.

The name of the new default file is shown in the 
measurement window (7). 

2

6

7

4

5
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When closing a default file with the ‘Save as file’ 
option (1) you will be prompted to input a file name 
via the keyboard window (2). The file will then be 
accessible from the FILE window (3).

The file thus saved keeps both the edited measur-
ing point data and the measuring results. It can be 
opened to add more measurements.

Single measurement user files

2

1

4

3
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Further measuring techniques can be added to a 
single measurement user file after it has been saved 
under a name and appears in the FILE window.

Press ENTER to open the file. Press the MENU key 
and select ‘Add technique’ (1). This opens the ‘Add 
technique’ window (2), listing every default file saved 
on the various measuring technique tabs. 

Mark a measuring technique and press the ENTER (or 
F1) key to select it. The name of the new measuring 
technique will be added below the existing ones in 
the measuring window (3). 

To get the correct measuring point data for all 
measuring techniques under the same measuring 
point, you can configure and save the default file 
before you add more techniques. Alternatively, edit 
the measuring point data for each technique in the 
new user file. Save it under a new name if you want 
to keep the original user file.

To measure vibration or shock pulses with variable 
speed, select the speed technique and do not input 
an rpm value with the measuring point data for the 
others.

Multi-measurement user files

3

1

2
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‘Recording’ on the measurement menu (1) is a func-
tion for taking a stated number of readings at stated 
intervals, or measure for a stated number of minutes.

Default files and single measurement user files can 
be used when recording a single quantity, e. g. shock 
pulses or a certain type of vibration.

However, the ‘Recording’ feature is consecutive 
measurement of different quantities, using up to 
three different transducers simultaneously con-
nected to Leonova:

• a shock pulse transducer on the SPM input
• one vibration transducer on the vib input
• a tachometer or temperature probe on the ta-

chometer/temperature input

To set up a consecutive recording of a shock pulse 
measurement, a vibration or rpm measurement and 
possibly temperature (or any combination of these), 
one needs a measuring point where all wanted 
measuring techniques are active. This measuring 
point is either downloaded from Condmaster, or it 
is a multi-measurement user file (see previous page).

Define the number of measurements or minutes (2) 
and the time interval (3) between measure ments (0 
minutes = as fast as possible). Use the F1 key (NEW, 
4) to select measuring techniques from the list (5) 
and put them into the measuring sequence (6). A 
selected technique can be replaced by another 
with EDIT (7) or be deleted with (8). Connect the 
transducer(s) and press the MEASURE/SAVE (M/S) 
key to start.

The results can be seen on the graphics display and 
can be uploaded to Condmaster.

For SPM and vibration measurements with variable 
speed, select ‘Speed’ as a technique and do not 
input an rpm under ‘Measuring point data’.

Recording 
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For efficient, systematic condition monitoring, Le-
onova is used as a data logger. Measuring points are 
set up in Condmaster and downloaded to Leonova, 
complete with all input data for any or all of the 
supported measuring techniques. For instructions, 
see the ‘Working with Condmaster Ruby’ user guide.

Downloaded measuring rounds are placed in the FILE 
window (1). To measure, mark the file and press the 
ENTER key to open (or press MENU > ‘Open’ (2)).

Measuring rounds cannot be renamed in Leonova, 
because Condmaster needs the original round name 
as an identifier.

After uploading a measuring round back to Cond-
master, it can be deleted from Leonova (3). If you 
keep it in the instrument, it will be overwritten next 
time you download the same measuring round from 
the PC.

Components and measuring points in downloaded 
measuring rounds are shown in the order they were 
arranged in Condmaster. All the operator has to do 
is connect the appropriate transducer and use the 
Leonova MEASURE/SAVE (M/S) key to obtain and 
save the measurements.

In Condmaster, the components and measuring points 
contained in a measuring round can be organized  
under labels (4) to create a logical structure and 
improve measuring route efficiency.

Mark a component and press SHIFT+UP/DOWN to 
move between components (5) and mark a meas-
uring point or label to jump to next view.

To add a technique to a measuring point, press 
MENU > ‘Add technique’ (6). This technique will be 
automatically saved as part of the measuring point 
in Condmaster. 

A new measuring point can also be added to a meas-
uring round (7). It is sufficient to name the measuring 
point temporarily and select at least one measuring 
technique. On uploading the round, the new meas-
uring point can be properly named and numbered.

Please note that the new measuring point will not 
remain in the measuring round to which is was added. 
To make it a permanent part of the measuring round, 
go to the measuring round register in Condmaster 
and add it.

Measuring rounds from Condmaster
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The function ’Download all round data’ under Data 
Transfer > Settings in Condmaster is activated by 
default and means that all measuring rounds and 
their measuring points for the current database is 
downloaded to the instrument, but without meas-
urement results. This function is the basis for the 
functions ’Add downloaded measuring point’ and 
’Add downloaded round’ in Leonova, see below.

When you are in the middle of a measuring round and 
remember that you need to measure something on 
a particular machine that belongs to another round, 
you can use the ’Add downloaded measuring point’ 
function. Go to MENU > Add measuring point, then 
choose ’Add downloaded measuring point’ (8), se-
lect a measuring point from a list of all downloaded 
measuring points and complete the measurements. 
The measuring point is added to the round, but when 
uploading the round to Condmaster, the results are 
transferred but the measuring point is not added to 
the measuring round.

Another option is to create a new round and add 
some of the downloaded measuring points. Go to 
MENU > Add round, select Create new round (9) and 
then choose measuring points from a list containing 
all downloaded measuring points from Condmaster.

If you have forgotten to load a certain measuring 
round in the instrument, it is possible to temporary 
add a downloaded round. Go to MENU > Add round, 
select Add downloaded round (10) and then choose 
a round.

Under MENU > Settings > General settings, the 
alternative ’Automaticaly set round as finished’ 
is available (default off). If it is ticked, a round 
will automatically be marked as finished when all 
its assignments have been measured. A finished 
round is shown by a folder symbol with a green 
checkmark (11). It is possible to mark a round as 
finished even though it is not (and vice versa). Use 
the alternatives ’Set round as finished’ and ’Set 
the round as unfinished’ as required found from 
the MENU. 

8
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9

11
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TIP: When standing in a measuring round, you can 
press SHIFT+F4 to jump to the default transducer 
setting (12) which can be useful if you need to 
change default transducer for a measuring point.

TIP: When standing on a measuring point, you 
can press MENU and select ’View details’ to view 
more of the information that was input in Cond-
master. This can be useful if you for example need 
to know the location of the measuring point which 
is shown under ’General’ (13).

At the bottom, Work description (14) is shown if 
the measuring point has a work description con-
nected to it in Condmaster, press F2 to access it. 
Lubrication data is shown if the measuring point 
has lubrication data set up in Condmaster, press 
F3 to access it.

TIP: It is possible to view a Work description for a 
measuring round from the file menu when stand-
ing on a round (if the round has a Work descrip-
tion connected to it). Press MENU and select 
’Show Work description’ (15).

12

15

13

14
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Measuring rounds for CondID

CondID is a contact free memory tag used for 
measuring point recognition. It is hung on the 
adapter cap or strapped in a suitable place on the 
machine. It should not be mounted flat against a 
metal surface. A distance of min. 3 mm between 
metal surfaces and CondID is recommended. The 
tag responds to a recognition signal when Leonova 
is held close to the tag.

To connect a CondID tag to measuring point, select 
the measuring point in the round, press MENU and 
select ’Connect CondID to measuring point’ (1).

In a downloaded measuring round, the measuring 
points linked to CondID tags will be marked with a 
memory tag symbol (2). 

After opening the round, hold Leonova close to the 
memory tag, press the MENU key and select ‘Read 
CondID’ (3).

The information on the tag will open the right 
measuring point in the round and Leonova is ready 
for measurement.

To break the link, press MENU and select ‘Dis-
connect CondID from measuring point’ (4). Press 
‘Yes’ to confirm.

When standing in a measuring round and reading 
a CondID that does not belong to the round but 
to the database, the instrument asks if the meas-
uring point should be added to the round so it 
can be measured (5). If ‘YES’, the measuring point 
will be temporary added to the round. When up-
loading the round to Condmaster, the results are 
transferred but the measuring point is not added 
to the measuring round. 
NOTE: This functionality requires that the ‘Down-
load all round data’ is enabled under Data trans-
fer > Settings in Condmaster.

3
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The measuring sequence

Default files
1 Select a file (technique menu).

2 Open the file.
 • Open ‘Measuring point data’.
 • Edit ‘Measuring point data’, all parameters.
 • Close ‘Measuring point data’.

3 Connect the transducer.

4 Press the MEASURE/SAVE (M/S) key to start 
the measurement. Press MEASURE/SAVE (M/S) 
again to save the measuring result.  To measure 
repeatedly without saving in between, press the 
M/S key down for 2 seconds. Set a comment if 
needed.

5. To remove unwanted results, go to MENU > 
‘Measuring results’ > Delete result (F3).

6 Close the file with MENU > ‘Close’ (which closes 
the default file without saving), or use ‘Save as’ 
to save it as a user/new default file.

Files configured in Condmaster
1 Select a file (FILE menu).

2 Open the file and select a measuring point.

3 Connect the transducer.

4 Press the MEASURE/SAVE (M/S) key to start 
the measurement. Press MEASURE/SAVE (M/S) 
again to save the measuring result.  To measure 
repeatedly without saving in between, press the 
M/S key down for 2 seconds. Set a comment if 
needed.

5. To remove unwanted results, go to MENU > 
‘Measuring results’ > Delete result (F3).

6 Close the file with MENU > ‘Close’ with or 
without saving.

Measuring with Leonova, especially data logging with downloaded, fully configured files, is very 
easy. 

RPM measurements in measuring rounds
In rounds containing several measuring points, the RPM value of the preceding measuring point is
automatically suggested for the next measuring point if the settings match each other (Min/ Max
RPM must match, or Min/Max Speed and Unit for speed must match).
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Measurement window before measuring

The measurement window has three parts, the result field (A), the measuring point field (B) and the 
function bar (C). Their contents differ, depending on the type of measurement file and measuring 
technique used. The figure below shows a downloaded round with the dBm/dBc technique active, 
before pushing the MEAS key.

B Measuring point field
10 Component
11 Measuring point open (measuring assignments 

are visible)
12 Measuring point number and name, (marked 

= active)
13 Measuring point name ‘on separate line’ (re-

move under ‘General settings’)
14 Measure all measuring assignments (measur-

ing techniques) with one command
15 Measuring assignments (techniques)
16 Measuring assignment; measured and uploaded 

at least once, present status in Condmaster
17 Measuring assignment, measured and up-

loaded at least once, no condition status or 
no alarm limit defined in Condmaster

Open/close measuring point folders with RIGHT/
LEFT arrow keys. 

C Function bar
The function bar shows actions controlled through the function keys F1 to F4. The functions available 
will vary with different modes. The SHIFT key is used to provide alternate functions in the function bar.

A Measuring result field
1 Measuring point icon
2 Measuring point number
3 Measuring point name
4 Active measuring technique
5 Measuring result saved for this technique; 

No = blue box,  yes = blue check mark    , 
not measured = white box, measurement 
aborted = grey check mark

6 Measuring point status when last measured
7 Alternatives for measuring point status 

after measurement
8 Unit of main measuring result
9 Additional measurements yes - no, e.g. 

transducer line quality, spectrum etc.

1

3

7

10

5

15

2

16

A

9

B

468

14

17

C

13

11

12



B:16   General measurement functions

B

Measurement window before saving

The measurement is started by connecting the transducer and pressing the MEASURE/SAVE (M/S) 
key, or selecting the ‘Measure all’ command (press function key F1). 

The measuring result (1) is displayed in the measurement field (A) and the status is shown by a larger 
status icon (2) on top of the alternatives. 

At this stage, the measuring result is not yet saved; a fact indicated by a small blue box. The alterna-
tives are to save it now or repeat the measurement.  To measure repeatedly without saving in between, 
press the M/S key down for 2 seconds.

C    Function keys and menu options
All options reached via the function keys (F1-F4) are linked to the measuring point and measuring as-
signment selected in the measurement window (B). 
3 F1: Opens the measuring results window. In this window, use the F1 and F2 function keys before 

saving to toggle between measuring results from the active measuring assignment, and F3 to delete 
any results you do not want to save.

4  F2: Opens the Graphics window to display trend graphs for the selected measuring assignment. This 
window shows a) the selected measurement taken before saving, or b) all downloaded and saved 
measurements after saving, for the selected measuring point and measuring assignment.

5 F3: Spectrum display (if any).

Pressing the MENU key on the instrument displays a menu of further options.

 El. motor DS

 El. motor DS
 El. motor DS
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The ‘Measure all’ function

Under all measuring points in Leonova, the ‘Measure 
all’ command appears above the list of measuring 
assignments (1). The purpose of this function is to 
speed up the execution of measuring rounds. 

All types of assignments under a measuring point 
are measured simultaneously with exception of 
RPM measurements, user defined measurements, 
assignments triggered by RPM and assignments 
with post triggers.

Settings for ‘Measure all’ are made in the instru-
ment only, but are uploaded to Condmaster along 
with the measuring round and saved for the next 
download to Leonova. 

The ‘Measure all’ function is disabled by default. It 
can be activated under MENU > ‘Settings’ > ‘General 
settings’ in the FILE window.

In the top section of the measurement window, a 
list of measuring techniques and the current channel 
configuration for the measuring point is shown (2).  
Measurement using remote transducers is always 
carried out separately, i.e. not concurrent  with any 
of the other measurements in the list. 

When using a Duotech accelerometer the shock 
pulse measurement occurs on channel VIB-1.

To change the channel configuration, mark the 
‘Measure all’ line (1) and press the ENTER key. The  
‘Channel settings’ window (3) is displayed, showing 
all measuring techniques on the measuring point; 
press F1 (‘Change channel) (4) to change channels. 

1

2
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Press F1 ’Measure all’ to start measuring. You will 
be prompted to connect transducers and/or input 
manual data. 

When a RPM result is saved the value will be 
transferred to the subsequent measurement 
points under the same component. If a measuring 
point under the component has a different ’Max 
RPM’ value this RPM value will be recalculated on 
the basis of the measured measurement point. 

Conditions to enable this feature:
- RPM is available as technique
-  There is a saved RPM value (may be a download-

ed preset value from Condmaster or a measured 
value)

-  None of the other measuring techniques have 
”Measure RPM simultaneously” enabled

- RPM can not be set as USER (user input) in the 
channel settings for ’Measure all’. 

To use the RPM from the previous measuring point, 
untick ‘Measure RPM’ (1) by pressing F3 in the first 
’Measure all’ dialog box.

Press ’Edit’ (F1) in the ‘Measuring point data’ 
window to change the RPM settings if values are 
outside the limits. New settings will be transferred 
to Condmaster when uploading the round. 

All measured assignments are displayed during meas-
urement (2). When a measurement is completed for 
a particular assignment its status bar is green for a 
few seconds before the assignment disappears from 
the list. If an error occurs during the measurement 
of an assignment its status bar becomes red (e.g. 
TLQ error).

When a measuring assignment is completed it disap-
pears from the list. When all assignments on the list are 
compleded the measuring window closes automatically 
and the display will show ’All techniques measured!’. 
Press ENTER to go to next measuring point.

Press F2 ‘View summary’ to see the results of all 
measurements just carried out (3).

To toggle between measurement results, use the UP/
DOWN arrow keys. From ‘View summary’, measure-
ment results can be erased and measured again. 

2

1
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Conditional measurements

In conjunction with SPM HD measurements, condi-
tions can be set up in Condmaster (see the Cond-
master User Guide). 

Conditions are used to ensure that measurement 
is completed only if the HDm reading was above a 
user defined limit. 

If an SPM HD measuring assignment has a condition 
associated with it, the hint ‘FFT on limit >=...’ (1) is 
displayed. This  condition means that a full SPM HD 
measurement including FFT will only be completed 
if the initial HDm reading equals or exceeds the 
limit value.

After measurement, a blue box (2) signifies a suc-
cessfully completed measurement (although not yet 
saved), whereas a grey check mark (3) indicates that 
the condition for this measuring assignment was 
not met and the measurement therefore aborted. 

To override conditions for an SPM HD measure-
ment, mark the measuring assignment and press 
ENTER. Under ‘FFT calculation’, press ENTER and 
select ‘OFF’ (4). 
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Comments

The MENU option ‘Set comment’ (1) is open for all types 
of measurements. 

Comments are made up of a ‘standard comment’ (2) and 
an optional free text (3) of up to four lines. The present 
date and time are set automatically in the field ‘From 
date/time’ (4). They can be edited. Leonova is also capa-
ble of recording and playing back audio files, so using a 
headset with microphone, you can add vocal comments 
as well. These are uploaded to Condmaster with the 
measuring round and can be played back from there.

As an option, a future date and time can be input in the 
field ‘To date and time’ (5). This turns the square on the 
time line of the graphics display into a bar that covers 
the time interval between the two dates and times.

To record a vocal comment, press the F3 function key 
(‘Voice recording’) (6), then press F1 (‘Start’) to begin 
recording. Maximum recording time is 30 seconds. 
Standard comments having a vocal recording attached 
to them are marked with a speaker symbol (7). Mark the 
comment and press F4 (‘Play’) to listen to a recording. 

The complete list of standard comments contained in 
Condmaster is downloaded with the measuring rounds 
and is available when data logging. Before download-
ing, the user can select what comments should be 
downloaded to the instrument and the order in which 
to show them.

When measuring with the Leonova default files, there 
are sixteen ‘Default comments’ (8) to which you can add 
free text. The text ‘Default comment’ can not be edited.

In the graphics display, comments appear as small 
squares (colour coded in Condmaster) on the time line.
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The graphics window shows measuring results as dots (1) against a neutral scale or, in case of evalu-
ated measuring results, a condition scale (2). Alarm limits defined in Condmaster are marked by thin 
horizontal lines (3). The type of measuring result (4) is selected in the measuring result window.

Up to 100 measuring results can be downloaded with a measuring round from Condmaster. The set-
ting is made under System > Measuring system when Leonova is activated as a measuring device. 
Downloading 5 to 10 measuring results is quite sufficient to see the trend when the new reading is 
taken. The new result is shown before it is saved.

Graphics window

To select a measuring result dot for further examination, use the F2 function key (‘Cross’) (5). This 
action displays a “crosshair” (6) which can be moved between individual measuring results using the 
instrument arrow keys. The measuring result and time of measurement is displayed in the upper right 
corner of the display (7).  

A white corner on a function (8) indicates that more options are available when pressing the correspond-
ing function key (F1 - F4). Pressing and holding the SHIFT instrument key offers further options still.

‘Zoom’ > ‘Zoom X’ zooms the display around the center of the current view, while ‘Zoom to cross’ 
zooms in on the crosshair. ‘Zoom back’ reverts the last zoom step, while ‘Zoom back all’ returns to 
the original time span.

The amplitude range can be changed by pressing SHIFT + F1. The ‘Rescale Y-axis’ function sets the 
scale to the min. - max. range of the measuring results.

Comments are placed along the time line and displayed in the upper right corner (9) (replacing the 
measuring result information) when put in focus by means of the crosshair. To add a new comment, 
press MENU > ‘Set comment’. 

Pressing MENU offers more functions, such as ‘Measuring protocol’ (10), which spaces the measuring 
result dots evenly, regardless of the time intervals between measurements.
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In the upper part of the measuring result window (1), the current measuring assignment data is dis-
played. Saved measuring results from that measurement are displayed in the lower part of the display 
(2). The scroll bar (3) indicates that there are more parameters than those visible on the screen.

The measuring results are shown in this window both before and after saving the current measurement. 
When several readings have been taken and saved, the F1 (‘Previous result’) and F2 (‘Next result’) 
keys can be used to toggle between them (4). Press the SHIFT key + F1 or F2 to skip to the first or 
last measuring result.

The measuring result window also shows the units of measurement (5), if any.

Measuring result window
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Using the Measuring Point Imag-
ing function in Condmaster, images 
or photographs can be connected 
to measuring points. If a measur-
ing point has an image associated 
with it, the image can be viewed in 
Leonova Emerald (1). 

Images are accessed from the 
measurement window. With  the 
measuring point name marked (2), 
press the F4 key (‘View image’) (3).

Measuring point images
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The live spectrum window (1) shows a continuously 
updated spectrum with 200 lines, irrespective of other 
settings. The window will come up before measuring with 
the vibration measuring techniques and rotor balancing.

This function is activated MENU > ‘Settings’ > ‘Gen-
eral settings’ (2). On the ‘File’ tab, mark ‘Preview live 
spectrum’ (3). 

‘Re-scale’ (4) will adjust the Y scale to fit the highest 
value and ‘Lock scale’ (5) will lock the Y scale.

Temporary settings can be made in the live spectrum 
window; use the instrument arrow keys to navigate to 
the arrows button (6), then press ENTER.

When pressing ‘Measure’ the pre-set assignment will 
be performed.

In the live spectrum window (7), you can temporarily 
change the upper frequency, spectrum unit and FFT type.

Select parameter with the UP/DOWN arrow keys and 
change value with LEFT/RIGHT. Pre-set values for the 
measuring point are shown in blue, changed values 
in black. Changes will not affect settings made under 
‘Measuring point data’.

It is possible to display time signal (8) in the live spectrum 
window. First start the measurement with ‘Preview live 
spectrum’ enabled under ‘Settings’, then press Shift+F1 
to switch to the display of time signal.

After changing the display setting to time signal, the time 
signal display is default for all new measurements until 
the user switches back to display spectrum with Shift+F1.

At a reset of the instrument it will return to show live 
spectrum.

Live spectrum window
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Spectrum window

Below the spectrum field (A) are functions (B) which are reached using the instrument function keys  
in combination with the SHIFT key.

The spectrum diagram is marked with the (displayed) range (1) in Hz, CPM or Orders, depending on 
the default setting made under ‘General settings’. The unit may be changed by pressing F4, ‘Hz/CPM/
Orders’ (2). All spectrum lines below the lower frequency will be shown in grey.

The Y axis (3) is marked with the measuring unit for spectrum line amplitude and with the range. For 
default measuring assignments (which are not part of a measuring round downloaded from Cond-
master), the spectrum type unit can be changed by pressing the MENU key while in the measurement 
window and  selecting ‘Measuring point data’.

If there are known disturbances, e.g. from surrounding equipment, the ‘Spectrum enhancement’ func-
tion can be activated in Condmaster in order to obtain a clearer view of the relevant signals in the spec-
trum. Using this function, spectrum lines related to a certain source of disturbance can be excluded, or 
interesting spectrum areas highlighted. When ‘Spectrum enhancement’ is activated in Condmaster, it 
can be turned on or off in the Leonova spectrum window under MENU > ‘Spectrum enhancement’ (4).

Zoom options become available by pressing F1, ‘Zoom’. While in zoom mode, use MENU or SHIFT to select 
a suitable zoom option. The spectrum can be zoomed along its X axis with the LEFT/RIGHT arrow keys.

Pressing F2 (‘Cursor’, (5)) displays options for cursors, harmonics and stroboscope. Holding down the 
SHIFT key while in the cursor menu displays sideband options. 

To display symptoms, press SHIFT + F4 in the spectrum window.
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Zoom
To zoom in on the X axis of the spectrum, press the F1 key (‘Zoom’)  (1) > F1 (‘Zoom X’) (2) . This zooms 
the display around the center of the current view. To zoom sideways, press SHIFT + F1 (left) or F2 (right).

The displayed frequency range is shown below the diagram (3). 

To zoom in on the Y axis, press the F1 key (‘Zoom’) (1) > F2 (‘Zoom Y’) (4). The amplitude scale changes. 

You can undo the last zoom step with ‘Zoom back’ or restore the original diagram with ‘Zoom back 
all’ (5). 

Cursors
By default, cursor A (6) is already in the spectrum when you open it. To display a second cursor, B, 
press F2 (‘Cursor’) (7) > F2 (‘Cursor B’). To remove it, press F2 again.

For fine work, move cursor A sideways with the LEFT/RIGHT arrow keys and cursor B with SHIFT + 
LEFT/RIGHT (8). One step corresponds to spectrum resolution (minimum distance between two spec-
trum lines).

For each step, the cursor skips to the top of the spectrum line or, if there is none, to the base line 
(amplitude = 0). Frequency and amplitude of the cursor position are briefly displayed in the upper 
right corner (9). 

When the arrow coincides with a position belonging to a symptom, the name of the symptom is dis-
played (9). In case several symptoms share the same position, all relevant symptom names are displayed.

Spectrum functions

Regarding display and available functions, there is no difference between a vibration spectrum and an 
SPM spectrum. The spectrum type is recognised from the measurement unit and the amplitude unit.
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The purpose of a spectrum is to reveal line patterns as-
sociated with machine or bearing faults. Characteristic 
for many fault patterns is the presence of ‘multiples’ 
or ‘harmonics’, which means that the line (or group of 
lines) is repeated two, three or more times further up 
in the spectrum. The spacing is 1Z, 2Z, 3Z, ... nZ, where 
1Z = the frequency of the first harmonic. 

With the cursor (1) positioned on a spectrum line that 
has a significant amplitude, press F2 (‘Cursor’) > F3
(‘Harmonics’) (2). 

A series of numbered, green arrows (3) now show up 
in the spectrum. Number 1 is in the cursor position. 
Numbers 2, 3, etc. are the harmonics. They are evenly 
spaced along the frequency axis at Z intervals. Mov-
ing the cursor one step and back will again display its 
position and thus Z.

To remove the arrows from the spectrum, press F3 
(‘Harmonics’) (2) again. 

In the second screen shot (right), the cursor is po-
sitioned on a different spectrum line in the pattern 
and the harmonics shown. This spectrum line has one 
harmonic within the displayed frequency range. Z in 
this case is doubled.

Please note that cursor number 1 in the lower figure 
also matches the symptom ‘Bearing, BPFI’. This shows 
that the symptom is configured to look for multiples 
of the basic pattern. More about symptoms overleaf.
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The F1 (‘Measuring result’) key opens a window with 
further options for the spectrum window; use the UP/
DOWN arrow keys to select a symptom (1) for display, 
and the  function keys F1 (‘Previous result’) and F2 
(‘Next result’) to toggle between measuring results.

‘Symptoms’ are instructions to search for and highlight 
spectrum lines or groups of spectrum lines that are 
typical for certain machine faults. Their purpose is to 
point out the significant data contained in the spectrum.

Symptoms are selected and configured when the 
measuring point is created in Condmaster. They are 
downloaded with the measuring round. The only fac-
tor added in Leonova is normally the machine speed 
(unless the measuring point is configured with a fixed 
rpm, which it should not be when spectra are measured).

For a spectrum, the list of symptoms shows the symptom 
value, i. e. the RMS value of the included symptom lines 
(1). When the spectrum is measured with an appropriate 
resolution and over a frequency range large enough to 
accommodate the pattern, the number of matches will 
normally equal the number of lines in the symptom. 

Pressing the MENU function key in the spectrum window 
opens further functions for the spectrum (2). 2

1
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The effect of a logarithmic Y-scale is illustrated to the 
right, using a downloaded vibration spectrum.

The amplitude scale of a spectrum is automatically 
scaled to accommodate the largest spectrum line (1). 
Thus, a dominant line will make most others invisible, 
which is desirable, because the lines containing very 
little energy are insignificant for the evaluation of ma-
chine condition. In this example, the amplitude scale 
is approx. 6 mm/s, so even the largest spectrum line 
is fairly small.

Switching to a logarithmic scale amplifies the low am-
plitude values (2). The amplitude unit gets the addition 
‘LOG’ (3). This display form clearly shows that the FFT 
calculation produces spectrum lines in almost every 
position, most with amplitudes well below 0.002 mm/s.

The two lower screen shots show the same spectrum 
with the Y scale in dB; (4) is scaled according to Euro-
pean standard and (5) according to US Navy standard.

4
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Highlighted symptoms in the spectrum
The following examples show different options on the ‘Settings’ menu and their effect on the spec-
trum display.

A. Symptoms are not marked in the 
spectrum.

B. The symptom name is shown (1). The symptom line is marked 
with a red dashed line (2) if a match is found in the spectrum. 
To find the match, Leonova searches for the closest peak 
line within the tolerances programmed in Condmaster.

C. The symptom name is shown, plus 
the text ‘Theoretical symptom’ (3). 
The line in the calculated symptom 
position is marked with a blue dashed 
line (4). Leonova does not search for 
the closest peak.

B

1

2

3

4

C
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The previous page illustrated the three basic alternatives on the ‘Settings’ menu with single line symp-
toms. Below are examples of multi-line symptoms.

D. Same as B, but containing the first harmonic at BPFI plus 
three harmonics, altogether four possible matches (5). In 
this example, the match found by Leonova agrees with the 
obvious peaks in the spectrum: all dashed lines are on top 
of the largest lines (5). 

E. Same as C, marking the positions where BPFI and its three 
harmonics should be according to the calculations. In case 
of the first line (6), reality as reproduced by the FFT agrees 
with the calculation. However, the next three lines in the 
pattern are not quite in their calculated positions: they are 
beside the dashed lines (7).

Please note that such near misses are normal, especially for 
the more rigid ‘Theoretical symptom’. Vibration itself is a con-
tinuous event, which is first digitalized during measurement 
and the subjected to mathematical manipulations to get the 
spectrum. At every step, there are tolerances, so an offset 
must be expected.

The resolution of this spectrum is ≈ 1 Hz, so the line is offset 
by a single digital step.

D

5

E

7

6
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Multi-line symptoms with harmonics

The symptom register in Condmaster contains a number of symptoms searching for groups of lines. 
These are of three kinds:

a harmonics of a single frequency line
b side bands to a single frequency line
c harmonics of a side band pattern.

Note that ‘harmonics’ are also called ‘multiples’ and ‘orders’. Alternative a) is illustrated on the pre-
vious page.

Damage on the rotating inner race of a bearing typi-
cally affects the line at the ball pass frequency over 
the inner race (BPFI). Quite often it also produces 
side bands to this frequency line. In Condmaster, 
the symptom BPFIM (M = modulation) is configured 
to show two sidebands on either side of the centre 
line BPFI, which is not highlighted (F).

Adding the marker to the centre line of the patters 
displays the position of BPFI and shows that it is 
covered by its own symptom (G).

F

G
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Harmonics of a side band pattern tend to put a lot of highlighters into the spectrum, which can be 
confusing. There is also a strong possibility that the multiples of the basic pattern overlap. 

In the symptom shown below (H, I), the number of side bands has therefore been reduced to two on 
either side of the center line. 

The pattern in (H) is made clearer by placing marker on top of the BPFI line and selecting ‘Show har-
monics’ (I).

Please note: While the presence of side bands and multiples in a spectrum is significant, the actual 
number of such elements is not important. The job of a symptom is to point out relevant data, not 
to find ‘everything’.

Zooming in on the spectrum and sweeping a cluster of lines reveals how close together significant 
lines can be. 

The BPFI factor of this bearing is 7.75, so the harmonics of BPFI are spaced 7.75 * RPM / 60 apart. The 
symptom  ‘Bearing, BPFIM’ looks for four harmonics but only two side bands. 

H I
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Waterfall diagram

The waterfall diagram is a three dimensional display 
of up to 99 vibration spectra. The different readings 
are displayed along the Z coordinate, with the latest 
reading in the front.

To display a waterfall diagram, press the F3 key (‘Spec-
trum’) in the measurement window. In the spectrum 
window, press MENU > ‘Waterfall diagram’ (1). 

You are prompted to select a number of diagrams to 
show (2). In this screen shot example, three diagrams 
are shown.

Cursors only apply to the spectrum in the front. For 
the cursor position in the spectrum, the frequency, 
amplitude and phase angle are shown (3). 

Settings and other graphical functions are the same as 
for spectrum, see ‘Spectrum functions’ earlier in this 
part of the manual. 

1

2
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Phase spectrum

If a time signal is measured together with a tachometer 
pulse, a phase spectrum can be displayed.  

To view a phase spectrum, go to the Spectrum window 
and press MENU > ‘Phase spectrum’ (1).

The blue cursor (3) is displayed by default. It can be 
removed with F2 (‘Cursor’) > F1 (‘Cursor A’). For the 
marker position in the spectra, frequency, amplitude 
and phase angle are shown (4). 

Move the blue marker with the LEFT/RIGHT arrow keys. 

In the Phase spectrum window, you can select MENU 
> ‘Show phase noice’ (2) to see the phase angle for 
each line included in the spectra.

All other settings and graphical functions are the same 
as for spectrum, see ‘Spectrum functions’ earlier in this 
part of the manual. 

2
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The time signal

The measuring unit (1) is always the signal unit. The diagram is scaled peak to peak (Y axis) and shows 
the total sample time (2) along the X axis.

In the time signal there is no default cursor; you can add them to the graph with F2 (‘Cursor’) (3) > F1 
and F2. See further information overleaf.

Using the F3 function key (‘Result’) (4), you can toggle between measurement results and lock the Y 
axis scale.

The MENU key option ‘Clear all’ removes markers and other indicators, and also removes a time signal 
that was selected from the list of saved time signals.

For vibration and SPM HD measurements, the time signal can be saved. It can be seen directly after 
measuring and before saving, or by calling up any stored measurement for the active measuring point.

1

2

3 4
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To zoom in on a time range, press the F1 key (‘Zoom’) 
(1) > F1 (‘Zoom X’). This zooms the display around the 
center of the current view. To zoom sideways while in 
zoom mode, press SHIFT + F1 (zoom left) or F2 (zoom 
right).

To zoom in on a part of the amplitude scale, press 
the F1 key (‘Zoom’) (1) > F2 (‘Zoom Y’). The amplitude 
scale changes. 

To put a cursor (2) into the spectrum, press F2 (‘Cur-
sor’) (3). With cursor A inserted, you can add a second 
cursor, B (4). 

The frequency for the period between the cursors (5) 
is shown in Hertz, together with delta values (6): 

• Delta time = time between the two cursors 

• Delta amplitude = difference in amplitude 
   between the two cursors.

• Delta phase = difference in phase angle 
   between the two cursors.

Note: Phase angle is shown only if rpm is measured.

When two cursors are in place, you can activate  periods 
by pressing F3 (‘Periods’) (7). This creates multiples 
with the same distance as that between cursors A and 
B (8). This feature is a useful aid for identifying fault 
symptoms.

While in cursor mode, the cursors can be moved side-
ways; move cursor A with the LEFT/RIGHT arrow keys 
and cursor B with SHIFT + LEFT/RIGHT. For each step, 
the time and amplitude of the spot beneath the marker 
are briefly displayed.

To mark a different period, use MENU > ‘Clear all’ and 
start again.

1 3
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Determine RPM from spectrum

It is possible to determine rpm from a vibration spec-
trum when the measurement is performed without 
specifying the rpm.

To activate this function, go to MENU > ‘Settings’ > 
‘General Settings’ > ‘File’ tab (1) and mark ‘Possible 
to determine rpm from spectrum’ (2).

Under ‘Measuring  point data’ for the measuring as-
signment, the following settings are required:

• ‘Variable speed’ enabled (3)
• ‘Measure RPM simultaneously’ set to ‘No’ (4)

When you press the MEASURE/SAVE (M/S) key, you 
are prompted to select how to determine rpm. Select 
‘Determine rpm from spectrum’ (5).

When the measurement is completed, press F3 (‘Spec-
trum’) to go to the Spectrum window. Use the LEFT/
RIGHT arrow keys to move Cursor A (6) to the assumed 
rpm (1X) in the spectrum.

In the spectrum window, press the MENU key and select 
‘Set RPM from cursor’ (7). A window (8) opens where 
you can verify the selected peak and the corresponding 
rpm value before saving with the ENTER key.

5

4
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HD Order tracking is an optional Leonova function 
primarily used for SPM HD and vibration analysis on 
variable speed machines. 

The method uses multiples of rotational speed (orders), 
rather than absolute frequency (Hz). The number of 
orders to be shown is input by the user. Leonova will 
then automatically set the sampling frequency to an 
exact multiple of the measured rpm. Order tracking 
will also minimise the risk of smearing when using 
FFT averaging.

The purpose of using orders is to lock the display to 
the rotational speed (1X) and its multiples, which means 
that the ordered components in the spectrum always 
remain in the same position in the display, even if the 
rotational speed varies between the measurements.

Two or several spectra from the same machine with 
variable speed can therefore more easily be compared 
if they are expressed in orders. Using order tracking, 
the frequency range will always cover the symptoms 
of interest, regardless of the rotational speed of the 
machine.

To activate Order Tracking, go to MENU in the 
measurement window > ‘Measuring point data’ (1) 
and select ‘Order tracking’ (2). Press ENTER to mark 
the ‘Order tracking’ checkbox (3). Enter the desired 
number of orders (4) and press F1 to save and BACK 
to return to the measurement window.

The lower frequency is input in Hz or CPM under 
‘Measuring point data’. The upper frequency is shown 
in orders. ‘Variable speed’ must be marked and rpm 
has to be measured.

Other graphical functions and settings are the same as 
for spectrum, see ‘Spectrum functions’ earlier in this 
chapter of the manual. 

Setup of order tracking assignments in Condmas-
ter requires one of the following optional software 
modules: 

• MOD134 (FFT with symptoms)

• MOD135 (EVAM)

• MOD193 (Vibration Expert) 

• MOD197 (Vibration Supreme)

• MOD195 (SPM HD Expert)

• MOD140 (HD Analysis)

HD Order Tracking
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Measurement techniques always included

Leonova is always programmed for an unlimited use of the measurement techniques listed below. 
Other diagnostic and analytic functions, for shock pulse measurement, vibration measurement, and 
rotor balancing, are user selected. 

Temperature,
User defined

RPM  Vibration

Measurement techniques always included are:

•	 RPM	measurement

•	 Shock	pulse	measurement	HDm/HDc	and/or	LR/HR

•	 RMS	vibration,	ISO	2372

•	 Temperature	measurement,	User	defined	(manual	input)

•	 Stethoscope	(available	function	under	Speed,	Shock	pulse,	Vibration,	Temperature)

These measurement techniques and the equipment needed to use them are described in this chap-
ter	with	the	exception	of	the	SPM	HDm/HDc	and	LR/HR	technique	described	in	Chapter	D.	

Measuring	points	containing	the	free	techniques	can	be	downloaded	from	Condmaster	Ruby,	fully	
configured and ready for measurement. 

When the default files under the technique windows are used, the analog measurements and the 
vibration measurement normally require a configuration under ‘Measuring point data’.

Shock 
pulse
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RPM measurement

RPM, optical:
Distance 30 to 2000 mm.
Measuring angle 5 to 75°

Reflecting
tape

RPM, contact centre
Hold	it	against	the	shaft	centre

TAD-11 Short, 30 mm
TAD-15 Long, 60 mm
TAD-19 Extra long, 170 mm

Peripheral, contact wheels
Multiply the reading by the wheel factor:

TAD-12	 0.1	m/min.	(factor	10)
TAD-13	 0.1	yd./min.	(factor	10)
TAD-17	 0.5	ft./min. (factor 2)

The	SPM	laser	tachometer/IR	temperature	probe	TTP10	is	used	for	both	optical	and	contact	RPM	
measurement. It is connected to the transducer input marked RPM on Leonova.

A blue LED indicator on the Tachometer and Temperature probe TTP10 lights when reflected ligth 
hits the sensor.

TTP10

CAB90  Stroboscope cable, 1.5 m spiral, 
3.5 mm phones connector

CAB92  Proximity switch cable, 1.5 m 
spiral, M12 connector

CAB95 Keyphasor cable, 1.5 m spiral, 
BNC	connector

5–75°

Input	for	tachometer/tem-
perature probe TTP10
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RPM measurement with default file

Optical speed measurement

Easiest is the optical speed measurement. The preparations are simple: paste a bit of adhesive 
reflecting tape on the rotating part. It has to be reasonably clean.

Direct the laser beam at the reflecting tape and press the M/S key. When measuring on short 
distance the reflections from the shaft can register false readings. Then try to angle the laser beam 
towards the reflection tape to achieve a stable result. A blue LED on the Tachometer and Tempera-
ture probe shows that the light beam is reflected back to its sensor. A green dot (4) on the display 
indicates signal from the probe sensor. Red measuring values indicates values out of range. When 
the count stabilizes, press F1 to continue or save the measurement with the M/S key.

To see or delete measurement(s) before saving, press F1 to see the result window. Press SHIFT+F2 
to set a default comment or link a voice recording to the result. See Chapter B, Comments.

To save the result, press MENU and select ‘Save as’. Select ‘Save a file’ and input a name via the 
keyboard window. Press ENTER to save.

4

1

2

3

Please note: to evaluate bearing condition and to make 
sense of a vibration spectrum, one has to know the rpm 
of the shaft. This type of RPM measurement is made 
as part of the shock pulse or vibration measurement, 
where the RPM technique is automatically included 
when the point is configured for ‘variable speed’.

The RPM measure with the default file (1) is not avail-
able for other measurements. Press ENTER to open 
RPM measurement.

Settings (2) are made under ‘Measuring point data’ 
(SHIFT+F3). It is possible to change RPM and speed 
range via the keyboard window. Values outside the 
range will not be registered. To edit, mark a line in 
the list with the UP/DOWN arrow keys and open with 
ENTER.

‘Number of pulses’ are set to correspond to the 
number of reflecting tape bits. Leonova will always 
count the number of pulses (1 rpm for each received 
light reflex/pulse). The maximum is 150 000 pulses per 
minute. On slowly rotating parts you can use several 
reflexes at even intervals.

It is possible to convert RPM to other unit. Specify 
‘Unit of speed’ to desired unit and activate ‘Use factor’. 
Input the conversion factor via the keyboard. 

When using a factor or gear ratios, the measured RPM 
from the tachometer is shown in the lower right corner 
and the converted RPM value in the middle of the 
display

‘Factor’ is also used with contact measurement to 
convert RPM to peripheral speed.

‘Max. fluctuation’ is used only for variable speed.

When measuring with the Tachometer and Temperature 
probe TTP10, select ‘Portable’ (3) as transducer.  



C:6   Measurement techniques always included

BC
Remote transducer

Other types of transducers can be used by switching 
the setting of ‘Transducer’ to ‘Remote’ (2).

When using a proximity switch the setting of ‘Trans-
ducer type’ is ‘PNP’ or ‘NPN’ (3). The setting of ‘12V 
Supply’ should be ‘ON’ (4).

When Leonova is connected to a stroboscope, the 
setting of ‘Transducer type’ (3) is normally set to 
‘NPN’. Some types of stroboscopes require the 
setting ‘PNP’. The setting of ‘12V Supply’ should be 
‘OFF’	(4).

When Leonova is connected to a Key Phasor for rpm 
measurements, the setting of ‘Transducer type’ is 
‘Key	Phasor’.	‘12V	Supply’	(4)	should	be	‘OFF’	(4).

Manual input

For	manual	input	of	speed,	press	ENTER	and	input	
the speed via the keyboard window.

Contact measurement

For	contact	measurement,	you	place	the	contact	
adapter over the lens and fix a contact centre or 
a wheel. The shaft in the adapter has a reflecting 
surface, and each revolution sends one light reflex to 
the counter. The contact centre is pressed firmly into 
the cavity at the centre of the shaft, and the probe is 
aligned with the shaft’s centre line. 

The wheels are used to measure peripheral speed. 
One turn corresponds to 0.1 m, 0.1 yards, or 0.5 feet, 
depending on the wheel type.

Settings (1) are made under ‘Measuring point data’ 
(SHIFT+F3).	Mark	‘Use	Factor’	and	select	‘Yes’.	Then	
mark	‘Factor’	on	the	list	and	press	F1	to	edit.	For	
meters	or	yards	per	minute,	set	‘Factor’	(1)	=	10.	For	
feet	per	minute	the	factor	=	2.	Number	of	pulses	=	1.

1
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3

4
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Temperature measurement 

The	SPM	laser	tachometer/IR	temperature	probe	
TTP10 is used for temperature measurements in 
the	range	of	–20	to	+300	°C	(–4	to	+572	°F).	Meas-
uring	accuracy	is	±	2.5°C.	

The probe has an infrared sensor that allows you 
to accurately measure the temperature of a surface 
without having to come in contact with it.

The probe is connected via the spiral cable to the 
RPM input on Leonova. It is power supplied by the 
instrument.

Keep the protective adapter on the probe when 
the probe is not used.

To measure, move the laser point so that it is on 
the	area	to	be	measured	and	press	the	M/S	key.	
Make sure that the target is larger than the unit’s 
spot size. The smaller the target, the closer you 
should be to it.

Caution: Never point the sighting laser in some-
body’s eye.

The	laser	tachometer/ IR	temperature	probe	has	
distance	to	spot	size	(D/S)	8:1,	meaning	that	if	the	
probe is 800 mm from the target, the diameter of 
the object must be at least 100 mm (see the dia-
gram beside). When accuracy is critical, make sure 
the target is at least twice as large as the spot size.

TTP10
SPM	laser	tachometer/
IR temperature probe

Laser 
beam

IR sensor

Distance	(D)	to	Spot	size	(S)	=	8:1

200           400           800

ø
2

5

ø
5

0

ø
10

0

Input	for	tachometer/tem-
perature probe TTP10
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Temperature measurement with default file

The default file for temperature measure-
ments is located in the ‘User defined’ window 
(1). There are no settings under ‘Measuring 
point data’.

The result is displayed with a decimal, but 
please note that the accuracy of the SPM 
laser	tachometer/IR	temperature	probe	is	
±2.5°C.

The	change	from	°C	to	°F	is	made	under	
‘General settings’ (2) in the SETTINGS win-
dow. Switching from one unit to the other 
will re-calculate all saved results and display 
them in the active unit.

After	pressing	the	measure	key	(M/S)	you	
can select type of material (3) to obtain as 
accurate readings as possible. 

Select material to be measured (emissivity) 
with	RIGHT/LEFT	arrow	keys:

- Paint
- Black body
- Iron rusted
- Iron oxidized
- Aluminium unoxidized
- Aluminium oxidized
- Lead oxidized
- Brass polished
- Brass oxidized
-	Copper	rough	polished
-	Copper	black	oxidized

Press	F1	‘Continue’	or	ENTER	to	stop	read-
ing.	Save	the	result	with	the	M/S	key.	

To see or delete measurement(s) before sav-
ing,	press	F1	‘Measuring	result’	(4)	to	see	the	
result window. Press	SHIFT+F2	to	set	a	de-
fault comment or link a voice recording to the 
result.	See	Chapter	B,	Comments.	Press	F2	to	
go	to	graphics	(see	Chapter	B,	Graphics)

To save the result, press MENU and select 
‘Save as’. Select ‘Save a file’ and input a 
name via the keyboard window. Press ENTER 
to save.

For	manual	input	of	temperature,	press	
ENTER and input the temperature via the 
keyboard window.

4
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User defined (manual input)

During a measuring round, a reference value 
of preferred quantity can be saved in rela-
tion to the other measuring values. Leonova 
Emerald is missing the option for analog 
signals, but there is a possibility to manually 
input a user defined measuring value such as 
current, flow, pressure, etc. 

While in a measuring round with ‘User de-
fined’ values (1), press ENTER and input the 
value manually via the keyboard window.

Usually, user defined units for manual input 
is	set	up	within	a	round	in	Condmaster.	If	
you want to manually input values outside 
a measuring round, an icon for user input is 
located in the ‘User defined’ window (2). (See 
below for more information.)

User defined (manual input) 
with default file

For	manual	input	of	values	outside	a	measur-
ing round, an icon for user input is located in 
the ‘User defined’ window (2). Press ENTER 
to open the measuring window (bottom 
picture).	Configure	files	for	manual	input	
measurements	by	pressing	SHIFT+F3	to	open	
‘Measuring point data’. 

‘Type’ is always set to User input and can not 
be changed. ‘Type’ is shown as the measuring 
point name in the measurement window (3). 
‘Quantity’ is what the manual input rep-
resents, e. g. power, flow, pressure. Mark 
this	line	and	press	‘Edit’	(F1).	Write	the	new	
name in the keyboard window and save with 
ENTER. It will be displayed above the result 
in the measurement window (4). 

‘Unit’ is the measurement unit for the new 
quantity, here ‘bar’ for oil pressure. It is 
displayed in brackets above the result field (5). 
‘Format’	defines	the	number	of	digits	and	the	
position of the decimal point in the result (6). 
Write a ‘#’ for each digit.

To save the result, press MENU and select 
‘Save as’. Select ‘Save a file’ and input a 
name via the keyboard window. Press ENTER 
to save.

1
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Vibration severity measurement

Vibration severity measurement according to ISO 2372 is a broad band measurement over the 
frequency	range	10	to	1000	Hz.	It	returns	the	RMS	value	of	vibration	velocity	in	mm/s	(or	inch/s).	
This value is representative of the energy contents of machine vibration, and thus of the destructive 
forces acting on the machine. It is still widely regarded as a good and easy to obtain indicator of 
general machine condition.

Evaluation of machine condition

The evaluation consists of a comparison 
of the measured value with the ISO limit 
values recommended for 6 different 
classes (see definition on the next page).

The majority of industrial machinery 
belongs to the vibration classes 2, 3, 
and 4:

Class	2:	 Medium	size	machines	without	
special foundations

Class	3:	 Large	machines	on	rigid	foun-
dations

Class	4:	 Large	machines	on	soft	foun-
dations.

For	example,	most	smaller	process	pumps	in	a	chemical	plant	would	be	Class	2.	A	100	kW	fan	on	a	
concrete	foundation	would	be	Class	3.	However,	the	same	fan	fastened	to	the	less	rigid	metal	deck	
of	a	ship	could	be	considered	as	Class	4.

Class	1	refers	to	independent	parts	of	machines,	for	example	electric	motors	up	to	15	kW.	Classes	
5 and 6 are used for heavy reciprocating prime movers and machines which are intended to vibrate, 
such as vibrating screens.

Leonova is programmed with the ISO limit values and will evaluate the measuring result, provided 
the ISO machine class number is input under ‘Measuring point data’. On the instrument, the ISO 
values for good and acceptable are shown as green. Just tolerable is yellow, unacceptable is red.
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Definition of machine classes according to ISO 2372

The following text is a quotation from ISO 2372 (1974, E, page 6, Annex A). This ISO Recommenda-
tion has also been published as British Standard (BS 4675, part I). A similar vibration classification of 
industrial machinery can be found in VDI 2056.

In order to show how the recommended method of classification may be applied, examples of 
specific classes of machines are given below. It should be emphasized, however, that they are 
simply examples and it is recognized that other classifications are possible and may be substituted 
in accordance with the circumstances concerned. As and when circumstances permit, recommenda-
tions for acceptable levels of vibration severity for particular types of machines will be prepared. At 
present, experience suggests that the following classes are appropriate for most applications.

Class I
Individual parts of engines and machines, integrally connected with the complete machine in its 
normal operating condition. (Production electrical motors of up to 15 kW are typical examples of 
machines in this category.)

Class II
Medium-sized machines, (typically electrical motors with 15 to 75 kW output) without special foun-
dations, rigidly mounted engines or machines (up to 300 kW) on special foundations.

Class III
Large prime movers and other large machines with rotating masses on rigid and heavy foundations 
which are relatively stiff in the direction of vibration measurement.

Class IV
Large prime movers and other large machines with rotating masses on foundations which are rela-
tively soft in the direction of vibration measurement (for example turbogenerator sets, especially 
those with lightweight substructures).

Class V
Machines and mechanical drive systems with unbalanceable inertia effects (due to reciprocating 
parts), mounted on foundations which are relatively stiff in the direction of vibration measurement.

Class VI
Machines and mechanical drive systems with unbalanceable inertia effects (due to reciprocating 
parts), mounted on foundations which are relatively soft in the direction of vibration measurements; 
machines with rotating slackcoupled masses such as beater shafts in grinding mills; machines, like 
centrifugal machines, with varying unbalances capable of operating as self-contained units without 
connecting components; vibrating screens, dynamic fatigue-testing machines and vibration exciters 
used in processing plants.
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Measuring points for vibration

Vibration severity is primarily a measure for general machine condi-
tion. Vibration at the measuring point should be representative for 
the overall vibration of the machine. Typical measuring points are 
the bearing housings. By measuring in three directions, one can get 
an indication of the causes for increased vibration.

•	 Horizontal	vibration	(H)	in	the	plane	of	rotation	is	most	representa-
tive of balance condition.

•	 Vertical	vibration	(V)	in	the	plane	of	rotation	is	most	representative	
of structural weakness.

•	 Axial	vibration	(A)	along	the	line	of	the	shaft	is	most	representative	
of faulty alignment and bent shafts.

To get comparable results, the measuring points should be clearly 
marked, so that the measurements can always be taken in the same 
spots and important, at the same speed. SPM vibration transducers 
can be used
•	 as	a	hand-held	probe,	with	or	without	 the	probe	 tip	attached.	

Not	recommended	above	1000	Hz.

•	 with	a	magnet	for	attachment	to	ferrous	metal	parts. Not recom-
mended	above	2000	Hz.

•	 with	the	M8	(UNC	1/4”-28)	mounting	screw.

The firmer the contact with the machine, the better the measuring 
result. Plain, clean metal makes the best contact surface for the 
vibration transducer. 

The vibration transducer is connected via a twisted pair cable to the 
VIB input on Leonova. Transducers of type	IEPE*	(ICP)	with	voltage	
output (<24 Vpp) can be used. 

Only one vibration transducer can be connected to Leonova when 
measuring according to ISO2372. Move the transducer between the 
three	directions	(H,	V,	A)	and	perform	three	measurements.

DuoTech® accelerometers (Dual Technology)

The DuoTech® accelerometer is a single transducer solution used 
for vibration or shock pulse measurements or both in combination. 

•	 DuoTech	with	quick	connector,	TRC100,	for	use	with	permanently	
installed	measuring	adapters.	Connect	the	DuoTech	via	the	mea-
suring	cable	CAB82.

•	 DuoTech	for	permanent	installation,	SLC144.

Permanently installed DuoTech accelerometers are mounted in a 
countersunk mounting holes identical to holes normally used by 
shock pulse transducers. The accelerometer has 2-pin connector 
and is connected to Leonova or a measuring terminal via twisted 
pair cable. DuoTech is connected to the VIB input on Leonova.

Input for
vibration transducer

Hand-held	probe

Transducer with magnet

DuoTech with quick connector

Transducer line quality, TLQ

Leonova is automatically testing the quality of signal transmission between transducers of type 
IEPE and instrument before measurement. The unit of measure is voltage (Bias). Accepted values 
depends on transducer settings. Not acceptable values generates an error message.
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Measuring point data for ISO 2372

The only measuring point data that should 
be	edited	are	‘Direction’	and	‘Class’	(1).	Press	
SHIFT+F3	to	open	‘Measuring	point	data’.	For	
both, the alternatives are selected from lists 
after	marking	the	line	and	pressing	F1	‘Edit’.

The selected measuring direction appears as 
measuring point name in the measurement 
window (2). The selected machine class 
effects the evaluation of the measuring result 
(3). Readings in the yellow and red zone are 
indicated with an alarm flag and a flashing red 
dot (4) before the value.

‘Portable’ on the transducer line (5) means that 
the default transducer for vibration measure-
ments is active. Set up of default transducers 
is	described	in	Chapter	A	page	13.

To temporarily use another transducer, press 
SHIFT+F3	to	open	‘Measuring	point	data’	and	
mark	‘Transducer’	on	the	list.	Press	F1	‘Edit’	
and select ‘Remote’. 

The transducer data become editable after 
you switch ‘Transducer’ from ‘Portable’ to 
‘Remote’. Provided you know the transducer’s 
frequency range, sensitivity and its upper and 
lower bias range, you can input the data here.

This temporarily transducer data will be lost 
when closing the measuring technique but will 
be saved in the measuring result file.

To measure, connect the transducer and press 
the	M/S	key.	Save	the	measurement	with	
M/S.	If	you	do	not	accept	the	reading,	press	
SHIFT+M/S	to	collect	a	new	reading	without	
saving the previous. 

To see or delete measurement(s) before sav-
ing,	press	F1	to	go	to	the	result	window.	

Press	SHIFT+F1	to	see	the	alarm	list.	Press	
SHIFT+F2	to	set	a	default	comment	or	voice	
recording	to	the	result	(see	Chapter	B,	Com-
ments).	Press	F2	to	go	to	graphics	(see	Chap-
ter B, Graphics). 

To save the result as a file, press MENU and 
select ‘Save as’. Select ‘Save a file’ and input a 
name via the keyboard window. Press ENTER 
to save.

1

5

2

3

2

4
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Using the stethoscope function

The stethoscope function is useful for detect-
ing machine sound irregularities, such as load 
shocks and scraping. It is recommended to use 
a shock pulse transducer with probe or a vibra-
tion transducer with probe tip or magnetic 
foot. Installed transducers can also be used.

Connect	your	headphones	to	the	output	
connector (1). Open one of the measuring 
techniques under Speed, Shock Pulse, Vibra-
tion or Temperature. Press MENU, select 
‘Stethoscope’ (2) and press ENTER.

Source is the transducer input you intend to 
use.	Select	with	the	UP/DOWN	arrow	keys	and	
press	F1	(or	ENTER)	to	confirm.	

Hold	the	transducer	against	the	object.	Use	
LEFT/RIGHT	arrow	keys	to	adjust	the	volume	
(4). 

NOTE! Setting the volume to the maximum 
level may harm your hearing.

1

You can filter out high or low frequencies with the high 
pass/low	pass	filter	(5)	at	500,	1000	or	2000	Hz.	Press	the	
DOWN	arrow	key	and	select	filter	with	the	LEFT/RIGHT	
arrow keys.

When a shock pulse transducer of type 40000 is used, 
you	can	select	‘High	frequency	mode’	(6).	‘High	frequency	
mode’ moves frequencies above the audible down to 
the	audible	frequency	range.	Activate/deactivate	‘High	
frequency mode’ with the ENTER key. Adjust the amplifica-
tion	(7)	with	the	LEFT/RIGHT	arrow	keys.

The	‘High	frequency	mode’	is	always	activated	when	using	
transducers of type 42000 and 44000. Vibration transduc-
ers	are	working	in	the	audiable	frequency	range	and	‘High	
frequency mode’ (6) can not be used.

To	select	source	(3),	press	F1.	To	return	to	the	measuring	
technique	window,	press	the	BACK	key.	

Vibration and SPM 44000 
transducers

4

5

6

7

SPM 40000 and 42000 
transducers

3

2
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Shock pulse measurement
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Shock pulse techniques

SPM HD

Shock pulse magnitude is quantified on a decibel scale by two 
values, the maximum value HDm and the carpet value HDc. 
The input data are very simple: the rpm and the bearing’s shaft 
diameter. The maximum value HDm is evaluated on a green - 
yellow - red condition scale. It indicates the bearing’s operating 
conditions in terms of good - caution - bad. Operating condition 
includes factors like installation quality, load, lubrication and the 
mechanical state of the bearing surfaces. 

In Time signal HD, repetitive shocks are enhanced and random 
signals supressed using advanced digital algorithms. The Time 
Signal HD is extremely useful to determine the location of a 
possible bearing damage. The SPM Spectrum HD, obtained by 
applying FFT algorithms on the Time Signal HD, is useful for 
trending purposes (applying symptom and band values).

SPM dBm/dBc

With the dBm/dBc technique, the shock pulse magnitude is 
quantified on a decibel scale by the maximum value dBm and 
the carpet value dBc. 

SPM LR/HR and LR/HR HD

Shock pulse magnitude is quantified on a decibel scale by the 
values LR (low rate of occurrence, corresponding to the HDm) and 
HR (high rate of occurrence, similar to the HDc). In addition to 
these ‘raw values’, the bearing’s operating condition is indicated 
by the evaluation results CODE (overall condition), LUB (oil film 
thickness) and COND (mechanical state of the surfaces). Thus, 
condition information is more detailed, with emphasis on bearing 
lubrication. The basic principles for LR/HR and LR/HR HD are the 
same; however LR/HR HD utilizes the SPM HD algorithms for time 
signals and spectrums. Both methods are most advantageous 
for RPMs above 500.

The required input data are also more detailed: the rpm, the 
bearing’s mean diameter and its type number. The type number 
defines the bearing geometry and thus the evaluation box with 
its green - yellow - red condition zones.

For all three techniques, measuring results indicating bad bearing 
condition should be verified. By comparing shock values on and 
around the bearing housing and through lubrication tests, the 
operator can make sure that the measured shock pulses originate 
from the bearing before taking corrective action. This verification 
process is greatly simplified with the SPM Spectrum technique.

SPM Spectrum

A time record of the shock signal is subjected to an FFT. Prominent 
bearing patterns in the resulting spectrum are conclusive evidence 
that the measured shocks are generated by the bearing. Thus, 
the bearing condition data obtained with either the dBm/dBc or 
the LR/HR method are valid.

TYPE 3

HDm

 

HDc
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Rules for SPM measuring points

The rules for the selection of SPM measuring points have a 
very practical purpose.

We are trying to catch low energy signals which are getting 
weaker the farther they travel and the more they are bounced 
about inside a piece of metal.

We know that they lose strength when they cross over from 
one piece of metal to another (oil between the pieces reduces 
signal losses). 

We cannot know, for all bearing applications, how much of the 
strength of the bearing signal will reach the measuring point. 

However, by necessity we try to apply general evaluation rules, i. 
e. treat all measured signals as if they were of the same quality.

The rules for SPM measuring points try to assure that most 
signals are comparable, with sufficient accuracy, and that the 
green-yellow-red condition zones are valid.

1 The signal path between bearing and measuring point 
shall be as short and straight as possible.

2 The signal path must contain only one mechanical interface, 
that between bearing and bearing housing.

3  The measuring point shall be located in the load zone of 
the bearing.

3 – In the load zone of the bearing

Measuring

point

Load

1 – Straight and short path

2 – No interface!
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Measuring points should be located directly on the 
bearing housing, i. e. the metal that is touching the 
outer race.

SPM supplies long adapters and transducers that allow 
you to reach measuring points beneath covers, shields 
and brackets.

The signal losses in the two unavoidable interfaces 
(bearing – bearing housing and housing – adapter) 
have been taken into account in SPM’s evaluation of 
bearing condition.

The load zone is defined as the load carrying part of 
the bearing housing. It is normally determined by the 
weight of the supported machine part, i.e. the load 
is mostly on the lower half of the bearing housing. 

Consider also the direction of the force acting on the 
shaft when the machine is running. Thus, belt tension 
can determine the load on the bearings. The fan shaft 
in point 3 is pulled down towards the motor. The drive 
end of the motor shaft is pulled up towards the fan (2), 
the non-drive end (1) is pressed down and away from 
the fan. In point 4 the weight of the rotor normally 
determines the measuring direction. The arrows show 
the measuring points, numbered in the direction of 
power transmission.

Finding the strongest signal

Use the shock pulse transducer with probe to find the spot on the bearing housing where the signal 
is strongest. If there are several points yielding the same signal, select the point where it is easiest 
to take readings. 

When a measuring point cannot conform to the rules (because an ideal spot cannot be reached), make 
allowance for a weaker signal. If you use SPM LR/HR, you have a COMP no. to compensate for weak 
signals, but must still try to find a good point.
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The following pages show measuring points and 
possible adapter or transducer installations. How to 
install measuring equipment is described in the SPM 
installation manual.

Through hole for long adapter

A measuring point beneath a fan cover (1) can be reached 
with a long adapter, through a hole in the cover.

Adapter with lock nut

The fan cover is fastened directly to the motor shield, 
which is also the bearing housing (2). One of the cover’s 
holding screws can be replaced by an adapter with lock 
nut.

Bearing housings beneath brackets

Consult machine drawings and identify the bearing 
housing before selecting a measuring point.

In a pump, the bearings can be placed in two separate 
housings inside the bearing bracket (3). 

Measuring point B, placed below and opposite to the 
pump outlet (because of the load direction) can be 
reached with a long adapter through an opening in the 
pump shield.

The bearing pair at measuring point A can be reached 
with a long adapter through a clearance hole in the 
bracket. The hole must be large enough to allow bearing 
adjustment and still prevent metallic contact between 
bracket and adapter.

Examples of SPM measuring points

2

B

1

3

A
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Multiple bearings in one housing

If there are several bearings in the same housing, 
they are normally treated as a single bearing. In the 
bearing arrangement for a vertical pump (4), it is not 
possible to distinguish between the shock pulses from 
the paired bearings in point 1. 

There is also a risk for cross talk between point 1 and 
point 2, which means that the shock pulses from the 
bearing in worst condition are picked up in both points.

Check signal strength with the probe. Use one 
measuring point only if readings are identical in both 
points. This point (x) can be placed halfway between 
points 1 and 2.

Installed transducer

On large electric motors (5), the bearings are often 
mounted in bushings which are welded or bolted to 
the motor shields. Because of the damping in the 
interface between the bushing and the shield, the 
measuring point should be on the bushing.

The bearing bushing at the drive end (A) is usually 
within reach. A long adapter is installed at an angle to 
the shield, so that there is enough space for connecting 
the transducer. 

The bearing at the fan end (B) requires a permanent 
transducer installation. The transducer is installed in 
the bushing. The coaxial cable is run through a slit in 
the fan cover to a measuring terminal on the stator 
frame.

1

X

2

4

A B

5

A. Drive end

B. Fan end
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Equipment for shock pulse measurement

Handheld transducers
Two types of handheld transducers are available for 
shock pulse measurement with Leonova:

•	 Shock	pulse	transducer	with	quick	connector,	
TRA79, for use with permanently installed 
measuring adapters.

•	 Shock	pulse	transducer	with	probe,	TRA78.

Permanently installed transducers

Permanently installed transducers can be used in narrow 
spaces or when the bearing cannot be reached directly. 
The transducer is connected to a measuring terminal 
via a coaxial cable. Connect Leonova to the measuring 
terminal with a slip-on measuring cable.

•	 Standard	transducer	series	44000,	used	with	
Leonova Diamond and online system Intellinova 
Compact. Max. cable length is 100 metres and 
max. temperature 150° C.

•	 Standard	transducer,	type	40000,	for	cable	length	
up to 4 metres. Max. temperature 150° C.

•	 Transducer	with	TMU,	type	42000,	for	cable	length	
up to 100 metres. Max. temperature 100° C.

•	 Measuring	cable,	CAB80,	BNC/TNC	slip-on,	1.5	meter.

Standard transducers and measuring cables are 
connected to Leonova’s rightmost input connector in 
the front of the instrument. 

DuoTech® accelerometers (Dual Technology)

The DuoTech® accelerometer is a single transducer 
solution used for vibration or shock pulse measure-
ments or both in combination. 

•	 DuoTech	with	quick	connector,	TRC100,	for	use	with	
permanently installed measuring adapters. Connect 
the DuoTech via the measuring cable CAB82.

•	 DuoTech	for	permanent	installation,	SLC144.

Permanently installed DuoTech accelerometers are 
mounted in a countersunk mounting holes identical 
to holes normally used by shock pulse transducers. 
The accelerometer has 2-pin connector and is 
connected to Leonova or a measuring terminal via 
twisted pair cable. DuoTech is connected to the VIB 
input on Leonova.

Note: For measurements with low dBi /HDi (low rpm 
or small bearings) the quick connector or permanently 
installed transducer is recommended. 

TRA78 

Shock pulse transducer with probe

TRA79

Shock pulse transducer with quick 
connector

CAB80

Measuring cable, BNC/TNC slip-on, 1.5 m

44000  Shock pulse transducer

SLC144 

DuoTech accelerometer for permanent 
installation

TRC100

DuoTech accelerometer with quick 
connector
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EAR16

Headset 
with fixed 
cable

Headphones

The headphones allow you to listen to the shock pulse 
pattern and is helpful for verifying and tracing the shock 
pulse sources. Three types of earphones are available:

•	 Headphone	in	ear	defenders,	EAR12,	headset,	with	
cable.

•	 Headphone	in	ear	defenders	for	helmet,	EAR13,	with	
cable.

•	 Headphone in ear defenders with neck band, EAR15 
with cable.

Headphones are connected to Leonova’s input/output 
connector on the right hand side of the instrument.

Headset 

Headset with microphone for recording of vocal 
comments, EAR16, are connected to Leonova’s input/
output connector on the right hand side of the instru-
ment.

•	 Headset	in	ear	defenders	with	microphone,	EAR16,		
with cable.

•	 Headset	in	ear	defenders	with microphone for helmet, 
EAR17, with cable.

•	 Headset in ear defenders with microphone and neck 
band, EAR18 with cable.

Equipment for shock pulse measurement

EAR12

Headphones 
with fixed 
cable

EAR17

Headset 
with fixed 
cable

EAR18

Headset 
with fixed 
cable
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Transducer with quick connector

The choice of transducer type depends on how the measuring 
point is prepared. For systematic shock pulse monitoring, 
SPM recommends the use of installed adapters and the quick 
connect transducer wherever possible.

All three types of shock pulse transducers are connected to 
Leonova’s ‘SPM’ connector (1). 

DuoTech® accelerometer with quick connector

The DuoTech® accelerometer with quick connector TRC10 is 
connected to Leonova’s ‘VIB’ connector (B) via measuring cable 
CAB82. The accelerometer fits all standard SPM measuring 
adapters and measures shock pulse and vibration in combination.

Adapters are solid metal bolts of different lengths and thread 
sizes, tuned for correct signal transmission. They are installed in 
threaded, countersunk mounting holes on the bearing housings. 
Glue-on adapters are available.

To attach a transducer with quick connector, press it against 
the adapter and twist clockwise. Twist counter-clockwise to 
remove it.

Check that installed transducers and adapters are properly 
mounted according to the SPM installation instructions and in 
good condition. You cannot expect a useful signal by attaching 
the quick connect transducer to a rusty lump of metal, or from 
a transducer that is rolling on the floor on the other side of a 
partition.

Adapter surfaces must be clean and plane. Use an adapter 
cap to protect them.

A CondID® tag (an RFID identification tag) can be hung on the 
adapter cap. CondID® is a contact free memory tag used for 
measuring point recognition. It should not be mounted flat 
against a metal surface. A distance of min. 3 mm between 
metal surfaces and CondID® is recommended. 

CondID® responds to a recognition signal when Leonova is held 
close to the tag. It contains all basic data for its measuring 
point. If the measuring point is already loaded in Leonova, it 
will be displayed, else it will be added to those in the data 
logger memory.

Push and twist

Signal transmission

Adapter cap

Identification 
tag, CondID

1
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Permanently installed transducers/terminal 

Installed transducer, cable to terminal

A permanently installed transducer and a measuring 
terminal (BNC or TNC connector) are used when 
the bearing cannot be reached directly. Use 
a measuring cable to connect Leonova to the 
terminal.

The terminal cabinet, SPM 14318, can receive up 
to 16 coaxial cables from shock pulse and vibration 
transducers. The cabinet is made of stainless steel 
and has protection class IP66.

Transducers for permanent installation are available 
with different thread sizes and in three types:

•	Series	44000 for cable length max. 100 m and 
temperature max. 150° C

•	Series	40000 for cable length max. 4 m and 
temperature max. 150° C

•	Series	42000 for cable length max. 100 m and 
temperature max. 100° C

DuoTech® for permanent installation

DuoTech® accelerometers series SLC for permanent 
installation are available with different thread 
sizes. They are used for shock pulse and vibration 
measurements in combination and when the 
measuring point cannot be reached directly. 
Connect the accelerometer via twisted pair cable 
to the VIB input on Leonova.

The permanently installed transducers are installed 
in threaded, countersunk mounting holes on the 
bearing housings. The cable between transducer 
and terminal should be firmly attached to the 
machine with cable clamps and, where necessary, 
be protected against damage.

SPM supplies high temperature cables and moisture 
proof connectors. 

Measuring
terminal

Input for
shock pulse 
transducer
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The handheld probe is mainly used to locate the 
strongest shock signal on and around the bearing 
housing, in order to find the best measuring point or to 
verify the shock pulse source after getting a measuring 
result which indicates bad bearing condition.

If it is used for regular condition monitoring, the 
measuring points for the handheld probe should be 
clearly marked. Always measure in the same spot.

The probe tip is spring loaded and moves within a sleeve 
of hard rubber. To maintain a steady pressure on the 
tip, press the probe tip against the measuring point 
until the rubber sleeve is in contact with the surface. 

Hold the probe steady to avoid rubbing between probe 
tip and surface.

The probe is directionally sensitive. It must be pointed 
straight at the bearing. 

The centre of the probe tip should touch the surface. 
Avoid pressing the probe tip against cavities and fillets 
which are smaller than the probe tip.

The only part likely to wear out is the rubber sleeve 
for the probe tip. It is made of chloroprene rubber 
(neoprene) and tolerates 110° C (230° F). Spare sleeves 
have part number 13108.

Shock pulse transducer with probe

Avoid small
cavities and
fillets

SPM 13108

Neoprene, 110° C (230° F)

Rubber sleeve
in contact with
the surface

Point at the
bearing

Hold steady
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RPMd

The SPM HD measuring technique

The SPM HD measuring technique is a refinement of the original dBm/dBc measuring technique (see 
page D:18), which has been successfully applied for more than 40 years. It is well suited for industrial 
condition monitoring, because it works with few, easy to understand in- and output data and with 
‘reasonable accuracy’.

Even on a logarithmic scale, there is normally a large, distinct difference between the maximum values 
from good and bad bearings. Thus, minor inaccuracies in the input data (rpm and shaft diameter) have 
little effect on the evaluated measuring result.

Lubrication condition is indicated by the delta value, i.e. the difference between HDm and HDc. 
High readings and a small delta value indicate poor lubrication or dry running. This is sufficient for 
maintenance purposes.

HDm and HDc are measured during a predefined number of revolutions and automatically displayed. 

Life time

HDm

HDcHDm 
HDc

HDm

 

HDc
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The absolute shock pulse level of a bearing, measured in dBsv (decibel shock value), is both a function 
of rolling velocity and of bearing condition. To neutralize the effect of rolling velocity on the measured 
value, Leonova must be programmed with shaft diameter (in millimetre or inch) and rotational speed 
(in rpm).

The instrument will then calculate the initial value HDi, the starting point of the condition scale for 
a particular bearing. The HDi can also be input directly or via the ISO bearing number. The condition 
scale is graded in normalized shock values, HDn. 

Leonova samples the shock pulse amplitude over a period of time and displays:

• the maximum value HDm for the small number of strong shock pulses.
• the carpet value HDc for the large number of weaker shock pulses.
• the status dot which is green for HDm up to 20 HDn = good condition, yellow for 21-34 HDn = 

caution, red for 35 HDn and more = bad operating condition. 

The maximum value HDm defines the bearing’s position on the condition scale. The difference between 
HDm and HDc is used for a finer analysis of the causes for reduced or bad condition.

When you set the HDi to ‘0’, Leonova will take an unnormalized reading in dBsv (absolute shock values). 
The condition zones do not apply. This method is used for comparative reading on different bearings 
and/or other shock pulse sources. 

Normalized condition readings 
Absolute scale
(shock value)

Normalized scale
(condition)

HDi = Initial value of a bearing

HDc = Carpet value (weak pulses)

HDm = Maximum value (strong pulses)

HDn = Unit for normalized shock level

dBsv = Unit for absolute shock level
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Measuring points for the SPM techniques are normally 
set up in Condmaster and then downloaded to 
Leonova. However, it is possible to open the Leonova 
default file in the SPM window (1) and configurate all 
measuring parameters. Select ‘SPM HD’ and open 
with ENTER.

Transducer
Before starting measurements, make sure that the 
shock pulse transducer you are using with your 
Leonova is properly selected. 

Default transducers for the shock pulse techniques are 
set up via the transducer register. Default transducer 
is the active transducer when ‘Portable’ transducer 
is selected under ‘Measuring point data’. To select a 
default transducer, see Chapter A page 15.

You can select other shock pulse transducers from the 
transducer register (2) if you switch ‘Transducer’ from 
‘Portable’ to ‘Remote’. 

When using a DuoTech sensor all fields displays (3)
that normally apply to a vibration transducer. The 
actual data for the individual transducer is written on 
its calibration card. This data should always be input 
in the transducer register. When several transducers 
are in use, they should be marked to assurethat the 
readings are calibrated. Note that measurements with 
DuoTech will be performed at channel VIB-1.

HDi
For a normalized reading of bearing condition with the 
Leonova default file, go to MENU > ‘Measuring point 
data’ and set the initial value HDi. The default setting 
is HDi = ‘Calculated’, which produces the normalized 
shock values with condition status display.

If known, the HDi can be input directly via the 
keyboard. Mark the ‘HDi’ row, then press the F1 key 
(‘Edit’). 

If the HDi is not known, input the rotational speed 
(rpm) and the shaft diameter, and Leonova will calcu-
late and display the HDi for you.

There are two alternatives for entering the shaft 
diameter. ‘Input ISO bearing number’ (4) opens a 
window (5) where you set the last two digits of the 
ISO number using the UP/DOWN arrow keys on the 
Leonova keypad.

‘Input diameter’ (6) opens the Leonova keyboard. 
Write the shaft diameter, then edit RPM and input the 
rpm on the keyboard.

Input data for SPM HD

4
6

5

1

2

3
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Variable speed

The alternative ‘Variable speed’ (1) implies that the shock 
pulse measurement is preceded by a measurement of the 
rpm. 

Measure RPM simultaneously 

‘Measure RPM simultaneously’ (2) is normally not used. With 
this setting on, you are forced to measure the rpm simulta-
neously with the shock pulse measurement 

Measuring time
Depending on the rpm of your application, the Measuring 
time (3) setting has a significant impact on the length of a 
measuring cycle. Empirical studies have shown that in order 
to achieve reliable measurements of bearing condition, 
measurement should cover at least 10 shaft revolutions 
and preferably 50 revolutions, which is the default setting. 
The time required to complete a measuring cycle can be 
calculated as 50 X (60/RPM).

FFT calculation
This setting means that a full SPM HD measurement including FFT will be saved. Input upper frequency 
in orders and number of spectrum lines. Under ‘Save’, select ‘Time signal and FFT’, ‘Full spectrum’ or 
‘Condition parameters’ to be saved with the measurement.

Symptom enhancement factor
The ‘Symptom enhancement factor’ (4) is used to improve the signal-to-noise ratio. For applications 
with little electronic noise and few mechanical shock phenomena, this factor can be kept low (0 - 5). 
Where noise and random shocks are frequently occurring, it is recommended that the ‘Symptom 
enhancement factor’ be set to 5 -10. However, you should be aware that the higher this factor, the 
longer the measurement cycle. The Y axis unit in spectrum and time signal is HDesv when symptom 
enhancement is used.

Time synchronous averaging
To achieve greater accuracy when measuring gear damages, one can order the average result from a 
stated number measurements. To get a time synchronous average, a tachometer must be connected 
which supplies a trigger pulse. This starts each measurement with the shaft in the same position.

Trigger selection
When measuring on variable speed machines, an ‘RPM trigger’ can be used to determine when to start 
a measurement, ensuring that it is carried out at an appropriate speed. The RPM trigger can be used on 
applications where useful readings can be obtained only within a limited RPM range, such as in cranes.

The purpose of the ‘Post trigger’ is to avoid the recording of irrelevant signals that may ultimately 
cause false alarms. It can be used where strong signals can be expected which are process related 
and not attributed to machine damage.

‘RPM trigger’ can be set to ‘RPM run up’ or ‘RPM run down’. ‘RPM run up’ means Leonova will initiate 
the measurement, then wait for the machine to speed up to the level input under ‘Trigger level’ 
before it starts recording the signals. With ‘RPM run down’, Leonova waits for RPM to slow down to 
the ‘Trigger level’ setting.

When using ‘Post trigger’, input a value (HDsv) under ‘Trigger level’. In the above example (5), Leonova 
will initiate an SPM HD measurement and wait for the signal’s HDsv level to reach 25 before it starts 
a complete measurement including time signal and FFT. Make sure you input a viable trigger level; if 
the level is never reached, the measurement must be aborted manually.

4

5

3
2

1
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Transducer line quality

Transducer line quality test, TLQ

From the measurement window, the instrument can 
be set up to perform a transducer line quality test 
(TLQ) before measurement. Press the ENTER key to 
enable or disable the TLQ test (1). 

When TLQ is enabled, the instrument will display 
the result of the transducer line quality test in the 
result window, so you can check the quality of signal 
transmission between transducer and instrument. 
Part of your signal will be lost in a poor transducer 
line, so your measuring results will be lower than 
they should be.

For shock pulse transducers, the following applies:

•	 40000, 42000 type transducers: the result of 
the TLQ test is a ‘TLT’ (Transducer Line Test) 
value. TLT is dimensionless, with accepted 
values between 15 and 25.

•	 44000 type transducers: the result of the TLQ 
test is a ‘TLR’ (Transducer Line Resistance) 
value in kohm (resistance). Accepted values 
are  between 26 and 40 kΩ.

1

Under ‘Delay time’, you can specify a number of seconds during which Leonova will delay the start 
of measurement. This setting is optional.

Acquisition time
The ‘Acquisition time’ is automatically updated when parameters are changed that affect the time.

The TLQ test should always be made when you measure with permanently installed transducers. Normal 
TLT/TLR values for transducer types 40000 and 42000 are around 20 and for 44000 approx. 32 kOhm. 

For 40000 and 42000 type transducers, TLT values below 15 are not acceptable, so you have to check 
cables and connectors for bad connections and moisture.  

If  the TLQ value is below the accepted level, the measuring result cannot be saved.
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Measuring SPM HD

When the MEASURE/SAVE (M/S) key is pressed, 
Leonova samples the transducer signal for two 
seconds. A preliminary result is displayed in the 
measurement window. The HDm shown is the 
amplitude value of the strongest shock pulse 
registered during the measuring time.

To accept the displayed result, press the ENTER 
key. The measurement window shows the two shock 
values (1), the status dot (2) and, if transducer line 
quality test is enabled, the TLQ  value (3). 

Save the result by pressing the MEASURE/SAVE 
(M/S) key, or measure again with SHIFT + M/S.

When ‘Variable speed’ is active, the rpm must be 
measured before measuring the shock values.

3

2

1
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The original SPM dBm/dBc measuring technique has been successfully applied for over 40 years and 
continues to be widely used. Like its successor the SPM HD measuring technique, dBm/dBc is well 
suited for industrial condition monitoring and requires only few, easy to understand in- and output data.

With the dBm/dBc technique, lubrication condition is indicated by the delta value, i.e. the difference 
between dBm and dBc. High readings and a small delta value indicate poor lubrication or dry running. 
This is sufficient for maintenance purposes.

dBm and dBc are measured in a fixed time window and automatically displayed. After that, the instru-
ment continues to measure while the transducer is connected. The peak indicator blinks when pulses 
stronger than the displayed dBm value are detected. If earphones are connected, a “pinging” sound 
can be heard with each blink from the peak indicator. For more information, see ‘Using the earphones’.

The stethoscope function (see ‘Using the stethoscope function” in section C of this manual) can be 
used to listen to machine sounds. With the stethoscope, machine sound irregularities from various 
rotating parts can be detected.

The dBm/dBc measuring technique

dBi = Initial value of a bearing

dBc = Carpet value (weak pulses)

dBm = Maximum value (strong pulses)

dBn = Unit for normalized shock level

dBsv = Unit for absolute shock level

rpmd

The initial value dBi
depends on rpm and
shaft diameter d.
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Input data for SPM dBm/dBc

Measuring points for the SPM techniques are normally set up 
in Condmaster and then downloaded to Leonova. However, 
it is possible to open the Leonova default file in the SPM 
window and configurate all measuring parameters. Select 
‘dBm/dBc’ and open with ENTER. 

Transducer
Before starting measurements, make sure that the shock 
pulse transducer you are using with your Leonova is properly 
selected. 

Default transducers for the shock pulse techniques are set up 
via the transducer register. Default transducer is the active 
transducer when ‘Portable’ transducer is selected under 
‘Measuring point data’. To select a default transducer, see 
Chapter A page 15.

You can select other shock pulse transducers from the 
transducer register (1) if you switch ‘Transducer’ from 
‘Portable’ to ‘Remote’. 

When using a DuoTech sensor all fields displays (2) that 
normally apply to a vibration transducer. The actual data 
for the individual transducer is written on its calibration 
card. This data should always be input in the transducer 
register. When several transducers are in use, they should 
be marked to assurethat the readings are calibrated. Note 
that measurements with DuoTech will be performed at 
channel VIB-1.

dBi
For a normalized reading of bearing condition with the 
Leonova default file, go to MENU > ‘Measuring point data’ 
and set the initial value dBi. The default setting is dBi = 0, 
which produces the normalized shock values with condition 
status display.

If known, the dBi can be input directly via the keyboard. 
Mark the ‘dBi’ row (3), then press the F1 key (‘Edit’).

If dBi is not known, input the rotational speed (rpm) and 
the shaft diameter, and Leonova will calculate and display 
the dBi for you.

There are two alternatives for shaft diameter. ‘Input ISO 
bearing number’ (4) opens a window (5) where you set the 
last two digits of the ISO number using the UP/DOWN 
arrow keys on the Leonova keypad.

‘Input diameter’ (6) opens the keyboard. Write the shaft 
diameter, then edit RPM and write the rpm on the keyboard.

The dBi will be displayed when the data input is complete (3).

4

2

2

3

1

5

6
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Variable speed

The alternative ‘Variable speed’ (1) implies that the 
shock pulse measurement is preceded by a measure-
ment of the rpm. 

Measure RPM simultaneously 

‘Measure RPM simultaneously’ (2) is normally not used. 
With this setting on, you are forced to measure the 
rpm simultaneously with the shock pulse measurement.

RPM Trigger
When measuring on variable speed machines, an 
‘RPM trigger’ can be used to determine when to start 
a measurement, ensuring that it is carried out at an 
appropriate speed. The RPM trigger can be used on 
applications where useful readings can be obtained 
only within a limited RPM range, such as in cranes.

‘RPM trigger’ (3) can be set to ‘RPM run up’ or ‘RPM 
run down’. ‘RPM run up’ means Leonova will initiate 
the measurement, then wait for the machine to speed 
up to the level input under ‘Trigger level’ before it 
starts recording the signals. With ‘RPM run down’, 
Leonova waits for RPM to slow down to the ‘Trigger 
level’ setting.

Under ‘Delay time’, you can specify a number of 
seconds during which Leonova will delay the start of 
measurement. This setting is optional.

SPM Spectrum
An SPM spectrum measurement can be carried out 
along with the dBm/dBc measurement. It is measured 
in addition to the ordinary shock values. 

Mark the ‘SPM Spectrum’ row (4). Press ENTER and 
set ‘SPM Spectrum’ to ‘Yes’. 

Settings for SPM Spectrum are described on page D:33.

3

4

2

1
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Measuring SPM dBm/dBc

From the measurement window, the instrument can 
be set up to perform a transducer quality line test 
(TLQ) before measurement. Press the ENTER key to 
enable or disable the TLQ test (1). TLQ (Transducer 
Line Quality) is described on page D:17.

When the MEASURE/SAVE (M/S) key is pressed, 
Leonova samples the transducer signal for two 
seconds. A preliminary result is displayed in the 
measurement window. The dBm shown is the ampli-
tude value of the strongest shock pulse registered 
during the measuring time.

Meanwhile, Leonova keeps measuring. If it registers 
stronger pulses, the peak indicator (1) will blink. 

Watching the peak indicator is very important, 
especially when the preliminary result indicates poor 
or bad bearing condition. The lower the rpm, the 
longer it can take for damaged parts to move into 
the load zone and reveal their presence by strong 
shock pulses.

When the peak indicator blinks, press the UP key 
on the Leonova keypad. This increases the dBm in 
steps of one dB. The original value is displayed in 
brackets (2). Stop adjusting the dBm value when 
the peak indicator stops blinking. The DOWN key 
decreases the value.

When earphones are connected in order to listen to 
machine sounds, use the LEFT/RIGHT keys to adjust 
earphone volume (3).

To accept the displayed result, press the ENTER or 
the MEASURE/SAVE (M/S) key. The measurement 
window shows the two shock values (4), the status 
dot (5) and, if transducer line quality test is enabled, 
the TLQ value (6). If a default measurement file was 
used, the dBi value is also shown. For measuring 
assignments downloaded from Condmaster in a 
measuring round, the dBi is not displayed.

Save the result by pressing the M/S key, or measure 
again with SHIFT + M/S.

When ‘Variable speed’ is active, the rpm must be 
measured before measuring the shock values.

7
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Using the earphones

For dBm/dBc, earphones can be used to listen to the shock pulse 
pattern in case of suspect or high readings. Listening to the shock 
pulse signal can help to pinpoint the cause for high values. This, 
and the possibility to search for shock pulse sources with the probe 
transducer, is a means to verify the measuring result and its cause. 

Earphone listening does not work with the LR/HR and SPM HD technique.

The measuring threshold is changed with the UP/DOWN arrow keys 
on the Leonova keypad. At a low level, Leonova will emit a continuous 
tone. As the threshold is raised, this changes to very rapid pulses at 
the dBc level. At the dBm level, only a few pulses should occur at 
irregular intervals.

Significant are

•	 the	dBm	level
•	 the	rhythm	of	the	pulses	immediately	below	the dBm level
•	 the	delta	value,	which	is	the	difference	between	the	dBm	and	the	dBc.

Shock pulses from a bearing normally occur at irregular interval, while strong, rhythmic shocks are a 
sign of disturbance. The diagrams below show typical patterns.

B

A.  Good bearing
Shock values are low.

C

E F

D

B.  Bad bearing
High values, large delta,
irregular pattern.

C.  Pump cavitation
Very small delta, fairly high 
shock level.

F.  Measured value drops sharply
A danger signal, the bearing is sliding.

E.  Regular showers
Scraping machine parts.

D.  Load shocks, valves, etc.
Regular patterns mean often 
disturbance

A
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The LR/HR technique was originally developed for a continuous, automatic monitoring system (CMS). 
An automatic system cannot, like a human operator, vary measuring time, use earphones or make 
”further tests” to verify suspect readings. It works with fixed settings and is dependent on accurate 
input data. This, together with new research results, programmable chips, and the desire to get more 
detailed information from the shock pulse signal, lead to a change in the threshold values, plus a more 
diverse and detailed output. 

The value for the noise carpet (HR) is read at an occurrence rate of approx. 1000 pulses/second and the 
value for the strong shock pulses (LR) at approx. 40 pulses/second. This makes LR an average value of 
the strong pulses, lower than the maximum, and thus reduces the dynamic range. To increase accuracy, 
the mean diameter of the bearing is used, the SPM TYPE no. is input to define bearing geometry, and 
the COMP no. to calibrate the individual measuring points.

The extra output information concerns mainly lubrication condition, allowing the user to attack a 
mayor maintenance problem (most bearings fail too soon because of inadequate lubrication) at the 
root. With SPM’s LUBMASTER® (part of Condmaster® versions for this technique) and LR/HR readings, 
it is possible to accurately measure lubrication condition, calculate the resulting L10a life, and work out 
feasible improvements by simulating changes in the lubricant parameters. 

The basic principles for LR/HR and LR/HR HD are the same; however LR/HR HD utilizes the SPM HD 
algorithms for time signals and spectrums. Both methods are most advantageous for RPMs above 500.

The LR/HR and SPM LR/HR HD techniques

Mean diameter Dm

TYPE

RPM

COMP

TYPE 3 TYPE 1

LR 
HR
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bearing speed on the shock level when evaluating bearing condition. The mean diameter Dm is more 
exact than the shaft diameter, because the height of bearings with the same shaft diameter can vary 
considerably. Together, rpm and Dm are used to calculate the NORM no. of the bearing (range 10 to 58).

The HR level shock pulses vary with the shape and number of the rolling elements in the bearing. This 
becomes important when estimating the oil film thickness in the rolling interface. The largest influencing 
factor is the shape of the contact area. In ball bearings, the rolling element has point contact with the 
raceways. In roller bearings, there is line contact, which means that the area under pressure, where 
the shock pulses occur, is much larger.

For SPM purposes, bearings are grouped into 8 different types, each with a TYPE number 1 through 
8. The types are described in the table above.

Bearing manufacturers, though not all, follow ISO standards when numbering their bearings. The 
number code contains the information on mean diameter and bearing type. Thus, when you use an 
ISO bearing number as input in Condmaster®, the program will give you Dm and TYPE no. As manual 
input for Leonova, you can use the last three digits of the ISO number, which will produce Dm but not 
the TYPE no.

Input data for LR/HR and LR/HR HD

1 Deep groove ball bearings,
 series 62, 63, 64

 
2 Angular contact bearings,
 all series

 
3 Deep groove ball series 60, 160, 618, 
 double row and self-aligning ball bearings

 
4 Thrust ball bearings, all types

5 Cylindrical roller bearings, single row
 

6 Taper roller bearings, all radial types

7 Spherical roller bearings
 Double row cylindrical roller bearings

 
8 Thrust roller bearings
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In addition to the basic input data, one can set values for 
COMP and ACCUM.

ACCUM (accumulation) determines the number of measuring 
cycles before the Leonova displays the average value as 
result. ACCUM can be set from 1 to 9. Especially on bearings 
with a low rpm, set ACCUM to at least 3.

COMP (compensation number) is used to calibrate the 
measuring point, normally to compensate for a somewhat 
weaker signal from a measuring point that does not quite 
comply with the SPM rules. To find the correct COMP no., 
use the LUBMASTER function in Condmaster®.

A normal signal from a good bearing should be near the 
centre of the green part of the evaluation frame. If it is far 
to the left, you can ”push it forward” by setting a COMP no. 
If the signal is outside of the left side of evaluation frame, 
Leonova will display the error code E3 = signal too low. 
The COMP no. is added to the measuring result before it 
is evaluated. Thus, it will influence the evaluation results 
CODE, LUB, and COND, but not the displayed values for 
HR and LR.

It is possible to set negative COMP nos., but you should 
avoid that. With a positive COMP no., you make the evalua-
tion results worse than apparent from the measured LR/HR 
values. With a negative COND. no., you ‘improve’ bearing 
condition, which can have unpleasant consequences if you 
are wrong in assuming that the signal from this bearing is 
stronger than normal. To avoid alarm from a stable bearing 
with high readings, it is better to change the alarm levels.

Positive
COMP

Accumulation and compensation

Negative
COMP
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For LR/HR values, the measuring unit is dBsv, i.e. 
these values are measured on the absolute shock 
pulse scale and do not, by themselves, express 
operating condition. 

The term delta value simply means the difference 
between LR and HR.

The operating condition of the bearing is expressed 
by the CODE letter, the LUB no., and the COND. 
no., all of them not measuring but evaluation 
results.

CODE A means that the bearing is in good condi-
tion. There is no detectable damage to the surfaces 
of the load carrying parts, and no extreme lack of 
lubricant in the rolling interface. 

CODE B indicates dry running. The lubricant is not 
reaching the rolling interface. This can have several 
causes, e.g. lack of lubricant supply to the bearing, 
low temperature in a grease lubricated bearing, 
or a heavy overload due to misalignment, tight fit, 
deformed housing, etc.

CODE C is displayed when the instrument detects 
an increased shock pulse level with a large delta 
value. This points to beginning surface damage.

CODE D is displayed when the signal is typical for 
bearing damage: a high shock level with a large 
delta value. Contamination of the lubricant by hard 
particles causes a similar signal.

The message of the codes is supported by the 
status dot: green for CODE A, yellow for B and C, 
red for D. 

LR Measured value for strong 
shock pulses.

HR Measured value for weak 
shock pulses.

LR-HR Delta value.
dBsv Unit for absolute shock pulse 

value.

CODE A Good condition 
CODE B Caution, dry running
CODE C Caution, damage developing
CODE D Bad condition

LR/HR values and CODE

B

C
C

A

D

D
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The most important influence on the 
service life of a bearing is the lubricant film 
between the load carrying rolling elements 
and the raceway. 

By preventing or inhibiting metallic contact 
between the loaded bearing parts, the 
lubricant film reduces the local peak stress 
in the rolling interface. The greater the 
lubricant film thickness, the more even the 
load distribution in the contact area, and the 
better the fatigue life of the bearing.

Full
lubrication

Boundary
lubrication

 LUB Ball bearing

 0 Dry running 

 1 to 2 Boundary

  lubrication

 3 to 4 Full lubrication

 LUB Roller bearing

 0 Dry running 

 1 to 4 Boundary

  lubrication

 > 4 Full lubrication

The LUB number

Irregularities in the bearing surfaces will always cause pressure 
variations in the contact area, and thus shock pulses, even when 
metallic contact is prevented by a separating lubricant film. A 
thinner film will result in an increase of the bearing’s HR value. 

The LUB No., displayed with CODE A and B, is directly proportional 
to oil film thickness. LUB No. 0 means dry running condition. 
The interpretation of LUB Nos. between 1 and 4 depends on the 
bearing type. For ball bearings, LUB Nos. greater than 2 mean 
full lubrication (a load carrying oil film). For roller bearings, a 
LUB No. greater than 4 indicates full lubrication.

The term boundary lubrication implies that part of the load 
is carried by metal to metal contact. The amount of lubricant 
in or supplied to the bearing is only one of the many factors 
that determine lubricant film thickness. Lubricant type and the 
bearing’s rpm are of great importance, but also the geometry 
of bearing parts and housing, as well as the load put on the 
bearing by alignment and fitting. 



Shock pulse measurement   D:29

D

The COND number and error codes

CODE C
COND 28 to 32
Beginning bearing damage

HR

LR

CODE C
COND >32
Minor to severe bearing damage

HR

LR

The COND No. (condition number) is displayed with CODE B, 
C, and D, i.e. for all bearings with reduced or bad condition. 
It indicates the degree of surface deterioration or damage 
in the rolling interface.

Large (visible) surface damage typically leads to a very 
marked increase in the bearing’s LR readings and a high 
delta value. Thus, it is easily detected and will give Code D 
and high COND numbers.

When a COND number is displayed, the bearing should be 
watched very carefully. Once damage has started, it cannot 
be reversed. Temporary improvements of the COND No. 
only mean that the edges of fresh spallings or imprints have 
been rounded off. Soon, there will be new spallings. The time 
left to plan a bearing replacement depends on the trend of 
the COND No. As a rule, COND Nos. should be interpreted 
as follows:

COND No. < 30 Minor damage

COND No. 30 to 40 Increasing damage

COND No. > 40 Severe damage

ERROR CODES

E2  Disturbance

E3  Signal too low

When the measured signal is not within the evaluation frame, 
the Leonova will display error codes. E2 is displayed when HR 
> LR, which normally means a high, even disturbance signal 
such as pump cavitation or a screaming steam box. E3 = 
signal too low can often be remedied by setting a COMP no.
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Input data for LR/HR and LR/HR HD

Measuring points for the SPM techniques are normally 
set up in Condmaster and then downloaded to Leonova. 
However, it is possible to open the Leonova default file in 
the SPM window and configurate all measuring parameters. 
Select ‘LR/HR’ or ‘LR/HR HD’ and open with ENTER. 

Transducer
Before starting measurements, make sure that the shock 
pulse transducer you are using with your Leonova is 
properly selected. 

Default transducers for the shock pulse techniques are 
set up via the transducer register. Default transducer 
is the active transducer when ‘Portable’ transducer is 
selected under ‘Measuring point data’. To select a default 
transducer, see Chapter A page 15.

You can select other shock pulse transducers from the 
transducer register (1) if you switch ‘Transducer’ from 
‘Portable’ to ‘Remote’. 

When using a DuoTech sensor all fields displays (2) that 
normally apply to a vibration transducer. The actual data 
for the individual transducer is written on its calibration 
card. This data should always be input in the transducer 
register. When several transducers are in use, they should 
be marked to assurethat the readings are calibrated. Note 
that measurements with DuoTech will be performed at 
channel VIB-1.

For a normalized reading of bearing condition with the 
Leonova default file, go to MENU > ‘Measuring point 
data’ and set the ‘TYPE’ and the ‘NORM’ number.

TYPE number 
For ‘TYPE’ no. definition, see the table on page D:25. 
Mark the line ‘TYPE’ (3), open it with the ENTER key, set 
the number on the keyboard.

4

5
7

6

3

1

NORM number

The default setting for NORM is UN NORMALIZED, which produces the shock values LR and HR only.

If known, the NORM number can be input directly. Mark the line and open it with the ENTER key, 
then select the number from the displayed list (4). The first choice on the list (---) also produces an 
unnormalized measurement.

Given the rotational speed (rpm) and the mean bearing diameter, Leonova will calculate and display 
the NORM number.

There are two alternatives for mean diameter. ‘Input ISO bearing number’ (5) opens a window (6) where 
you set the last three digits of the ISO number using the UP/DOWN arrow keys on the Leonova keypad.

‘Input diameter’ (7) opens the keyboard. Write the mean diameter, then edit RPM and write the rpm 
on the keyboard.

The NORM no. will be displayed when the data input is complete.

1

2
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Variable speed 
The alternative ‘Variable speed’ implies that the shock pulse 
measurement is preceded by a measurement of the rpm. 
The NORM no. will be shown in the measurement window 
after the speed measurement.

Measure RPM simultaneously 
‘Measure RPM simultaneously’ (8) is normally not used. With 
this setting on, you are forced to first measure the rpm again 
before you can repeat the shock pulse measurement.

ACCUM (accumulation) is set to 3 or higher on low speed 
bearings (rpm < 600) and in all cases where extra accuracy 
is required. Leonova will measure as many times as stated 
here and then return an average value.

COMP means compensation number, see page D:26. This 
number, if used at all, can first be set after studying the 
measuring result in Condmaster.

To calculate a new COMP number, select COMP, press Edit (F1) and select “Calculate on next reading”. 
Perform a new measurement. When saving,  both the new and the old number is displayed. When 
transferring to Condmaster you have the option to accept the new or retain the previous COMP number.

RPM Trigger
When measuring on variable speed machines, an ‘RPM trigger’ can be used to determine when to 
start a measurement, ensuring that it is carried out at an appropriate speed. The RPM trigger can be 
used on applications where useful readings can be obtained only within a limited RPM range, such 
as in cranes.

‘RPM trigger’ (9) can be set to ‘RPM run up’ or ‘RPM run down’. ‘RPM run up’ means Leonova will 
initiate the measurement, then wait for the machine to speed up to the level input under ‘Trigger level’ 
before it starts recording the signals. With ‘RPM run down’, Leonova waits for RPM to slow down to 
the ‘Trigger level’ setting.

Under ‘Delay time’, you can specify a number of seconds during which Leonova will delay the start of 
measurement. This setting is optional.

SPM Spectrum
An SPM spectrum measurement can be carried out along with the LR/HR measurement. It is measured 
in addition to the ordinary shock values. 

Mark the ‘SPM Spectrum’ row (10). Press ENTER and set ‘SPM Spectrum’ to ‘Yes’. Settings for SPM 
Spectrum are described on page D:33.

LR/HR HD
The LR/HR technique takes advantages from the SPM HD technique provided that both techniques 
are active in the Leonova. The LR/HR HD technique utilizes the SPM HD algorithms for time signals 
and spectrums. Input data for the FFT calculation is the same as for SPM HD. 

8

9
10
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Measuring LR/HR and LR/HR HD

From the measurement window, the instrument can be 
set up to perform a transducer quality line test (TLQ) 
before measurement. Press the ENTER key to enable or 
disable the TLQ test (1). TLQ (Transducer Line Quality) is 
described on page D:17.

When the MEASURE/SAVE (M/S) key is pressed, Leonova 
samples the transducer signal for two seconds if ACCUM 
is set to 1. When ACCUM is higher, it will continue to 
measure for the stated number of times and return an 
average of all measurements taken. The resulting LR and 
HR value is displayed in the ‘Measuring’ window, together 
with the status dot.

For a normalized measurement, LUB, COND and CODE 
are shown to the right (2).

When ‘Variable speed’ is active, the rpm must be measured 
before measuring the shock values.

Please note that LR and HR values are always raw values, 
measured in dBsv, the unit for unnormalized shock values.

For normalized measurements, LUB is displayed with 
CODE A and B, COND is displayed with CODE B, C and D.

The ‘Measuring result’ window (3) shows the results. In 
the ‘Graphics’ window (4), press ‘Change graph’ and 
select the desired alternative. The ‘Lubmaster’ graph 
(5) is displayed only when LR/HR HD is used. The LUB 
and COND graphs will not be shown for unnormalized 
readings. 

2

3 4
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When using the LR/HR HD technique, the 
produced ‘SPM Spectrum HD’ and ‘Time signal 
HD’ are shown by pressing the function keys (6). 

Save the result by pressing the MEASURE/SAVE 
(M/S) key, or measure again with SHIFT + M/S.
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Measuring an SPM Spectrum

An SPM spectrum measurement can be carried out 
along with either SPM dBm/dBc or SPM LR/HR. It is 
measured in addition to the ordinary shock values. 

Please note that the spectrum has a secondary role 
in bearing condition evaluation. The primary measure 
for bearing condition is the evaluated shock pulse 
measurement. 

In cases where the spectrum shows a good match for 
one or more of the bearing patterns, it is a confirmation 
that the measured shock pulses are coming from the 
bearing and not from other possible shock sources on 
the machine. Thus, the spectrum can make it unneces-
sary to verify by lubrication test or signal strength 
comparison (searching for the strongest signal source 
with the handheld probe).

To obtain a spectrum, go to MENU > ‘Measuring point 
data’. Mark the ‘SPM Spectrum’ row (1). Press the ENTER 
key and set SPM Spectrum to ‘Yes’ (2).

The default setting is a power spectrum over the range 
0 to 1000 Hz. It has 1600 lines of which 800 peaks are 
saved. The standard window Hanning is used. All these 
settings can be edited.

Please note that is not necessary to have an exact rpm 
reading in order to measure a spectrum. However, 
the exact rpm is very important when you want to 
interpret the spectrum, especially when you upload it 
to Condmaster and search for bearing patterns with 
the help of the bearing symptoms.

All bearing symptoms use the rpm as a variable. If the 
stored rpm data does not agree with the actual rpm at 
the time the shock signal was measured, Condmaster 
cannot find the bearing patterns correctly. Thus, by 
working with rough estimates of the rpm instead of fresh 
measurements, the symptom search and especially the 
symptom value calculation is made worthless.

For measurements intended for saving in Condmaster, 
it is therefore highly recommended to mark ‘Variable 
speed’ (3).

For spectrum functions in Leonova, se part B of this 
manual.

1
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An SPM Spectrum is based on the amplitude 
modulation of a high frequency signal. It shows 
periodic pulses as frequency lines. Thus, if the 
signal contains a strong pulse that is repeated at 
one second intervals, there will be a high amplitude 
line at 1 Hz. 

To change any of the spectrum parameters, mark 
the line, touch ‘Edit’ and select the value from a list.

Order tracking

‘Order tracking’ is described on page B:36.

Editing spectrum data

Frequency range

The frequency range (1) is always from 0 to ‘upper frequency’. Set ‘Upper 
frequency’ to include 3 or 4 multiples of BPFO (ball pass frequency, outer 
race). The narrower the range, the better the resolution.

Window

The choice of ‘Window’ (2) somewhat affects the spectrum line amplitudes. 
‘Hanning’ (default setting) and Hamming are the window types most 
commonly used to calculate spectra. The difference is often marginal 
and should not affect pattern recognition.

FFT type

The spectrum type (3) can be ‘linear’ or ‘power’. In a power spectrum, 
the line amplitudes are squared. Thus, high amplitude lines become 
more prominent while low amplitude lines are suppressed.

2
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Zoom factor

True zoom is selected to get a high resolution around a 
selected ‘centre frequency’. This frequency must be within 
the selected frequency range. Thus, to zoom in on 600 Hz, 
the minimum range is 0 to 1000 Hz. The range covered by 
the zoom is ‘upper frequency range/zoom factor’. Thus, 
with a zoom factor of 10, the spectrum will cover the range 
550 - 650 Hz.

The highest possible zoom corresponds to a 12800 line 
spectrum. For this, combine the lowest number of spectrum 
lines, 400, with a zoom factor of 32 (32 x 400 = 12800). With a 
centre frequency of 600 Hz, you will get a spectrum over the 
range 584.375 to 615.625 Hz, with a resolution of 0.078125 Hz.

Number of spectrum lines 

The number of spectrum lines (4) affects the resolution and 
the measuring time. Doubling the number of lines also doubles 
the measuring time. In cases where different fault symptoms, 
such as bearing frequencies and multiples of 1X, are close 
together, a high resolution spectrum is preferred.

Saving a full spectrum requires much memory space and 
is seldom necessary. Unless the spectrum lines in damage 
patterns have fairly high amplitudes, the pattern is not visible. 
Thus, saving only peaks (5) will preserve the essential data 
while reducing the amount of redundant data. A peak is a 
spectrum line that has a line with a lower amplitude on either 
side. If you select ‘Save peaks’, Leonova will display the full 
spectrum before saving, with peaks as black lines while the 
lines to be deleted are grey. The maximum number of peaks 
that can be saved is half the number of spectrum lines. The 
number of peaks to be saved is input on the number pad.

SPM spectrum type

One unit for amplitude in an SPM Spectrum (6) is SD (Shock 
Distribution unit), where each spectrum is scaled so that the 
total RMS value of all spectrum lines = 100 SD = the RMS 
value of the time record. The alternative unit is SL (Shock Level 
unit), the RMS value of the frequency component in decibel.

Average type

To achieve greater accuracy, one can order the average 
result from a stated number measurements (average count, 
set on the number pad). To get a time synchronous average, 
a tachometer must be connected which supplies a trigger 
pulse. This starts each measurement with the shaft in the 
same position. ‘FFT linear’ (7) gives the mean value of the 
measurements, while FFT peak hold gives the maximum value.

4
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Vibration measurement
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Vibration analysis techniques

Leonova can be programmed with the following vibration measurement techniques with either 
limited or unlimited use.

ISO 10816 is the measuring technique based on the ISO standard with this number. ISO 10816 
consists of several parts, each stating measurement conditions and a table of limit values for a 
defined machine type. Like ISO 2372, the evaluation of machine condition is based on the RMS 
values obtained by broad band measurement over a frequency range up to 1000 Hz. Depending on 
machine type, one or more of three measured quantities are used to determine vibration severity:

VEL: the RMS value of vibration velocity in mm/s

ACC: the RMS value of vibration acceleration in m/s2

DISP: the RMS value of vibration displacement in µm.

Please note that spectrum analysis is not part of the requirements set up by ISO 10816 but an extra 
function provided by the Leonova.

EVAM includes all advanced vibration measurement and analysis methods and gives the user a wide 
range of choices to adapt the condition measurement to a specific machine. EVAM returns three 
distinct sets of data:

Condition parameters: peak, peak-to-peak, the RMS values of vibration velocity, acceleration and 
displacement plus values for crest, kurtosis, skewness and noise levels.

Fault symptom values: the amplitude values of selected spectrum line patters connected with 
typical machine faults like unbalance, misalignment, gear damage, motor 
faults, bearing damage, etc.

COND numbers: dimensionless condition numbers, obtained by a statistical evaluation of 
all selected condition parameters and fault symptom values. Condition 
numbers are displayed against a green - yellow - red machine condition 
scale.

FFT with symptoms is reduced form of EVAM, lacking the statistical evaluation by means of criteria 
and possibility to display and save time signal.

Common features for ISO 10816, EVAM and FFT with symptoms are the condition parameters VEL, 
ACC, DISP and the spectrum. For an ISO 10816 measuring point, only one spectrum is saved, while 
an EVAM/FFT measuring point can have many. This means that a measuring point set up for ISO 
10816 can at any time be converted into an EVAM or FFT with symptoms measuring point.

HD ENV® is an ideal complement to conventional vibration techniques, capable of detecting at 
a very early stage such machine problems which are generally difficult to find in good time with 
non-enveloping techniques, for example bearing and gear damages. HD ENV requires that the 
measuring technique ‘Vibration Premium’ or ‘Vibration Supreme’ is active.
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Measuring points for vibration

Common for all vibration measurement is that the vibration at the measuring point has to be 
representative for the overall vibration of the machine. Please study ISO 10816, it shows examples 
for various machine types.

As the cause for excessive vibration will usually show up in the spectrum, measuring in the direction 
that returns the highest RMS value can be quite sufficient to accurately establish machine condition. 
To get comparable results, measuring points should be clearly marked, so that the measurements 
can always be taken in the same spots. 

Hand-held probe

Transducer with magnet

SPM vibration transducers can be used

•	 as	a	hand-held	probe,	with	or	without	the	probe	tip	attached.	
Not recommended above 1000 Hz.

•	 with	a	magnet	for	attachment	to	ferrous	metal	parts. Not 
recommended above 2000 Hz.

•	 with	the	M8	(UNC	1/4”-28)	mounting	screw.

The firmer the contact with the machine, the better the measuring 
result. Plain, clean metal makes the best contact surface for the 
vibration transducer. 

When using a hand-held probe it is important to press the 
transducer with the same strength every time to get comparable 
readings.

DuoTech® accelerometers (Dual Technology)
The DuoTech® accelerometer is a single transducer solution used 
for vibration or shock pulse measurements or both in combination. 

•	 DuoTech	with	quick	connector,	TRC100,	for	use	with	permanently	
installed measuring adapters. Connect the DuoTech via the 
measuring cable CAB82.

•	 DuoTech	for	permanent	installation,	SLC144.

Permanently installed DuoTech accelerometers are mounted in a 
countersunk mounting holes identical to holes normally used by 
shock pulse transducers. The accelerometer has 2-pin connector 
and is connected to Leonova or a measuring terminal via twisted 
pair cable. DuoTech is connected to the VIB input on Leonova.

Transducer line quality, TLQ

Leonova is automatically testing the quality of signal transmission between transducers of type IEPE 
and	instrument	before	measurement.	The	unit	of	measure	is	voltage	(Bias).	Accepted	values	depends	
on transducer settings. Not acceptable values generates an error message.

DuoTech with quick connector

Typical measuring points are the bearing housings. ISO 10816 states 
the required measuring directions.

•	 Horizontal	vibration	(H)	in	the	plane	of	rotation	is	most	
representative of balance condition.

•	 Vertical	vibration	(V)	in	the	plane	of	rotation	is	most	representative	
of structural weakness.

•	 Axial	vibration	(A)	along	the	line	of	the	shaft	is	most	representative	
of faulty alignment and bent shafts.
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Measuring point configuration, ISO 10816

Measuring points for ISO 10816, EVAM and FFT with 
symptoms are normally set up in Condmaster and then 
downloaded to Leonova.

However, it is possible to open the Leonova default file 
in	the	vibration	window	(1)	and	configure	all	measuring	
parameters. Please note that most of the settings 
become locked once the measurement has been made. 

Fault symptoms cannot be attached to the measuring 
point in Leonova but can be added after the measuring 
point has been uploaded to Condmaster.

Select ‘ISO10816’ with the arrow keys and open with 
ENTER. Open ‘Measuring point data’ with SHIFT+F3. 
Mark the lines in the configuration window one by one 
with	UP/DOWN.	Open	them	with	ENTER.

Before starting vibration measurements, make sure 
that the vibration transducer you are using with your 
Leonova is properly selected. 

Default vibration transducers for the vibration tech-
niques are set up via the transducer register. Default 
transducer is the active transducer when ‘Portable’ 
transducer is selected under ‘Measuring point data’. To 
select a default transducer, see Chapter A page 13.

The transducer data become editable after you switch 
‘Transducer’	(2)	from	‘Portable’	to	‘Remote’.	Provided	
you know the transducer’s frequency range and its 
upper and lower bias range, you can input the data 
here.

The nominal sensitivity of a vibration transducer 
SLD144S is 10.0 mV/m/s2. The actual sensitivity of the 
individual transducer is written on its calibration card. 
This data should always be input in the transducer 
register. When several transducers are in use, they 
should be marked to assure that the readings are 
calibrated.

The	acquisition	time	(3)	is	automatically	updated	when	
the parameters that affect the time changes.

1
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To evaluate a spectrum, you need to know the RPM 
of the shaft at the time of vibration measurement. 
Mark	‘Variable	speed´	(1).	This	forces	a	speed	meas-
urement before you can measure the vibration.

‘Time	signal	unit	‘(2)	can	be	ACC,	VEL	or	DISP.	

On	the	line	‘Save’	(3)	you	determine	the	type	of	
measuring results you want. There are five alterna-
tives.

‘Time	signal	(FFT	calculated)’	saves	the	time	signal	
and calculates the FFT.

‘Full spectrum’ returns a 1600 line velocity spectrum. 
By default, the range is 2 to 1000 Hz. 

‘Peaks’ will save the number of peaks you input under 
‘No.	of	peaks	to	save’	(4).	A	peak	is	a	spectrum	line	
with a higher amplitude than the lines on either side 
of it. Thus, a 1600 line spectrum can contain max. 
800 peaks.

‘Condition parameters’ selects the RMS vibration 
values and excludes the spectrum.

‘Time signal and FFT’ saves the time signal and the 
calculated FFT.

The	line	‘Direction’	(5)	lets	you	select	one	of	the	
three measurement directions. Your choice is then 
displayed in the measurement window.

2
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Guide for machine classification
Machine condition evaluation according to the ISO 
10816 standard requires a correct classification of 
the monitored machine.

So far, ISO 10816 consists of six parts. Part 1 
contains general guide lines. 

Parts 2 to 6 describe 5 different machine types. 
Most of these have sub divisions, each with its 
own set of limit values defining acceptable and 
unacceptable vibration levels. 

The	lines	‘Part’,	‘Group’	and	‘Support’	(1)	contain	
the data defining a specific set of limit values 
in ISO 10816. Opening the line ‘Part’ leads to 
a step-by-step guide that helps you to input all 
necessary data.

‘Quick	mode’	(2)	is	used	to	speed	up	the	measure-
ment. The measurement calculations will be   based 
on the FFT instead of the time signal, resulting in 
faster settling time.

1
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Data for ISO 10816 part 2

‘Part’ refers to a sub division of the ISO standard. So 
far, parts 2 to 6 have been published.

Marking a part number displays the definition of the 
machine type treated in the part. 

In case the machine you want to monitor is a ‘large 
land-based steam turbine generator set in excess of 
50 MW’, part 2 is your obvious choice.

This machine class has no sub group. Instead, the 
choice of limit value table depends on machine speed, 
either ‘1500/1800 r/min’ or ‘3000/3600 r/min’.

Marking the appropriate speed range leads to the 
final window which shows the ISO recommended 
frequency	range	(10	to	500	Hz),	the	recommended	
measurement	quantity	(vibration	velocity	=	VEL)	and	
the limit values or ‘zone boundaries’.

Vibration zones A and B are acceptable, so any meas-
urement result below the B/C boundary of 5.30 mm/s 
RMS will be marked green. Results from 5.30 mm/s 
to below 8,50 mm/s will be yellow and 8.50 mm/s and 
higher will be red.
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Data for ISO 10816 part 3

Part 3 treats most of the common industrial machines.

They are divided into 4 groups:

Group 1
Large machines with rated power above 300 kW and not more 
than 50 MW; electrical machines with shaft height above 315 mm.

Group 2
Medium machines with rated power above 15 kW up to and 
including 300 kW; electrical machines with shaft height from 160 
mm to 315 mm.

Group 3
Pumps with multivane impeller with separate driver	(centrifugal,	
mixed	flow	or	axial	flow)	with	rated	power	above	15	kW.

Group 4
Pumps with multivane impeller with integrated	driver	(centrifugal,	
mixed	flow	or	axial	flow)	with	rated	power	above	15	kW.

Further criteria for Part 3 are the rigidity of the foundation and 
the rotational speed.

Concrete foundations are rigid, every thing else falls under flex-
ible. 

The RPM affects the lower measuring range as well as the limit 
values.

Please note that correct measurement of very low frequency 
vibration demands a transducer that is linear down to the stated 
frequency. Abnormally high displacement values can occur when 
selecting a lower frequency limit that is outside of the trans-
ducer’s range.

For machines under Part 3, Leonova 
returns both VEL and DISP. Machine 
condition is determined by the 
quantity that has the relatively 
highest measurement results.

Press F3 to confirm the settings.
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Data for ISO 10816 part 4
Part 4 is limited to ‘Gas turbine driven sets 
excluding aircraft derivates’. The standard 
also states a power output of at least 3 MW.

For this part, input the RPM of the turbine. 
This does not affect the vibration limit values 
but the upper frequency limit of the measure-
ment, up to 5000 Hz for a turbine speed of 
20000 RPM.

Data for ISO 10816 part 5
Part 5 is for ‘Machine sets in hydraulic power 
generating and pumping plants’, divided into 
4 groups. Please study the definitions and 
drawings provided in the standard.
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Data for ISO 10816 part 6

Part 6 is for ‘Reciprocating machines with power rating 
above 100 kW’.

For this type of machinery, the standard provides 7 
tables with limit values. Depending on the vibration level 
when the machine is new and in good condition, the user 
is supposed to select one of these tables as a norm for 
the machine. 

If you know your table, you simply select its classification 
number. 

When you mark ‘Measure’, 
Leonova will select the 
appropriate table and display 
its number. Please note that 
this requires a machine in ‘new 
and good condition’, with low 
vibration values. You then edit 
the measuring point data and 
input the proposed table number 
instead of ‘Measure’.
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Measurement results, ISO 10816

Depending on the part of the standard and 
the machine group, ISO 10816 gives limit 
values	for	displacement	(DISP)	and	either	
velocity	(VEL)	or	acceleration	(ACC).	Leonova	
automatically adjusts the measurement quan-
tity display to the selected part and group  

In this case, Leonova will display the evalu-
ated result in DISP, VEL and ACC, because all 
three parameters are returned when Part 6 is 
selected.

In case the different parameters fall into 
different evaluation zones, the large status dot 
(1)	will	show	the	worst	case,	while	the	small	
status	dots	(2)	show	the	individual	evaluation.	
Press F1 to see the ‘Measuring result’ window.

The	spectrum	(3)	is	always	a	velocity	spectrum.	
For spectrum functions in Leonova, see part B 
of this manual. 

Pressing	F4	(4)	toggles	between	Hz,	CPM	and,	
if rpm is measured, orders.

To	save	the	measuring	result,	press	MENU	
and select ‘Save as’. The measurement can be 
saved as a result file or as a file with default 
settings.
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Making a vibration assignment

A proper measuring point for FFT with symptoms 
or EVAM has to be made in Condmaster using the 
Condition Manager. 

In Leonova, you can set up an vibration assign-
ment, returning a set of condition parameters 
and single spectrum measured in accordance with 
the parameters you input under ‘Measuring point 
data’.

You can rename the file with a descriptive name. 
Mark	the	vibration	default	file	(1)	with	the	LEFT/
RIGHT arrow keys. Press SHIFT+F2 and select 
‘Rename’	(2).	Input	a	name	via	the	keyboard	
window and save with ENTER. The new name will 
show up in the measurement window. The default 
file	(1)	will	have	the	new	name	after	restarting	the	
instrument.

1

2

Press	ENTER	to	open	the	vibration	default	file	(1).	

Press SHIFT+F3 to open ‘Measuring point data’. 

Before starting vibration measurements, make sure 
that the vibration transducer you are using with your 
Leonova is properly selected. 

Default transducers for the vibration techniques are 
set up via the transducer register. Default transducer 
is the active transducer when ‘Portable’ transducer 
is selected under ‘Measuring point data’. To select a 
default transducer, see Chapter A page 15.

The transducer data become editable after you 
switch	‘Transducer’	(3)	from	‘Portable’	to	‘Remote’.	
Provided you know the transducer’s frequency range 
and its upper and lower bias range, you can input 
the data here.

The nominal sensitivity of a vibration transducer 
SLD144 is 10.0 mV/m/s2. The actual sensitivity of the 
individual transducer is written on its calibration 
card. This data should always be input in the trans-
ducer register. When several transducers are in use, 
they should be marked to assure that the readings 
are calibrated. 

3



E

E:14   Vibration measurement

To evaluate a spectrum, you need to know the RPM of 
the shaft at the time of vibration measurement. Mark 
‘Variable	speed´	(1).	This	forces	a	speed	measurement	
before you can measure the vibration.

With ‘Measuring point data’ you can edit the meas-
uring parameters. Open with SHIFT+F3 and mark the 
lines in the configuration window one by one with the 
UP/DOWN	keys.	Open	them	with	F1,	‘Edit’.	

The transducer setting ‘Portable’ selects the default 
transducer. ‘Time signal unit’ is the unit for the time 
signal, while ‘Spectrum unit’ is the measuring unit for 
the	spectrum	(e.	g.	VEL	for	a	velocity	spectrum).

The	acquisition	time	(2)	is	automatically	updated	
when the parameters that affect the time changes.

Frequency range
The	frequency	range	(3)	is	defined	by	selecting	a	
lower	and	an	upper	limit	(4).	Both	are	menu	selected.	
When	using	the	optional	function	‘Order	tracking’	(5)	
the upper frequency is set in orders.

Please note that correct measurement demands a 
transducer that is linear over the stated frequency 
range. 

Abnormally high displacement values can occur when 
selecting a lower frequency limit that is outside of the 
transducer’s range.

You can exceed the upper frequency range of the 
transducer when measuring an envelope spectrum.

Time signal unit
As time signal unit you can select VEL, ACC or DISP 
(6).	

The	‘Display’	setting	(7)	effects	the	presentation	of	
measuring	results	displayed	in	the	result	field	(upper	
part	of	the	Leonova	display).	Select	display	units	for	
the three result lines. You can choose ACC, VEL and 
DISP	as	RMS,	Peak	or	Peak	to	peak	(8).

Spectrum unit 
As	spectrum	unit	(9)	you	can	select	VEL,	ACC	or	DISP.	
Normally you would choose a velocity spectrum, i. e. 
VEL. 

Defining the assignment

1

9

7

3

4

5

6 8

2



E

Vibration measurement   E:15

1

1

Window
To compensate for the leakage effect introduced 
by the FFT process, a window function is usually 
applied. The user should choose the appropriate 
window	(1)	function	for	the	specific	application.	If	
the windowing is not applied correctly, errors may 
be introduced in the FFT effecting amplitude, 
frequency or even the overall shape of the 
spectrum.

-	 Rectangle.	The	Rectangle	(None,	Uniform)	
window is the one to choose for transient 
signals. The Rectangle window has the best 
frequency resolution but poor amplitude 
accuracy and high spectral leakage.

- Hanning/Hamming. The Hanning and Hamming 
windows are best for random signals. These 
windows have good frequency resolution and 
also rather fair amplitude accuracy. Since the 
Hanning window also has somewhat lower 
spectral leakage, this window is usually the one 
to prefer.

- Flat-top. The Flat-top window should be 

applied on sinusoidal signals. This window 
has the best amplitude accuracy, but poor 
frequency resolution.

As general advice, use: 

-	 Hanning	window	for	frequency	accuracy	(this	is 
the	most	common	window	to	use).

- Rectangle window only on transient signals.

- Flat-top window for amplitude accuracy.
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FFT type
Four	different	FFT	types	FFT	types	(1)	can	be	selected:

‘Linear spectrum’ consists of RMS values on a linear 
scale. Each value is the equivalent of the RMS value of 
a sinusoidal signal of the correspondent frequency. If 
the spectrum unit is velocity, v, the amplitude scale is 
accordingly: vrms.

‘Amplitude spectrum’ is closely related to the Linear 
spectrum scale. The Amplitude spectrum shows the 
peak value instead of the RMS value. If the spectrum 
unit is velocity, v, the amplitude scale is accordingly: 
vpeak.

‘Power	spectrum’	(Autopower).	Each	value	is	the	equiv-
alent of the RMS square value of a sinusoidal signal of 
the correspondent frequency. If the spectrum unit is 
velocity, v, the amplitude scale is accordingly: v2

rms.

‘Power	Spectral	Density’	(PSD).	This	is	a	power	spec-
trum where each amplitude value is divided by the FFT line width times 
the used window’s equivalent noise band width. If the spectrum unit is 
velocity, v, the amplitude scale is accordingly: v2

rms/Hz.

As general advice, use:
- Linear or Power spectrum on periodic signals.
-	 PSD	spectrum	on	non-periodic	(noise)	signals.

Number of spectrum lines 
The	number	of	spectrum	lines	(2)	affects	the	resolution	and	the	meas-
uring time. Doubling the number of lines also doubles the measuring 
time. In cases where different fault symptoms, such as bearing frequen-
cies and multiples of 1X, are close together, a high resolution spectrum 
is preferred.

Spectrum to save
Saving	a	time	record	or	a	full	spectrum	requires	more	memory.	Unless	
the spectrum lines in damage patterns have fairly high amplitudes, the 
pattern is not visible.

Thus, saving only peaks will preserve the essential data while reducing 
the amount of redundant data. A peak is a spectrum line that has a line 
with a lower amplitude on either side. 

If	you	select	‘Peaks’	under	‘Save’	(3),	Leonova	will	display	the	full	
spectrum before saving, with the peaks as black lines while the lines to 
be deleted are grey. The maximum number of peaks that can be saved 
is half the number of spectrum lines. The number of peaks to be saved 
(4)	is	input	on	the	number	pad.
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Enveloping filter
Enveloping is a technique used to detect low energy 
vibration typically caused by gear and bearing 
damage. This type of damage tends to modulate the 
amplitude of high frequency vibration, e. g. at the 
natural frequency of the transducer.

To suppress all vibration in the lower frequency 
ranges,	a	high	pass	(HP)	filter	is	set	at	1000	or	2000	
Hz	(1).	To	suppress	vibrations	in	both	the	lower	and	
the higher frequency ranges, select one of the band 
pass	filters	(Filter	1- 4).

Quick mode
‘Quick	mode’	(2)	is	used	to	speed	up	the	measure-
ment. The measurement calculations will be   based on 
the FFT instead of the time signal, resulting in faster 
data acquisition time.

Quick mode can not be combined with enveloping, 
time	signal	or	condition	parameters	(Crest,	Kurt,	
Skew,	NL1	to	NL4).

Average type
To achieve greater accuracy, one can order the 
average	result	(3)	from	a	stated	number	measure-
ments	(average	count,	set	on	the	number	pad).	To	get	
a time synchronous average, a tachometer must be 
connected which supplies a trigger pulse. This starts 
each measurement with the shaft in the same posi-
tion. ‘FFT linear’ gives the mean value of the measure-
ments, while FFT peak hold gives the maximum value.

Average overlap
To achieve faster collection of measuring values, 
one	can	set	‘Averge	overlap’	(4)	to	25%	or	50%.	This	
function reduces the measuring time by using less 
time waveform data to produce the spectrum.
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Trigger selection
The		trigger	function	(2)	can	be	set	‘Post	trigger’	
or ‘RPM trigger’. ‘Post trigger’ is primarily used for 
measuring in rolling mills. 

-	‘Trigger	Level’	(3)	is	set	to	activate	measurement	
when the vibration/rpm level exceeds/falls below 
the set value.

-	“Delay	time”	(4)	is	a	delay	in	seconds	before	the	
measurement begins after the ‘Trigger level‘ is 
exceeded.

-	‘‘RPM	trigger	type”	(5)	can	be	set	to	‘RPM	run	up’	
or	‘RPM	run	down’	(6).	The	measurement	begins	
when the rpm exceeds respectively falls below 
the set trigger level.
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Zoom centre and zoom factor
True	zoom	(1)	is	selected	to	get	a	high	resolu-
tion around a selected ‘centre frequency’. This 
frequency must be within the selected frequency 
range. Thus, to zoom in on 600 Hz, the minimum 
range is 0 to 1000 Hz. The zoom factor can be set 
to 2, 4, 8, 16, 32 or 64. The range covered by the 
zoom is ‘upper frequency range/zoom factor’. Thus, 
with a zoom factor of 8, the spectrum will cover the 
range 537.5 - 662.5 Hz. 

The highest possible zoom corresponds to a 12800 
line spectrum. For this, combine the lowest number 
of spectrum lines, 400, with a zoom factor of 32 
(32	x	400	=	12800).	With	a	centre	frequency	of	600	
Hz, you will get a spectrum over the range 584.375 
to 615.625 Hz, with a resolution of 0.078125 Hz.

When using the optional function ‘Order tracking’ 
the zoom centre frequency is set in orders.

1
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Measurement results

Press the M/S key to measure or F1 ‘Measure 
all’ for a measurement in a round. If the rpm 
assignment is set up with ‘Pseudo Tac’ in 
Condmaster, this will automatically be acti-
vated	and	indicated	together	with	the	rpm	(1).	
The ‘Pseudo Tac’ function is described in the 
CondmasterUser	Guide.	

The	live	spectrum	display	(2)	in	the	‘Meas-
uring’ window can be changed to show time 
signal by pressing Shift+F1.

After measuring vibration, Leonova will 
display three main condition parameters: 
DISP,	VEL	and	ACC	as	(RMS),	(Peak)	or	(Peak	
to	Peak).	Units	for	the	displayed	parameters	
are selected under ‘Time signal unit’ when 
defining the assignment under ‘Measuring 
point	data’	(SHIFT+F3).

The	status	dots	(3)	are	grey	because	there	are	
no evaluation criteria for EVAM assignments 
set up in Leonova.

 

Press F1 to see the full list of condition param-
eters	(4)	in	the	measuring	result	window.	

To delete a measuring result, press F1 
(previous)	or	F2	(next)	to	select	result	and	then	
press F3 to delete. 
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‘Peak’ and ‘Peak to peak’ values are displayed 
in the selected time signal unit.

Press F2 to see the full scale graphics where 
you can re-scale the axis, set comments etc. 
(see	part	B	of	this	manual).	

Change graph by pressing F3 in the graphics 
window.	Pressing	F1	(Previous)	and	F2	(Next)	
toggles between the different graphs.

The spectrum is displayed in the selected 
spectrum	unit,	here	velocity	(1).

Pressing	F4	(2)	toggles	between	Hz,	CPM	and,	
if rpm is measured, orders.

You can choose spectrum type, zoom functions, 
time signal and other graphical functions with 
the function keys.  See ‘Spectrum functions’ in 
part B of this manual.

1
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Making HD ENV assignments

HD ENV is an ideal complement to conventional vibration 
techniques. Capable of detecting at a very early stage such 
machine problems which are generally difficult to find in 
good time with non-enveloping techniques, for example 
bearing damages and gear damage, the method utilizes 
cleverly engineered algorithms for digital signal processing 
to obtain optimal data for trending purposes.

To follow an impact related damage throughout its 
development in all stages, from initial crack to loose parts 
and spalling, it is recommended to set up three vibration 
measuring assignments: 

•		one	HD	ENV	assignment	with	filter	4	for	detection	of	
early faults

•	 one	HD	ENV	assignment	with	filter	3	for	detection	of	
more developed faults 

•	 one	velocity	vibration	assignment	for	detection	of	far	
advanced faults

A proper measuring point for HD ENV has to be made in 
Condmaster and downloaded to Leonova. However, it is 
possible to open the ‘HD ENV’ default file in the Vibration 
window	(1)	and	configurate	all	measuring	parameters.	

You can rename the file with a descriptive name. Mark the 
vibration	default	file	(1)	with	the	LEFT/RIGHT	arrow	keys.	
Press	SHIFT+F2	and	select	‘Rename’	(2).	Input	as	name	via	
the keyboard window and save with ENTER. The new name 
will show up in the measurement window. The default file 
(1)	will	have	the	new	name	after	restarting	the	instrument.	

Select	the	‘HD	ENV’	default	file	(1)	and	press	ENTER	to	
open.

Press SHIFT+F3 to open ‘Measuring point data’. 

Before starting vibration measurements, make sure that 
the vibration transducer you are using with your Leonova is 
properly selected. 

Default transducer

Default vibration transducers for the vibration techniques 
are set up via the transducer register. Default transducer 
is the active transducer when ‘Portable’ transducer is 
selected under ‘Measuring point data’. To select a default 
transducer, see Chapter A page 15.

1
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The	transducer	data	become	editable	after	you	switch	‘Transducer’	(3)	from	‘Portable’	to	‘Remote’.	
Provided you know the transducer’s frequency range and its upper and lower bias range, you can 
input the data here.

The actual sensitivity of the individual transducer is written on its calibration card. This data should 
always be input in the transducer register. When several transducers are in use, they should be 
marked to assure that the readings are calibrated.
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With ‘Measuring point data’ you can edit the meas-
uring parameters. Open with SHIFT+F3 and mark the 
lines in the configuration window one by one with the 
UP/DOWN	keys.	Open	them	with	F1,	‘Edit’.	

Variable speed
The	alternative	‘Variable	speed’	(1)	implies	that	the 
vibration measurement is preceded by a measurement 
of the rpm. HD Order Tracking is always on when 
measuring HD ENV.

Measure RPM simultaneously 
‘Measure	RPM	simultaneously’	(2)	is	normally	not	used. 
With this setting on, you are forced to measure the rpm 
simultaneously with the vibration measurement. This must 
be activated when using ‘Time synchronous averaging’.

Frequency, upper (Orders)
The frequency range is defined by selecting an upper 
limit	in	orders	(3).	

Please note that correct measurements with the higher 
BP and HP filters an SLD144, or similar, must be used.

You can exceed the upper frequency range of the 
transducer when measuring an envelope spectrum.

Number of spectrum lines 
The	number	of	spectrum	lines	(4)	affects	the	resolu-
tion and the measuring time. Doubling the number of 
lines also doubles the measuring time. In cases where 
different fault symptoms, such as bearing frequencies 
and multiples of 1X, are close together, a high resolu-
tion spectrum is preferred.

Symptom enhancement factor
The	‘Symptom	enhancement	factor’	(5)	is	used	to	
improve the signal-to-noise ratio. For applications 
with little electronic noise and few mechanical shock 
phenomena,	this	factor	can	be	kept	low	(0 - 5).	Where	
noise and random shocks are frequently occurring, it is 
recommended that the ‘Symptom enhancement factor’ 
is set to 5 -10. However, you should be aware that the 
higher this factor, the longer the measurement cycle. 

The	Y	axis	unit	in	spectrum	is	HDeuE	(HD	enveloping	
units	Enhanced)	and	in	time	signal	is	HD2euE when a 
symptom enhancement factor is used.

Acquisition time
The	acquisition	time	(6)	is	automatically	updated	when	
the parassmeters that affect the time changes.

Defining the assignment
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1

Enveloping filter (Hz)
To detect damages or anomalies in different stages, 
a number of predefined high pass and band pass 
filters are available. The band pass filters are named 
filter 1- 4. Filter 1 and 2 are normally used for special 
applications and filter 3 and 4 for gear and bearing 
damage.

Filter	1	=	5 –100	Hz

Filter	2	=	50 –1000	Hz

Filter	3	=	500 –10000	Hz

Filter	4	=	5000 – 40000	Hz

Advanced
Advanced	(Yes/No)	opens	the	option	‘Time	synch.	
averaging’. 

Time synch. averaging (TSA)
To achieve greater accuracy, one can order the 
average result from a stated number measurements. 
To get a time synchronous average, a tachometer 
must be connected which supplies a trigger pulse. 
This starts each measurement with the shaft in the 
same position. Time synchronous averaging requires 
variable speed. Please note that TSA is recommended 
for detection of gear faults only, not for bearing 
faults.

1
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Trigger selection
When measuring on variable speed machines, an ‘RPM trigger’ 
can be used to determine when to start a measurement, 
ensuring that it is carried out at an appropriate speed. The 
purpose of ‘Post trigger’ is to avoid the recording of irrelevant 
signals that may ultimately cause false alarms. It can be used 
where strong signals can be expected which are process 
related and not attributed to machine damage.

‘RPM trigger’ will initiate the measurement, then wait for the 
machine to speed up to the level input under ‘Trigger level’ 
before it starts recording the signals. ‘Trigger type’ is ‘none’ for 
RPM trigger.

When	using	‘Post	trigger’,	input	a	value	(HDeu)	under	‘Trigger	
level’.	In	the	above	example	(3),	Leonova	will	initiate	an	HD	ENV	
measurement and wait for the signal’s HDeu level to reach 24 
before it starts a complete measurement including time signal 
and FFT. Make sure you input a viable trigger level; if the level 
is never reached, the measurement must be aborted manually. 
‘Symptom enhancement factor’ must be off when using post 
trigger.

Under	‘Delay	time’,	you	can	specify	a	number	of	seconds	during	
which Leonova will delay the start of measurement. This setting 
is optional.
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Measurement results

Press the M/S key to measure or F1 ‘Measure 
all’ for a measurement in a round. If the rpm 
assignment is set up with ‘Pseudo Tach’ in 
Condmaster, this will automatically be activated 
and	indicated	together	with	the	rpm	(1).	The	
‘Pseudo Tach’ function is described in the 
Condmaster	User	Guide.	

After measuring, Leonova will display the 
result in HDrp (HD	real	peak),	a	scalar	value	
expressed in decibels. Representing the 
true highest peak found in the enveloped 
signal, HDrp is the primary value to use for 
determining the severity of a bearing or gear 
damage. It is also used for triggering alarms in 
Condmaster.

In the example two assignments are setup with 
different	fiter	settings,	500-10000Hz	(filter	3)	
and	5000-40000Hz	(filter	4).	Both	assignments	
are measured parallel when pressing ‘Measure 
all’	(2).

The	status	dots	(3)	are	grey	because	there	are	
no evaluation criteria for the HD ENV assign-
ments set up in Leonova.

To	delete	a	measuring	result,	press	F1	(Meas-
uring	result),	select	result	and	then	press	F3	to	
delete. Selected result is marked with a blue 
vertical line. 

Press F2 to see the HDrp trend in full scale 
where you can re-scale the axis, set comments 
etc.	(see	part	B	of	this	manual).	

1
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Press	F3	to	see	the	HD	ENV	Spectrum	(1).	This 
is useful to determine where a possible bearing 
damage is located. It is also useful for trending 
purposes	(applying	symptom	and	band	values).
The spectrum is displayed in HDeu or HDeuE 
when an enhancement factor is used. Pressing 
F4	(2)	toggles	between	Hz,	CPM	and,	if	rpm	is	
measured, orders.

Press	F4	to	see	the	HD	ENV	Time	Signal	(3).	
This is extremely useful to locate where in 
the bearing a possible damage is located. In 
many cases it is also possible to determine 
the	nature	of	the	damage	(a single crack or 
spalling	all	around	etc.). The scale on the y-axis 
is displayed in HD2euE when an enhancement 
factor is used and HDeu when the factor is off.

You can choose zoom functions, cursors and 
other graphical functions with the function 
keys. See ‘Spectrum functions’ in part B of this 
manual.
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Motor current analysis

BNC adapter
93487

CAB97IS

Current clamp

(Fluke	i1000s)

2

3

1

4

Motor current analysis can be performed with the 
EVAM vibration analysis technique using a current 
clamp	(e.g.	Fluke	i1000s)	or	a	permanently	installed	
current tranformer connected to the VIB input. 
This feature is used for troubleshooting, primarily 
on	electrical	motors	with	at	least	70%	workload.

NOTE: It is important to follow safety precau-
tions and that the measurement is performed 
by authorized personnel.

In order to use a current clamp, a user defined 
transducer is to be set up. Fluke i1000s is the type 
of current clamp used in this example.

To	register	a	user	defined	vibration,	press	MENU	
and	open	‘Settings’	 	 (SHIFT+F3).	Select	 ‘Vibra-
tion	transducers’	and	press	F1	(OK)	to	open	the	
transducer	register	(1).	

Select	‘New’	(2)	with	the	F1	key,	then	input	the	
following data. Press F1 to save the settings and 
close	with	the	BACK	key.

Name: A descriptive name. It will 
be shown on the list of 
transducers.

Type:	 Select	‘User	defined’

User	defined	name:	 Is	the	name	shown	in	the	
measurement window

Sensitivity: The transducer’s nominal 
sensitivity in mV/displayed 
unit 

Max. frequency: The transducer’s upper 
frequency range.

IEPE type: Select ‘No’

Information	 about	 ‘Sensitivity’	 (depends	 on	
which	range	is	measured)	and	‘Max.	frequency’	is	
marked on the clamp and/or found in the technical 
specification	belonging	to	the	device).

Press F4 ‘Default transducers’, select ‘Vibration’ 
and press F1. Open the register with ENTER and 
select	 the	 current	 clamp	 to	 be	 used	 with	 UP/
DOWN. Press F1 to save the settings and close 
with	the	BACK	key.
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To start measurement, open an existing measure-
ment under ‘File’ or make a new EVAM assign-
ment. Assignments can be set up in Condmaster 
for downloading in measuring rounds.

Select the EVAM technique and press ENTER 
to make a new assignment. Press SHIFT+F3 to 
open ‘Measuring point data’. 

Set ‘Frequency, lower’ to 20 Hz and ‘Frequency, 
upper’	to	80	Hz	(common	area	for	motor	current	
analysis)	(1).	Press	F1	‘Edit’	to	change	the	values.	
Press	F1	‘OK’	to	save	the	setting.

‘Time signal unit’ and ‘ Spectrum unit’ must be 
set	to	‘User	defined’	(2)

Input	‘User	defined,	name’	and	‘User	defined,	
unit’	 (3).	NB. The name and unit must be 
exactly the same as the name and unit set in 
the transducer register. You will find the name 
and	unit	in	the	lower	part	of	the	window	(4).

Recommended settings for the spectrum param-
eters	(5)	are	Hanning	‘Window’,	Linear	‘FFT	type’,	
1600 ‘Spectrum lines’, ‘Average count’ 4 and 
‘Save’ time signal and FFT.

The transducer setting ‘Portable’ selects the 
default transducer. The transducer data become 
editable	after	you	switch	‘Transducer’	(6)	from	
‘Portable’ to ‘Remote’.

Save and close the settings window with F4. 

Press the M/S key and then F1 to start the 
measurement.

After measuring, Leonova will display the meas-
uring results in ampere, peak and peak-to-peak 
values	 (7).	 You	 can	 choose	 spectrum	 type,	
zoom functions, time signal and other graphical 
functions with the funktion keys. See ‘Spectrum 
functions’ in part B of this manual.

To	save	the	measuring	result,	press	MENU	and	
select ‘Save measurement’. The measurement 
can be saved as a result file or as a file with 
default settings.

After the file or measuring round is uploaded 
to Condmaster, measuring results available for 
analysis	are	time	signal	(in	ampere)	and	spectrum	
(y-axis	is	always	ampere).
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Rotor balancing
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Balancing methods

Single plane balancing is an optional Leonova function with unlimited 
use. 

Single plane balancing, 4 runs

This method uses one measurement without trial weight to determine 
the vibration severity (mm/s RMS) of the rotor, followed by three 
measurements with trial weights at 0°, 120° and 240° to calculate the 
weight and position of the correction mass. No rpm measurement 
is needed but all measurements must be done at the same rpm.

Single plane balancing, 2 runs

This method uses one measurement without trial weight to determine 
the vibration severity (mm/s RMS) of the rotor, followed by one 
measurements with a trial weight to calculate the weight and position 
of the correction mass. It requires time synchronised vibration measurement (trigger pulse supplied 
by a pulse from the SPM tachometer probe or a proximity switch) to find the relative phase angle 
between the two vibration measurements.

Please note: To get a good result fast, the static unbalance must be corrected before starting the 
balancing procedure with Leonova.

For all methods, a final run can be made to check the balancing results and, if needed, get the data 
for further adjustments. Leonova then saves a balancing log file.

Leonova guides step-by-step through the balancing procedure. One can shift the rotation direction 
and change the measured parameter from velocity to acceleration or displacement. 

In addition to the RMS value, a spectrum is shown to help find the part of vibration that is due to 
unbalance. For the 2-run methods, the number of ‘synchronized readings’ for obtaining a time average 
is set to min. 5. The recommendation is 10-20 readings.
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Balancing equipment

For single plane balancing with four runs, the only equipment 
needed is a vibration transducer type SLD144 or other IEPE (ICP®) 
type transducers with voltage output. 

The transducer is mounted with a magnetic foot (TRX29) or with an 
M8 (UNC 1/4”) screw. It is connected with the spiral cable CAB82 
or a straight 10 meter cable CAB83.

For the 2-run methods, a trigger pulse is needed which is either 
supplied by a proximity switch or by the SPM tachometer probe 
TTP10. 

The laser dot from the tachometer probe is directed towards a 
piece of reflecting tape pasted on the shaft. The tape must have 
a sharp edge.

NOTE: It is very important that the tachometer probe is firmly 
attached and not moved during the balancing procedure. The 
laser is sensitive to reflections from the shaft, especially during 
measurement at short distance. Do not direct the tachometer 
probe straight at the shaft, slightly angle the direction in order 
to avoid misreadings.

SPM supplies a tachometer probe holder with a magnetic base 
(SPM 81319) and a clamp for the probe (SPM 14765).

81319

14765

CAB83 (10 m)

Transducer SLD144
with magnetic foot

CAB82

TTP10
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General settings

To make general settings for the balancing func-
tion, press the MENU key and select  ‘Settings’ > 
‘General settings’, then use the F2 key to select 
the ‘Balancing’ tab.

Your selection of ‘Lagging phase’ or ‘Leading 
phase’ affects the way the angles are displayed 
in relation to the direction of rotation while 
balancing.

Leonova measures ‘true phase’ from the refer-
ence pulse (RPM trigger pulse). When using the 
‘Lagging phase’ convention, the phase angle 
increase opposite to the direction of rotation. 
Using the ‘Lagging phase’ convention is default 
and is to be considered as industry standard.

When ‘Lagging phase’ is used, angles are 
displayed as shown in figure A. 

When ‘Leading phase’ is used, angles are dis-
played as shown in figure B.

Marking ‘Ounce’ will show all weights in ounces 
instead of grams.

‘Output unit’ is the transducer output, ACC VEL 
or DISP.

Lagging phase
0°

+ 90°

A

+ 90°

B

Leading phase
0°
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Default transducer for balancing measurement

The ‘Registration of vibration transducers’ proce-
dure is described in Part A of this manual. Before 
starting vibration measurements, make sure that 
the vibration transducer you are using with your 
Leonova is properly registered, configured and 
selected.

To select and edit a transducer, press the MENU 
key and select ‘Settings’ > ‘Vibration transducers’. 
Use the arrow keys to mark a transducer on the 
list (1) and press F2 (‘Edit’) (2) to open and view 
its data. 

To edit transducer data, mark the setting you want 
to change and press F2 (‘Edit’).

The nominal sensitivity of a vibration transducer 
SLD144 is 10 mV/m/s2. The actual sensitivity of the 
individual transducer is written on its calibration 
card. This data should always be input in the 
transducer register (3). When several transducers 
are in use, they should be marked (e.g. with serial 
number) to assure that the readings are calibrated.

While in the ‘Vibration transducers’ menu, press 
the F4 key (‘Default transducers’) (4), then select 
‘Balancing’ (5) and press ‘ENTER’. Choose which 
transducer to be used as default transducer for 
balancing measurements by pressing ‘ENTER’  to 
get to the list (6). Use arrow keys to choose from 
the list and press ‘ENTER’ when ready. Finish 
the selection of default transducer by pressing 
‘BACK’ (Leonova automaticlly updates the choice 
of default transducer).

Transducer line quality, TLQ

Leonova is automatically testing the quality 
of signal transmission between transducers of 
type IEPE and instrument before measurement. 
The unit of measure is voltage (Bias). Accepted 
values depends on transducer settings. Not 
acceptable values generates an error message. 
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Unbalance

A rotor is unbalanced when the centre of its 
mass does not co-incide with the shaft centre.

This condition can be described as the rotor 
having a ‘heavy spot’ somewhere along its 
circumference. 

If we know the position and weight of this 
heavy spot, we can reduce it by taking away 
mass or, more often, put a counterweight on 
the oppisite side of the rotor.

For one plane balancing, it is assumed that the 
heavy spot is on the centre line of a narrow 
rotor or near enough, so that it does not matter 
on which side of the centre line the counter 
weight is place.

Position?

Counter 
weight?
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Measuring unbalance

Unbalance causes excessive vibration. However, 
excessive vibration can have any number of other 
causes. Thus, before attempting to balance a rotor, 
we must first check that there is in fact an unbalance 
problem and make sure that other vibration causes, 
such as loose parts and misalignment, are eliminated.

As the ‘heavy spot’ rotates in the radial plane, the 
vibration values measured in the horizontal (H) and 
vertical (V) directions should be higher than the 
vibration measured in the axial direction (A). 

Check all three directions. For balancing, measure in 
direction H or V, whichever yields the highest value.

Unbalance causes vibration with a frequency of 1X, 
which is the shaft frequency in Hz (rpm/60), also called 
the first order.

Check that the vibration spectrum has a clearly 
dominant line at 1X . This line is marked in the Leonova 
balancing spectrum.

All balancing methods use a first run to establish the 
vibration behaviour of the rotor.

The following run is made with a trial weight fastened 
at a convenient spot along the rotor. Thus, we add  a 
known unbalance factor, which allows us to calculate 
the position and weight of the unknown ‘heavy spot’ 
from the change in vibration behavour.

1X
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Four run method

Using four runs, three of them with the same trial 
weight fixed first at 0°, then at 120° and 240° along 
the rotor circumference, is the traditional balancing 
method. 

It is important to run the machine at the same speed 
at all measurements.

Traditionally, the position and weight of the balancing 
weight were calculated by drawing a graph of the 
vibration vectors. This part of the work is now done 
by Leonova: after the last run, the instrument displays 
the balancing weight in grams (ounces) and its position 
in degrees (measured from the point where the first 
trial weight was placed).

Two run method

The two run method work with synchronized vibration 
measurement. This requires a trigger pulse from a 
tachometer.  Each measurement starts in exactly the 
same shaft position. 

The tachometer position becomes part of the reference 
system needed to calculate the angles between 0° 
(the position of the trial weight), the position of the 
‘heavy spot’ and the position of the artificial unbalance 
created by the trial weight.

The tachometer must not be moved between measure-
ments.

Weak
direction
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Transducer selection and speed measurement

The balancing procedure is menu guided. Select 
the method, then simply follow the instructions 
on the instrument screen.

The first steps are common for all methods. Start 
with selection of transducer. The transducer 
selected under ‘Transducer register’ will be 
displayed as default. 

Follow the setup guide by pressing the F2 
function key (Next). 

For the ‘4-run’ method, the RPM data are only 
needed to find the 1X position in the spectrum 
and thus check on the amount of unbalance. 
You can do balancing work in three ways (1); 
without the RPM, input it via the numbers pad 
(Preset), or measure it. 

Select ‘Portable’ RPM transducer when using 
the Tachometer probe TTP10 or ‘Remote’ for 
transducers of type PNP, NPN or Keyphasor. 
When Leonova is connected to a stroboscope, 
the setting is normally set to NPN. Some types of 
stroboscopes require the setting of ‘12V Supply’.

RPM can be measured with two methods (2); 
synchronized (recommended) or asynchronized. 
‘RPM synchronized’ means that each measure-
ment starts in exactely the same shaft position. 
‘Asynchronized’ only require one reading and 
is a quicker way of measuring RPM.

The ‘2-run’ method is automatically set for 
synchronous RPM measurements (see previous 
page), and the setting for RPM uncertainty is 
not available. You can input the number of 
synchronized readings (3), recommended are 
10-20. If the machine is severely unbalanced 
you might increase the number of synchronized 
readings even more.

1

2

3
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For the ‘4-run’ method, set the frequency range 
for the spectrum to ‘Automatic’. Leonova will 
calculate the suitable range from the RPM data 
up to approx. 5x. If the machine is running at 
low speed < 600 RPM, the frequency range 
should be set to 500 or 1000 Hz to save time 
during measuring. Then select a number of lines 
to display in the spectrum, recommended are 
400 lines. 

For the ‘2-run’ method, frequency range and 
number of lines to display in the spectrum are 
set automatically and cannot be changed.

With the tachometer and the vibration transducer 
connected,  press the MEASURE/SAVE (M/S) key.

Note: If preferred, the display of the rotation 
direction (clockwise, counterclockwise) can be 
changed by pressing the MENU key and then 
choose ‘Shift rotation direction’.

Press the F3 function key (‘Spectrum’) (1) to 
display the spectrum. 

Run without trial weight

1

1

Frequency range settings, 4-run method

First measure without trial weight, 4-run method

First measure without trial weight, 2-run method
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Run without trial weight (cont.)

To set a cursor (2) on the spectrum line at 1X 
(which shows the amount of unbalance), press 
F2 (‘Cursor’) > F1 (‘Cursor A’), then use the 
LEFT/RIGHT arrow keys to move the cursor to 
the desired position.

To display machine fault symptoms, press SHIFT + 
F4 (‘Symptom’), then SHIFT + F1 for all symptoms 
or SHIFT + F2 for theoretical symptoms only.

In case the 1X line is relatively small, abort 
balancing and first check the machine for other 
vibration causes (misalignment, loose bolts, etc.).

For all methods, the run without trial weight 
supplies the value for V0 , the initial machine 
vibration.

2
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The trial weight must be large enough to create 
an unbalance but not so heavy as to create 
dangerous vibrations.

To edit the test weight, press the F3 function 
key (‘Edit test weight’) and use Leonova to 
calculate a suitable weight (1). The input data 
are the approximate weight of the rotor and 
its diameter.

Input the mass of the trial weight with the 
number pad (2).

Trial weight calculation

1

2
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Run(s) with trial weight

The position where the trial weight is attached 
automatically becomes the 0° position on the 
rotor. All angles are given with this point as a 
reference. 

For the 4-run method, you first measure V1 with 
the trial weight at 0°, then V2 with the weight 
at 120° and finally V3 with the weight at 240°.

4-run method, menu during third run 
with trial weight

2-run method, menu during run with weight
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The calculation results are the mass of the 
balancing weight and the angle defining the 
position where it has to be attached. 

The display shows the direction of rotation and 
the position of 90°.

On the side of the display (1) there is a row of 
function keys that allow you to select alternatives 
to adding mass at the indicated spot (see next 
page).

After completion of a balancing operation, 
the balance quality can be compared to the 
ISO 1940-1 standard, specifying permissible 
residual balance for rigid rotors. Press the F4 
(‘ISO 1940-1’) (2) key to open the function. This 
function is only avaliable for Single plane, 2 
runs (RPM is always measured in this method, 
which is a requirement for the comparison with 
‘ISO 1940-1’).

Display of results

Calculation results, 4-run method

0°

1

Calculation results, 2-run method

2
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Graphical check of calculation results.

Split the correction mass: Input the number of rotor partitions to 
distribute the correction mass between two of them.

Radial displacement: Input the change in radial distance to recalculate 
the weight. 

Calculate radial position of smaller/larger balancing weight (known 
weight).

Weight removal: Show drill hole position.

Degrees to length: change from angle to length measured along 
the rotor circumference.

Sum up weights: Replace all correction masses on the rotor by one.

Weight removal: Drill hole diameter and depth calculated for various 
materials.

Alternatives for balancing weights

Leonova calculates a number of alternatives for correcting the unbalance:
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Trial run and log

After balancing weight application, a trial run can 
be made to measure vibration after balancing. 
If balancing was successful, the vibration at 1X 
should be considerably lower.

The information in the ‘Applied balancing weight’ 
window is optional. It will appear in the balancing 
log file.

In case you used the proposed weight and 
position, press ‘Copy to log’ (1) to input the data. 

In the ‘Verification measurement’ window, click 
‘Measure’ to check vibration after balancing.

1
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To close and save a balancing job, press BACK (1). 

The display shows three alternatives (2):

• ‘Save changes and close’ - after entering a 
file name (3), this function saves the balancing 
work in a file which will be stored in the ‘File’ 
menu (4), see below.

• ‘Save changes’ - if you are working in an existing 
file and have done additional readings on the 
machine, this alternative will save the result, 
but not close the file.

• ‘Close without saving’ closes the function 
without saving any data.

Open an existing file from the ‘File’ menu by 
choosing it and press ENTER. The display shows 
two alternatives (5):

• ‘Open existing measurement’ makes it possible 
to edit data in the file. The changes will be 
stored in the same file.

• ‘New verification measurement’ opens the file 
and when a new measurement is done, this 
will be saved in a new file.

Finish the balancing job

1

2

3

4

5
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To print out or save a balancing report, do 
the following:

• Connect Leonova to the PC.

• Start the Leonova Service Program and select 
‘Balancing report’ (1).

• Select a balancing file saved under the ‘FILE’ 
menu and press OK.

• To print out the report, select printer, number 
of copies, etc under the ‘Print out’ menu. 
You can write comments and a header to be 
added on the report (2).

• To save the report as a document, select 
Excel file or Word file (3).

• Write your own comments (4) to be printed
    in the report.

3

2

Create report

4

1
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ISO balancing standard 1940-1

Determination of permissible residual unbalance

The recommendations are given based on experi-
ence concerning the balance quality requirements 
of rigid rotors, according to type, mass and 
service speed.

There are three methods used to determine the 
permissible residual unbalance (Uper):

• Empirical quality grades derived from long 
term practical experience from a large number 
of rigid rotors

• One experimental method often used in mass 
production balancing

• Method based on specific permissible bearing 
forces, calculated by defining Uper as a sum 
of the permissible residual unbalances in the 
bearing planes.

The result from the measurements (mm/s) will be 
recalculated into values that can be compared 
to the graph described in ISO 1940-1.

The balancing result for single plane, 2 runs and 
the result after applying the balancing weight 
and the trim weight will be plotted into a graph 
for the selected balance quality grade (G1, G2.5, 
G6.3 or G16) (1).

The residual unbalance is depending on the actual 
rotational weight, the distance of the balancing 
weight from the centre of rotation and the speed 
of the application. 

The result is described as a value that is independ-
ent of speed and the rotational weight Uper/ gr.mm.
In the example, the residual unbalance is 321 gr/
mm compared with the limit 700 gr/mm valid at 
150 kg, rotating at 2000 rpm and the position of 
the weight at 500 mm from centre of rotation. 

The limit is depending on the weight of the 
rotational mass and the RPM.

The residual unbalance value is depending on 
the position from the centre of rotation of the 
balancing weight.

For more detailed information, please see ISO 
standard 1940-1.

1
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